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Unit – 01 

1. Graphics: Introduction  

Graphic design is the process of visual communication and problem-solving using one or more of 
typography, photography and illustration. The field is considered a subset of visual communication and 
communication design, but sometimes the term "graphic design" is used synonymously. Graphic 
designers create and combine symbols, images and text to form visual representations of ideas and 
messages. They use typography, visual arts and page layout techniques to create visual compositions. 
Common uses of graphic design include corporate design (logos and branding), editorial design 
(magazines, newspapers and books), way finding or environmental design, advertising, web design, 
communication design, product packaging and signage. 

Students are introduced to the graphic design industry through magazines, internet, etc. We begin to talk 
about audience. 

2. Types of Images and Graphics 
The 5 Types of Digital Image Files: TIFF, JPEG, GIF, PNG, and Raw Image Files, and When 
to Use Each One 

1. TIFF (also known as TIF), file types ending in .tif. 
2. JPEG (also known as JPG), file types ending in .jpg. 
3. GIF, file types ending in .gif. 
4. PNG, file types ending in .png 
5. Raw image files. 

 

1. TIFF - Tagged Image File 

A TIF is a large raster file that doesn't lose quality. This file type is known for using "lossless 
compression," meaning the original image data is maintained regardless of how often you 
might copy, re-save, or compress the original file. 



Despite TIFF images' ability to recover their quality after manipulation, you should avoid 
using this file type on the web -- it can take forever to load. TIFF files are also commonly 
used when saving photographs for print. 

2. JPEG (or JPG) - Joint Photographic Experts Group 

JPEGs might be the most common file type you run across on the web, and more than likely 
the kind of image that is in your company's MS Word version of its letterhead. JPEGs are 
known for their "lossy" compression, meaning that the quality of the image decreases as the 
file size decreases. You can use JPEGs for projects on the web, in Microsoft Office 
documents, or for projects that require printing at a high resolution. Paying attention to the 
resolution and file size with JPEGs is essential in order to produce a nice looking project. 

3. GIF - Graphics Interchange Format 

GIFs are most common in their animated form, which are all the rage on Tumblr pages and in 
banner ads. It seems like every other day we have a new Grumpy Cat or Honey Boo Boo 
animated GIF. In their more basic form, GIFs are formed from up to 256 colors in the RGB 
colorspace. Due to the limited number of colors, the file size is drastically reduced. 
This is a common file type for web projects where an image needs to load very quickly, as 
opposed to one that needs to retain a higher level of quality. 

4. PNG - Portable Network Graphics 

PNGs are amazing for interactive documents such as web pages, but are not suitable for print. 
While PNGs are "lossless," meaning you can edit them and not lose quality, they are still low 
resolution. The reason PNGs are used in most web projects is that you can save your image 
with more colors on a transparent background. This makes for a much sharper, web-quality 
image. 

5. RAW - Raw Image Formats 

A RAW image is the least-processed image type on this list -- it's often the first format a 
picture inherits when it's created. When you snap a photo with your camera, it's saved 
immediately in a raw file format. Only when you upload your media to a new device and edit 
it using image software is it saved using one of the image extensions explained above 
RAW images are valuable because they capture every element of a photo without processing 
and losing small visual details. Eventually, however, you'll want to package them into a raster 
or vector file type so they can be transferred and resized for various purposes. 
 
As you can see from the icons above, there are multiple raw image files in which you can 
create images -- many of them native to certain cameras (and there are still dozens more 
formats not shown above). Here's a brief description of those four raw files above: 
 
CR2: This image extension stands for Canon RAW 2, and was created by Canon for photos 
taken using its own digital cameras. They're actually based on the TIFF file type, making 
them inherently high in quality. 



CRW: This image extension was also created by Canon, preceding the existence of the CR2. 
NEF: This image extension stands for Nikon Electric Format, and is a RAW file type created 
by (you guessed it) Nikon Cameras. These image files actually allow for extensive editing 
without changing file types, provided the editing takes place using a Nikon device or Nikon 
Photoshop plugin. 
PEF: This image extension stands for Pentax Electronic Format, a RAW image file type 
created by Pentax Digital Cameras. 
Working with images is a lot more complicated than you'd think at first glance. Hopefully 
this guide has provided a better understanding of the standard file types and which are most 
appropriate for your project. 
 
Does this article make you wonder which file types of your logo you have on hand? Take a 
look and if you don't have an .EPS or .AI file stashed away, I would recommend contacting 
your designer. 
 
 

3. Raster Graphics  
A raster graphic is made of a grid of small squares known as pixels. Photographs must be 
raster graphics in order to show shades of colors. Adobe Photoshop is the recommended 
software to create and save a high quality photo as a .tif file. Raster images are resolution-
dependent—that is, they contain a fixed number of pixels. Resolution is measured in Dots-
Per-Inch, also known as DPI. To get a good quality printed image, the number of dots should 
be at least 300 DPI. Below this number, the edges will appear fuzzy and rough. It is not 
recommended to use the raster format for logos. For more information on how to create a 
high quality raster graphic, see “How to Get the Best Quality Photos” available in the 
information section of our website. 
 
 

4. Vector Graphics 
A Vector graphic is made up of lines and curves defined by mathematical descriptions called 
vectors. Vector graphics are saved and printed in postscript, the language used by high-
quality printing devices. You can create and save a vector graphic from software such as 
Adobe Illustrator in the .eps or .ai format. Vector graphics are resolution-independent—that 
is, they can be scaled to any size and printed at any resolution without losing detail or clarity. 
It is highly recommended to use the vector format for logos, as the edges will always appear 
smooth, regardless of the size of the image. 
 
 

5. Integrating Image  
Integrating images and external material.  
2. Integrating or inserting pictures in your documents is fun and it improves the impression 
of your document. A common use of inserting a picture on a document is when you are 
creating your resume. 
 



 
 

6. Graphics in Multimedia 
Multimedia graphics and image data representation. Images consist of pixels 
(picture elements in digital images). A 1-bit image (also called binary image) consists of on 
and off bits only and thus is the simplest type of image Each pixel is stored as a single bit (0 
or 1), so also referred to as binary.  
 
 
 
 

 Unit – 02 

Aspects of image & Graphics 

1. Digital Image Representation 
a. Resolution 

Resolution is the height and width of an image and it is not limited to a specific aspect 
ratio or size. For videos and animations, resolution is measured in pixels. A pixel is a tiny 
square of color that is the smallest element of a digital picture or video frame, but that’s 
probably more than you need to know. The point is different standards of televisions do 
use specific resolutions to match aspect ratios. A 16:9 resolution would need to equate to 
16 parts wide by 9 parts tall. An example of this would be an image that is 1600 pixels 
wide by 900 pixels tall. 
 

b. Pixel Aspect Ratio 

On a normal monitor imaging element is in a square matrix. We then call the aspect ratio 
of that pixel 1. Aspect ratio is just the width/height. A aspect ratio of 1 is a square and a 
aspect of 16/9 is elongated. In the case of monitors we have 2 separate aspect ratios the 
ratio of the monitor and the shape of each pixel, called pixel aspect ratio. These two 
are not to be confused together they are different things. 
 

 
Image 1: Aspect ratio is defined as width divided by height 

One some devices most notably old TV signals and some movie formats the pixel is not a 
square but rather somewhat elongated, wider than high. So by setting this value to other 
than 1 will result in Photoshop emulating such a screen by stretching your image 
accordingly. 



Image 2: A pixel bobba fett
expressed as one number)
 
Most users will never need this option for 

know you need it. Odds are you will never encounter a situation where you would ever need 
to change pixel aspect ratio
 

 
c. Pixel Depth 

Alternatively referred to as
pixel on a computer monitor to represent a specific color. The more bits per
higher color variety and quality of the monitor.
 

d. Dynamic Range of Colors 
Dynamic range in digital photography
ratio between the maximum and minimum measurable light intensities (white and black, 
respectively). In the real world, one never encounters true white or black 
degrees of light source intensity and subject reflectivity.
 

 
2. Basic Color theory 

Colors play a large role in the elements of design[6] with the 
color wheel being used as a tool, and color theory providing a 
body of practical guidance to color mixing and the visual impacts 
of specific color 

 

User 

 Color star containing primary, secondary, and tertiary 
colors. 

 

 Color can aid organization to develop a color strategy 
and stay consistent with those colors.[6]

 
bobba fett by Shkvapper in a 1:1 pixel ratio and a 3:2 Ratio (or 1.5 

expressed as one number) 

Most users will never need this option for anything! So its safe to keep it at 1, unless you 
know you need it. Odds are you will never encounter a situation where you would ever need 

pixel aspect ratio. 

Alternatively referred to as pixel depth, color depth refers to the number of bits 
on a computer monitor to represent a specific color. The more bits per

higher color variety and quality of the monitor. 

Dynamic Range of Colors  
in digital photography. Dynamic range in photography describes the 

ratio between the maximum and minimum measurable light intensities (white and black, 
respectively). In the real world, one never encounters true white or black 
degrees of light source intensity and subject reflectivity. 

Colors play a large role in the elements of design[6] with the 
color wheel being used as a tool, and color theory providing a 
body of practical guidance to color mixing and the visual impacts 

containing primary, secondary, and tertiary 

Color can aid organization to develop a color strategy 
and stay consistent with those colors.[6] 

by Shkvapper in a 1:1 pixel ratio and a 3:2 Ratio (or 1.5 

anything! So its safe to keep it at 1, unless you 
know you need it. Odds are you will never encounter a situation where you would ever need 

refers to the number of bits per 
on a computer monitor to represent a specific color. The more bits per pixel, the 

ography describes the 
ratio between the maximum and minimum measurable light intensities (white and black, 
respectively). In the real world, one never encounters true white or black — only varying 



 It can give emphasis to create a hierarchy to the piece of art. 
 It is also important to note that color choices in design change meaning within cultural contexts. 

For example, white is associated with purity in some cultures while it is associated with death in 
others. 
 

3. Method of storing  
There are five methods of storing vegetables and fruit: drying, canning, curing and salting, 
freezing and common storage. Which method is chosen depends upon the type of produce, the 
quality desired and the facilities available for storage. 
 

4. Reproducing Images 
If you wish to include figures, images or extracts from previously published articles it is your 
responsibility to acquire permission to do so. All material must be properly referenced and you 
must have the written consent of the copyright holder (this may be the publisher rather than the 
author). This includes your own previously published material, if you are not the copyright 
holder. 
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Photoshop Basics: The Toolbox

The tool palette is probably one of the most frequently used parts of Adobe Photoshop. If
you want to make the most of Photoshop, you need to understand how to use the tools
effectively.

You can pickup a tool in the toolbox simply by clicking on it. If you let your cursor sit
over the tool without clicking on it, the name of that tool will appear on screen. It will
look something like this:

The letter inside the brackets is the keyboard shortcut for that tool. You will find a
complete list of these shortcuts at the end of this tutorial.

Tools with little black arrows in the corner have hidden tools underneath. Whenever you
select any tool from the toolbox, a series of options will appear at the top of the screen
in the Options Bar. Here is an example of what part of the option bar looks like when
you click on one of the selection tools:
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The Toolbox: A Visual Guide
There is a whole range of ‘hidden’ tools in the Adobe Photoshop toolbox.

Here’s a nifty little guide to help familiarise yourself with where they’re located.
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Photoshop basics: The Toolbox
A brief description of the tools in Photoshop and what they do.

The most frequently used tools are underlined.

TOOL ICON SHORTCUT DESCRIPTION

Rectangular Marquee Tool M
Allows you to make rectangular selections of the
image.

Elliptical Marquee Tool M Allows you to make elliptical selections of the image.

Single Row Marquee Tool
Allows you to select a single row of pixels stretching
from one side of the image to the other.

Single Column Marquee Tool
Allows you to select a single column of pixels stretching
from the top of the image to the bottom.

Move Tool V
Allow you to move selections and layers around the
canvas.

Magic Wand W

The Magic Wand allows you to select parts of the
image that are similar in colour. Adjusting the
Tolerance in the Options Bar when you click on this
tool allows you to adjust how much the Magic Wand
selects. If the tolerance is low, it will select only very
similar colours. If the tolerance is high, it will select
colours from a wider spectrum. Very useful for
removing backgrounds from an image.

Lasso Tool L The Lasso Tool allows you to make irregular, freehand
selections of the image.

Polygonal Lasso Tool L
The Polygonal Lasso Tool allows you to make
polygonal selections of the canvas – such as triangles
and other irregular, straight edged shapes.

Magnetic Lasso Tool L

The Magnetic Lasso Tool is similar to the regular Lasso
Tool although it automatic clings the edges of an
image. You can adjust the settings of this tool in the
Options Bar.

Crop Tool
C

Click on this tool, select the area of your document that
you wish to crop and hit ‘Enter’ on your keyboard to
confirm the crop (if you’re unhappy with the area you’ve
selected, press the ESC key and try again).
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Slice Tool K

The Slice Tool allows you to divide the image into
segments which can be exported to form a HTML table.
This is useful for web design because parts of the
image can be individually optimised or used as
hyperlinks. Dividing such an image into smaller parts
also makes it appear to load faster in browsers.

Slice Select Tool K This tool allows you to move and resize slices.

Healing Brush J

The Healing Brush allows you to fix blemishes,
scratches and other imperfections in images. Hold
down the option key to select an area of the image
which is similar to the one you want to repair. Use the
healing brush to paint over the imperfection.

Patch Tool J

This is another image retouching tool which allows you
to patch areas of the image. There are three ways to do
this. First, click on the Patch Tool and select an area of
the screen that is to be patched up. Click on Source in
the Options Bar. Drag the selected area to the region of
the image you want to use as the patch. Clicking on
Destination in the Option Bar enables you to do the
reverse: select the patch, then drag it to the area you
wish to patch up. Using the Options Bar, you may also
patch up the selected area with a pattern.

Brush Tool B

The Brush Tool is much like a conventional paint brush.
When you click on the Brush Tool, you are able to
select a range of different brushes from the Option Bar.
You can also set the Opacity and Flow of the brush.
Select the colour of the brush by clicking on ‘Set
Foreground Color’ selector.

Pencil Tool B

The Pencil Tool is much like a conventional pencil,
except you can choose a whole range of shapes and
sizes for the nib using the Options Bar. You can also
set the opacity of the pencil.

Clone Stamp Tool C
The Clone Stamp Tool allows you to clone parts of an
image. A common use

Pattern Stamp Tool C
The Pattern Stamp Tool allows you paint a pattern on
the canvas. You can specify the sort of pattern you
would like using the Options Bar.

History Brush Y

The History Brush is very similar to the Clone Stamp
Tool with one important differnce: instead of allowing
you to clone part of the image, it allows you to clone
part of the image as it appears in the previous stage of
the History.  This means you can change an image and
then regain portions of it using the History Brush.
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Art History Brush Y

The Art History Brush allows you to transform
conventional images into works of art. Experiment by
choosing different styles and brush types. It’s best to
work on a new layer above the original image, this will
preserve the original if you make major mistakes.

Eraser E
Allows you to erase parts of the image. Erased areas
are replaced with the Background Color.

Background Eraser E This makes the erased area transparent.

Magic Eraser E
Much like the Magic Wand Tool, effective for removing
areas of similar colour. Check ‘Contagious’ in the
Options Bar to ensure the area you remove is smooth.

Gradient Tool G

Click on this tool, draw a line in the canvas to create a
gradient from the foreground colour to the background
colour. Options to create more complex gradients can
be found in the Options Bar.

Paint Bucket G
Fills an area of the screen with the foreground colour.
The tolerance of this tool can be adjusted in the
Options Bar.

Blur Tool R
Using this tool, you can blur part of the image, strength
of the blurring can be adjusted in the Options Bar.

Sharpen Tool R Use this tool to sharped the image.

Smudge Tool R Use this tool to smudge the image.

Dodge Tool O

Use the Dodge Tool to lighten parts of the image, you
can choose to lighten shadows, highlights or midtones
using the Options Bar. You can also set the exposure
of the Dodge Tool.

Burn Tool O

The Burn Tool darkens parts of the image. Like the
Dodge Tool , you can choose to darken shadows,
highlights or midtones using the Options Bar. You can
also set the exposure of the Burn Tool.

Sponge Tool O
The Sponge Tool can be used to saturate or desaturate
the image, that is, make the colours more or less vivid.

Path Selection Tool A
This line allows you to select vector graphics (the sorts
of lines and shapes you can draw with the Pen Tools in
Photoshop).

Direct Selection Tool A
This allows you to manipulate vector graphics such as
lines, shapes and text.



Photoshop: The Basics

www.ibrett.com
© Brett Lamb 2004

6

Horizontal Type Tool T
Creates horizontal type, you can adjust the size and
font in the Options Bar.

Vertical Type Tool T Creates vertical type, you can adjust the size and font
in the Options Bar.

Horizontal Type Mask Tool T
This creates a horizontal text shaped selection which
can be manipulated in various ways.

Vertical Type Mask Tool T This creates a horizontal text shaped selection which
can be manipulated in various ways.

Pen Tool P

The pen tool is used to create paths, which can be
made into selections or objects that can have a stroke
around the outside or be filled with colour (like
triangles, rectangles and other shapes).

Freeform Pen Tool P
The Freeform Pen Tool allows you to create freehand
paths.

Add Anchor Point Tool
The Freeform Pen Tool allows you to create additional
anchor points on a path, essentially giving you the
ability to manipulate it in very flexible ways.

Delete Anchor Point Tool Allows you to change paths by deleting anchor points.

Convert Point Tool Another tool for manipulating anchor points of a path.

Rectangle Tool U Draws rectangular paths.

Round Rectangle Tool U Draws rounded rectangular paths.

Ellipse Tool U Draws ellipses.

Polygon Tool U Draws polygons.

Line Tool U Draws lines.

Custom Shape Tool U Draws custom shapes.

Note Tool N
Creates post-it notes which can be positioned
throughout the document. Useful if you’re working with
other people.

Audio Annotation Tool N
Creates audio annotations which can be positioned on
the canvas. Useful if you’re working with other people.
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Eye Dropper I
The Eye Dropper Tool is used to select colours from
the canvas. The selected colour becomes the
Foreground Color.

Color Sampler Tool I
Selects colour information from a specified point in your
image. You can store up to four different colours.
These can be cleared using the Options Bar.

Measure Tool I
Used to measure areas on the screen. Values appear
in the Options Bar.

Hand Tool H Used to scroll around your document.

Zoom Tool Z
Select a particular area of the screen to zoom into.
Holding down the Option/Alt button enables you to
toggle between zoom in and zoom out.

Foreground/Background Color
If you click on the foreground or background colour,
you will be presented with a dialogue box allowing you
to select the colour you desire.
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Photoshop basics: Starting a new document

When you launch Adobe Photoshop, you can start a document by selecting File>New.
You will be presented with a dialogue box asking you to specify the size and various
other parameters.

Selecting the Preset Sizes submenu allows you to choose from a range of preset
document sizes, such as A4, 640x480, Standard PAL. There is an exhaustive list of
options. If you’re working in video or print, two mediums which require very specific
page and screen sizes, this drop down menu quickly becomes a necessity.

You can also manually input the desired size of your image. If you click the drop down
menu to the right of the height and width fields, you’ll find different forms of
measurement – pixels, inches, centimetres, millimetres, points, picas and columns.

The resolution of your document depends on what the image is intended for. If it’s for
the web, set the resolution to 72 pixels/inch. If you’re creating a print layout, the
minimum resolution should be 300 pixels/inch. The higher the resolution, the slower
your computer will perform.

You can select a range of colour modes, including Bitmap (black and white), Greyscale
(shades of grey), RGB Color (colours are created using a combination of red, green and
blue – best for onscreen work such as images intended for webpages), CYMK (colours
are created using a combination of Cyan, Yellow, Magenta and black – this is best for
work that is going to be printed, such as posters and magazines) and Lab Color.

When you launch Photoshop with an image in the clipboard, Photoshop will automatically
set the width and height of the new image to the dimensions of that picture (so, if your
image is 50 pixels wide and 70 pixels high, Photoshop automatically puts these figures
into the width and height fields.
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Photoshop basics: Working with layers

One of the most useful aspects of Photoshop is its ability to work with multiple layers.
That is, you can have multiple images stacked on top of each other. Here’s an example
of what your document might look like if you’re working with three different layers.

   
In this example, there are three layers. A thumbnail image of each layer is shown in the
Layers Palette. Simply by dragging layers, you can rearrange their order.

   

You can also adjust the Opacity of each layer.

   

Here, the opacity of the top layer has been reduced to 50%. Experimenting with layers
and their opacity can produce complex and sophisticated images.
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Photoshop basics: The Layers Palette

When working with layers, you will need to use the Layers Palette. This palette allows
you to reorder layers, change their opacity, create new layers, hide layers, link layers
and delete layers.

When you’re working with multiple layers, you can manipulate the way a layer is blended
with the layer beneath it. Here are examples of the layer blending modes available in
Photoshop.

BLENDING MODE EXAMPLE
Normal

Dissolve

Change blending
mode

Click here to lock all
or parts of a layer.

Click in this space to
link a layer to the

currently selected layer

Click here to create a new
layer – dragging layers onto
this icon will crate a duplicate
of the selected layer.

Click here to delete a
layer – or simply drag
the layer to the trash.

The opacity of a layer can
be adjusted here.

Clicking on  this icon
will hide/show a layer.
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Darken

Multiply

Color Burn

Linear Burn

Lighten
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Screen

Color Dodge

Linear Dodge

Overlay

Soft Light
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Hard Light

Vivid Light

Linear Light

Pin Light

Difference
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Exclusion

Hue

Saturation

Color

Luminosity
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Photoshop basics: Selection

If you’re going to do sophisticated work in Adobe Photoshop, you need to understand
selection. Your ability to produce sophisticated imagery hinges on your ability to use the
selection tools. If you wish to select parts of the image, you can use the following tools
in the toolbox.

Rectangular Marquee Tool Magic Wand

Elliptical Marquee Tool Lasso Tool

Single Row Marquee Tool Polygonal Lasso Tool

Single Column Marquee Tool Magnetic Lasso Tool

Because selection is so important when you start creating sophisticated images, Adobe
Photoshop has an entire menu dedicated to the ways in which you can select parts of the
image. Here’s a quick summary of the feature you’ll find in this menu:
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MENU ITEM DESCRIPTION

All This allows you to select the entire image.

Deselect Deselects currently selected area.

Reselect Reselects previously selected area.

Inverse Selects the inverse of your current selection.

Colour Range… Allows you to select a particular colour. When you select
this item, you will be presented with a dialogue box. You
can toggle between a black and white picture of the
Selection and the Image itself. When you click on the
‘Image’ button, you can choose the colour that you want
to select using the eye dropper. The selected colour range
will be displayed in the dialogue box.

Feather…
This menu item allows you to feather the area selected. In
the following example, a rectangular area around the
picture has been selected and feathered by 10 points.
Notice what happens when the selected are, which has
been feathered, is deleted.



Photoshop: The Basics

www.ibrett.com
© Brett Lamb 2004

17

(notice the slightly rounded corners
on the rectangular selection)

When the feathered area is filled, the image
slowly fades into the fill colour.
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Modify>Border… This constrains the image by creating a border around it.
In the following example, the entire area has been
selected. A border of 15 pixels has been created using the
background colour.

Modify>Border (15 pixels)

Pressing delete…

Fills the border with the background colour
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Modify>Smooth… This smooths the selected area. In the example, an
irregular selection has been made with the Polygonal
Selection Tool and it has been smoothed by 10 pixels.

Modify > Smooth (10 pixels)

Modify>Expand… Expand allows you to increase the selected area by a
specified number of pixels. In the example, a selection has
been made with the Lasso Tool. It has been expanded by
10 pixels.
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Notice that the selected area has increased
by ten pixels around the perimeter.

Modify>Contract… Contract allows you to decrease the selected area by a
specified number of pixels. In the example, a selection has
been made with the Lasso Tool. It has been contracted by
10 pixels.

If you look closely, you will notice that the selected area
has decreased by 10 pixels all the way around the

perimeter.
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Grow…
Using Grow will increase the selected area to encompass
nearby areas of similar colour. Here, an area has been
selected with the Lasso Tool and the Grow… function
has been performed. Notice how the selected area
increases each time to incorporate areas of similar colour…
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Similar… Similar… allows you to select areas of a similar colour or
tone to the area currently selected. In this example, a
small area of the picture has been selected with the Lasso
Tool. Choosing similar has selected areas of the picture
that are similar in colour.

Transform Selection Transform Selection enables you to manually resize the
selection.

Load Selection  Allows you to load saved selections.

Save Selection If you find yourself frequently selecting the same area or a
similar shape, you area able to save these selections for
later use. Saved selections can be reused by going to
Selection>Load Selection.
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Photoshop basics: The Edit menu

The Edit menu contains a range of powerful ways to manipulate the image you’re
working with. You’ll find yourself using the features under this menu quite frequently no
matter what sort of image you’re creating. Here’s a brief summary of the features you’ll
find in this menu.

MENU ITEM DESCRIPTION
Undo Allows you to undo the previous action.

Step Forward Allows you to move forward in the history.

Step Backwards Allows you  to move backwards in the history.

Fade Fade allows you to fade brush strokes after drawing
them. You can also apply various blending modes to
the brush. In this example, a squiggle has been
drawn on a layer above the background using the
Brush Tool. It has been faded to 70% of its original
opacity.
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Cut Allows you to cut out the selected area to paste
somewhere else.

Copy Copies the selected area.

Copy Merged Copies all of the visible layers into one image.

Paste Pastes the copied selection, creating a new layer.

Clear Clears the selected area.

Check spelling… Basic spell checker.

Find and Replace
Text…

Allows you to find and replace text, much like the
type of feature you find in a word processor.

Fill… Fills the selected area. You can choose from the
foreground colour, background colour, pattern, 50%
grey, black and white.
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Stroke… Creates a stroke around the selected area. In the
example, a five pixel stroke has been added to the
selected area.
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Free Transform… Free Transform allows you to manually rotate and
resize the selected area by dragging handles around
the selection area.

Transform… Under this menu you’ll find an array of vitally
important ways to manipulate your image, including:
Scale, Rotate, Skew, Distort, Perspective, Rotate
180º, Rotate 90º Clockwise, Rotate 90º Counter
Clockwise, Flip Horizontal and Flip Vertical. Some of
these functions are self-explanatory. The less
obvious ones have been described here.

Skew
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Distort Distort allows you to move the corners of the image
horizontally and vertically, it provides more freedom
than skew.

Perspective

Flip Horizontal
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Flip Vertical

Define Brush… Makes the selected area into a brush that can be
used when using the Brush Tool, Eraser and other
tools that rely on different shaped brushes.

Define Pattern… Turns the selected area into a pattern.

Purge Allows you to clear undo, the history and clipboard.

Preset Manager Allow you to manage the objects that appear by
default in the Brushes, Swatches, Gradients, Styles,
Patterns, Contours, Custom Shapes and Tools.
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Photoshop basics: The image menu

The Image menu is where you can adjust the colour and size of your image. There are a
number of fundamental, frequently used image manipulation functions under this menu.

MENU ITEM DESCRIPTION
Mode > This menu item allows you to set the colour mode of your

document. The most frequently used modes include
Bitmap, Grayscale, RGB Color and CYMK Color. If you’re
image is entirely black and white, chances are you’ve
accidentally set the mode to Greyscale or Bitmap when
creating the document. Changing the colour mode will
often flatten the image into one layer.

Adjustments > This menu essentially contains a range of important colour
manipulation functions. Under this submenu, you will find:
Levels, Auto Levels, Auto Color, Curves, Color Balance,
Brightness/Contrast, Hue/Saturation, Desaturate, Replace
Color, Selective Color, Chanel Mixer, Gradient Map, Invert,
Equalize, Threshold, Posterize, Variations.

Duplicate This allows you to create a copy of the document in a new
window.

Image Size… Allows you to chance the size of the image.

Canvas Size… Allows you to change the size of the canvas, the image will
not change, only the size of your workspace (unless, of
course, you make your workspace smaller than the
picture, in which case the original image will be cropped).
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Rotate Canvas> This allows you to  rotate your entire document 180º, 90º
CW, 90º CCW, as well as  by other values. It also enables
you to flip the entire document vertically and horizontally.

Crop Crops the image to the selected area.
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Photoshop basics: The Filter menu

The Filter Menu contains a range of powerful ways to manipulate your images. Examples
of some of these filters have been shown below. When creating advanced imagery in
Photoshop, you will need to have a good understanding of these filters. The best way to
get to know them is simply to experiment.

MENU ITEM EXAMPLE
NORMAL

This is the unprocessed version of the image that
has been used for these examples.

Artistic>Colored
Pencil
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Artistic>Cutout

Artistic>Dry  Brush…

Artistic>Film Grain
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Artistic>Fresco

Artistic>Neon Glow

Artistic>Paint Daubs
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Artistic>Palette Knife

Artistic>Plastic Wrap

Artistic>Poster Edges
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Artistic>Rough Pastels

Artistic>Smudge Stick

Artistic>Sponge
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Artistic>Underpainting

Artistic>Watercolor

Blur>Gaussian Blur
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Blur>Motion Blur

Blur>Radial Blur

Blur>Smart Blur
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Brush Strokes>
Accented Edges

Brush Strokes>
Angled Strokes

Brush Strokes> Cross
Hatch
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Brush Strokes> Dark
Strokes

Brush Strokes>
Ink Outlines

Brush Strokes>
Spatter
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Brush Strokes>
Sprayed Strokes

Brush Strokes>
Sumi-e

Distort>
Diffuse Glow
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Distort>Glass

Distort>
Ocean Ripple

Distort>Pinch
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Distort>
Polar Coordinates

Distort>Ripple

Distort>Shear
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Distort>Sphereize

Distort>Twirl

Distort> Wave
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Distort> Zig Zag

Noise>Add Noise

Noise>
Dust and Scratches
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Noise>Median

Pixelate>
Color Halftone

Pixelate>
Crystallize
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Pixelate>Fragment

Pixelate>Mezzotint

Pixelate>Mosaic
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Pixelate>Pointillize

Render>Clouds

Creates a random cloud in the selection based on
the background and foreground colour.

Render>
Difference Cloud
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Render>
Lens Flare

Sharpen>
Sharpen More

Sketch>
Bas Relief
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Sketch> Chalk and
Charcoal

Sketch>Charcoal

Sketch>Chrome
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Sketch>
Conte Crayon

Sketch>
Graphic Pen

Sketch>
Halftone Pattern
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Sketch>
Notepaper

Sketch> Photocopy

Sketch>Plaster
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Sketch>Reticulation

Sketch>Stamp

Sketch>Torn Edges
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Sketch>
Water Paper

Stulize>Diffuse

Stylize>Emboss
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Sylize>Extrude

Stylize>Find Edges

Stylize>
Glowing Edges
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Stylize>Solarize

Stylize>Tiles

Stylize>
Trace Contour
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Stylize>Wind

Texture>Craquelure

Texture>Grain
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Texture>
Mosaic Tiles

Texture>Patchwork

Texture>Stained Class



Photoshop: The Basics

www.ibrett.com
© Brett Lamb 2004

58

Texture>Texturizer
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Photoshop basics: The view and windows menus

The View Menu is essential for zooming in and out and showing/hiding guides. If you
don’t see a particular palette on the screen, you can show them using the Windows
Menu.
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1.1 Introduction and What’s New 

Welcome! If you have recently upgraded to CorelDraw X7 from X6, or being introduced to 

CorelDraw for the very first time, you are in for amazing discoveries.  The newest version of 

CorelDRAW has the same great power and features as X6, but the application interface has been 

revamped so it is extremely user-friendly, whether you are a beginner or have reached expert level.   

Corel CONNECT 

After installation of your new software, or when first launching CorelDRAW, a box will pop up on 

your screen that ask you to sign into your Corel Account or Create An Account.  Although this is an 

optional step, Corel CONNECT gives you access to an online community of users.  You will have 

access to new fills and other content that other users, as well as Corel, creates through CONNECT.   

There are two types of accounts.  The Standard Membership is free and guarantees all the fonts, 

clipart, and media that you would receive with a program on disc.  The Premium Membership has a 

monthly subscription fee and comes with a lot more of the “extras” you would expect to receive 

with a Premium account.  The following illustration shows the box that pops up on your screen.  

 

Welcome: Get Started  

Once you have either filled out or closed the registration data box, CorelDraw’s splash screen 

appears before the program opens.  This is where you are welcomed by a screen overlain on the 

workspace. If you are a previous CorelDraw owner you already know about the Welcome  

Screen, but if you are new user of version X7 you will see the number of options you have to choose 

from.  There is a number of different content that the Corel Corporation has provided – from 

tutorial videos to customized workspaces.  
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Let’s take a look at your options.  The illustration below shows the Welcome screen. This is the 

Central Location for starting a new design, doing research, selecting an interface, and getting the 

latest software updates.  

 

 Get Started This icon shows you the most common options to choose from when you want to 

start a new drawing or open up one you have previously saved.   You can also find these options 

under the File menu, and you can also open a new document and bypass the Welcome screen by 

selecting the New document icon   on the Standard bar.  

 Workspace When you click on this icon, you are given multiple workspace options – Lite, Classic, 

Default, Advanced, and Other.   

- Lite offers a limited Toolbox  

and other features.  

- Classic and Default interfaces 

are similar, except the Classic 

interface will remind experienced 

users of previous versions. 

- Advanced interface you can set 

up the program to make Desktop 

Publishing or Illustrator features 

more prominent and easily  

accessible.  

- Other interface allows users to set 

Up CorelDraw to remind you of 

Adobe Illustrator [or similar programs]. 

 What’s New is the destination to learn about all the new features in a more detailed but brief 

document, which is featured in the center of the screen when you click on the “What’s New “ icon. 

 Need Help? Displays a brief list of resources you can access online and directly within the program 

to get started.  Corel Corporation offers a great collection of video tutorials on the basics. 
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 Gallery Enjoy images that have been created by fellow CorelDraw users.  This gallery is updated 

frequently, so check the Gallery often to see new work. 

 Updates Stay current. Clicking on this icon let you check for the latest software and product updates.   

 CorelDraw.com This icon is a connection to the CorelDraw community and online world.  It does 

not actually take you to CorelDraw.com but give you the URL.  You can share your experiences, get 

tips and tricks, and interact with other community members at CorelDraw.com. 

 Membership & Subscription This is another opportunity to sign up for the Standard or Premium 

service.  Although it is optional, without creating an account [even a FREE Standard Subscription], 

you will not have access to the fills, fonts, and other media that you will want to access from within 

the program.  

Lastly, once you become tired of the Welcome screen after your fifteenth visit to CorelDRAW, 

you have the option to uncheck the Always Show the Welcome Screen at Launch checkbox at the 

bottom left.  Then, the program will always start with a bare menu.  From this point on you will 

need to either choose New from the File menu [or New from Template, or Open a saved 

document], or select the New button on the Standard bar.   

 

Before you can get started, CorelDRAW needs you to tell it what type of new document you would 

like to create. The following illustration will help guide you when Creating a New Document for 

the first time.  Just like the Welcome screen, at the lower left you can check the Do Not Show 

Again box.  However, it is not a bad idea to let this box appear each time.  Without this dialog, 

you will start a new document with default settings, and this could cause issues with page size, 

color settings, etc.  For example, a document set up for RGB color mode will not look accurate if 

you print it with commercial CMYK inks.  

 Name When saving a document, you can name it.   

If you name the document at the beginning of your 

Sesssion, all you need to do is press CTRL+S at any  

Time to save your work. 

 Preset Destination A destination in computer  

graphics terms mean “where the design you draw  

will be displayed.”  

 Size, Width, and Height boxes These options  

are where to set your page size.  Although you can 

change your page size at any time within CorelDraw,  

it’s nice to get this detail taken care in the beginning. 

There are a number of different units of  

measurements you can choose from and select  

Landscape or Portrait orientation.  

 Number of Pages You can add, take away, and  

Rearrange a multiple page document at the  

Beginning of your session, or anytime throughout.  

 Primary Color Mode Color mode for a graphics file holds great importance on your work.  It 

effects how colors are printed and displayed.  You can choose from RGB or CMYK.  

 Rendering Resolution The word resolution here means how many dots you want the printer 

to use to render your artwork to the desired material(s).   



P a g e  | 9 

 

 

 Preview Mode The best option is Enhanced mode.  It will provide the maximum viewing quality. 

 Color Settings This is a crucial feature that greatly effects and protects your artwork when 

printed.   

 Relative Colorimetric This setting does not preserve the whitest whites, but rather shifts all 

colors and all brightnesses to the nearest colors that the CMYK color space can express.  Realtive 

does exclude certain colors.  

 Absolute Colorimetric The White Point and Black Point, unlike Relative, is preserved in 

Absolute Colorimetric.  This guarantees that highly identifiable colors are reproduced accurately.  

 Perceptual This conversion method takes the entire range of colors from one device [such as 

your computer screen], and compresses it to fit the destination device [such as the printer].  

However, it may result in all the colors in the artwork changing, even if only a couple were out of 

CMYK range.   

 Saturation This is for a specific type of artwork – highly comic book-like artwork.  When color 

accuracy is not important this is your option.   

Finally, you can save your Custom settings by clicking on the 3.5” floppy disk icon next to the Preset 

destination option and then giving it a specific name.  

Now let’s move on to Exploring the Features that will help you Increase Productivity.  

 

1.2 Exploring Features and Increasing Productivity  

Utilizing Your Workspace 

Once your document has loaded and are ready to begin, the vast number of options and tolls can make one 

feel just a bit overwhelmed.  Don’t worry, you have more help than you know at the touch of your fingertips.  

You have the capability to refine, redefine, and customize your document with a few clicks and don’t forget, 

you also have a tutor right within the workspace.  

The Page Shadow  

The page shadow is the medium gray trim around the right and bottom of the drawing page in the 

drawing window.  Although it may not seem like it holds much importance and can be mistaken for 

merely an artistic embellishment, it is actually a shortcut to an array of useful options.  Whether you 

want to change the page orientation or resolution, it’s all just a double-click away.  You can find some 

of these options in the Property bar, but by using the Pick tool, you can double-click the shadow that 

opens up the Options dialog.   

 

 

 



P a g e  | 10 

 

 

dg 

Page Options on the Property Bar  

The terms Page Type or Page Size offer more options that what those words make it sound like.  In 

CorelDraw you have control over many more useful things than you think.  All you have to do is switch to 

the Pick tool to display the properties on the Property bar.   

 

Let’s take a closer, more detailed look, into the purpose of these features and how they can save you time. 

 Dimension number box These are defined as the numerical entry fields for the units you’ve 

selected for the current page size. You can change the page size at any time, merely by typing in the 

value.  No need to type in the abbreviation for the units, as you the software knows you have already 

selected a specified setting when the document was created.  

 Elevator buttons Elevator buttons are, the majority of the time, located to the right of the 

dimension number block fields.  Just as the arrows suggest, the up arrow increases the values and the 

down arrow decrease the value.  

 Portrait and Landscape Orientations With a simple click of a button, you can rotate your page 

by 90 degrees.  

 Set Dimensions for All Pages After you set a new page you can click this button to have ALL 

the pages in your multipage document identical. 
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 Set Dimensions for Only the Current Page Click this button while viewing the specific page, 

if you want only the current page unique in size.  

 Units drop-down If you select this button a drop-down list of units will appear.  You can change 

all features that display and use units.  

 Treat All Objects As Filled toggle A toggle is just a computer term used for an “on/off 

switch.”  This is a very helpful feature to artists, especially those that are used to programs such as 

Illustrator.  When toggled (or “on”) the icon has a slim outline around it.  This comes in handy when 

you want to keep an object unfilled but the outline width is so thing the object is hard to select.  

 

 
 

 Nudge Distance The arrow keys on a keyboard are often used to move a selected object a 

predefined distance, or nudge distance.  However, you can also use the elevator buttons to nudge an 

object.  This is a great tool to use when you have an object that needs to be moved while you edit 

another object but need it returned to its original position.  

 Duplicate Distance A quick and easy way to copy and paste an object is CTRL+C then CTRL+V.  

However, when using this shortcut, it copies the object directly on top of the original.  If you press 

CTRL+D, it will duplicate your selected object and then you can use the fields to select where the copy 

will appear.  

A Quick Hint 

The Toolbox has a vast number of tools to enhance your creativity and many of the tools you see are 

only at the top face of the tool group.  Look a little further at the flyout and there lies even more different 

neighboring tools.  The pen tools, edit tools, and effects tools all contact these flyouts.  However, with 

so many options you may not know which one is the best option for you.  Helpful Hints are just a 

click away.  Select Help  Hints, and once you select a tool on the Toolbox, the Hints docker will 

provide an explanation of what the tool is most useful for.  
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Meet Your Three New Friends: CTRL, ALT, and SHIFT 

These three modifier keys are used in a large number of programs to extend a command.  In 

CorelDRAW, these modifier keys will become your best friends as they can be used to change a tool’s 

function.  Although each do something different depending on the tool selected, they do have some 

commonalities.  

 CTRL This is an abbreviation for Control.  However, in CorelDRAW you should also think of it as 

Constrain.  When holding down CTRL it will constrain the dimensions of an object.  For example, if 

you are using the rectangle tool, if you hold down CTRL while you drag, it will keep the object 

dimensions a perfect square.  

 ALT This key offers alternatives to the basic command or tool you are using.  ALT(ernatives).  ALT 

is not as common as CTRL or SHIFT, but it will come in handy from time to time.  For example, 

when using the Bezier tool, you generally end up with a curved path segment.  However, if you hold 

ALT while click+dragging with this tool, it creates a straight line segment.   

 SHIFT This modifier keys is the “add to” key.  For example, if you are using the Pick tool, SHIFT-

clicking on objects adds to the current selection of objects.  If you are drawing shapes with object tools, 

such as a Polygon, Ellipse, and/or Rectangle tool, holding SHIFT before you click-drag will draw the 

object from the center outward rather from the corner.   

*Remember that modifiers can be used in combination.  

The Power of a Right-Click (of the mouse)  

The mouse holds a great deal of power in CorelDRAW when you understand what right-clicking and 

setting up the mouse wheel actually does.  *Tablet users can access the same power by using pressure and buttons 

on their stylus.  

The Right-Click Menu 

Although it may go by many names, Windows has supported a pop-up menu, or a contextual menu. 

What this means is that the menu commands on the pop-up menu change, depending on which tool 

is currently selected.   
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Dropping a Copy of the Selected Object  

 Right-click+drag, release, use the pop-up menu. This is the easiest way to copy an object quickly if 

you are just getting used to a point-and-click device.  

 

 Left-click+drag, then click both buttons, then release. This is considered the traditional “drop a 

copy” CorelDRAW technique.  
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 Hit the SPACEBAR Key repeatedly while left+dragging a shape to make mulitple copies.  This method 

is used for duplicating when you want a quick way to populate a page with the same object.  

 

 

Page Navigation the Smart Way 

There are a number of shortcuts in CorelDRAW but only a handful that you should consider 

memorizing.   

 If you press down on the mouse wheel while dragging, you temporarily toggle to the Pan 

tool, which allows you to drag your view of the document window in any direction you 

choose.  

 If you roll the mouse wheel away from you, causing a clockwise rotation of the wheel, you 

zoom into the current document.  Rolling the mouse wheel toward you will zoom out.   

Don’t Forget About the Standard Bar 

The Standard bar is an element that doesn’t change or move (unless you deliberately hide it); the 

features remain the same no matter the tool you choose.  In Corel X7 the Standard bar has been 

revamped and simplified to bring you only the most needed features.   

Here are some of the features you will want to become familiar with: 
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 Import simply means to bring a copy of something into the drawing window and the original has not 

been touched. If you have worked in Adobe Illustrator before you might refer to this as placing a 

file.  

 Export is the opposite of import, but does not necessarily the same as saving a file.  

CorelDRAW provides its users with very extensive export filters.   This even includes 

exporting objects as typefaces.  For example, if you need a JPEG or PNG file you can do so 

from the Export dialog.  However, you remember that you are not sending the original 

artwork anywhere, but a copy, usually a different file format.   

 Zoom Levels In this box you can select from a number of preset resolutions or enter in a 

custom value.  The maximum zoom level is 264,583 percent, and the minimum is 1 percent.  

 Show/Hide Rulers This button toggles on and off to display and hide the rulers on the top 

and let of the drawing window border.  *TIP* You can move the rulers anywhere in the 

drawing window by SHIFT+dragging a ruler.  

 Show/Hide Grid When in View -> Pixels display mode, this button toggles the visibility of 

the different grid on and off, however a grid can continue to Snap To objects you move 

around, even when visibly hidden. 

 Show/Hide Guides This setting shows/hides any guidelines in a template or guides you’ve 

added to your document; this button has no effect if there are no guidelines in your 

document.   

 Snap To settings This drop down list offers options to make each interface object become 

magnetic [“sticky”] or not, which is useful when you want to enable the stickiness of the pixels 

in a photo you imported.   

 Welcome Screen In case you need to watch a tutorial video right away, or you disabled the 

Show Welcome Screen option, this button will give you access to the welcome screen 

 Options The Options dialog is the nerve center for customizing both the way your documents 

behave and look; but also how CorelDRAW behaves and looks.  The is probably one of the 

most important dialogs you’ll need for overriding default settings. ** SHORTCUT – CTRL+J 

 Application Launcher Although Corel CONNECT has its own button on the Standard bar, 

this drop-down list affords access right within CorelDRAW to all the other modules included 

in the X7 Graphics Suite. 

 

Shortcut Keys You’ll Want to Memorize 

Here is a list of important key combos, modifiers, and other shortcuts in X7 that you’ll want to 

memorize.  If you do, before long, CorelDRAW will seem more transparent, and the only thing you’ll 

need to concentrate on is the work itself.   
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A Brief Anatomy Lesson on Dockers 

Dockers are panels—palettes—where many different commands and controls related to specific tasks 

are grouped together in one handy location. Dockers put more of Corel’s power right at the tip of 

your cursor without forcing you to dig through lots of dialog boxes or flit between various toolbars 

and menus. In general, if you display a docker such as Window | Effects | Extrude, you might initially 

think it’s just a duplication of what’s on the Property bar when the (interactive) Extrude tool is your 

current tool. It’s not, however, and here’s the important difference: you can work on refining the 

extrude properties of an extruded shape indefinitely when the Extrude docker is open or minimized—

it’s simply there; you set it down on the counter, but you didn’t put it away, in a manner of speaking.  

In contrast, when you use the Extrude tool to work with the Extrude features on the Property bar, 

you will lose those features if you need a different tool for a moment because the Property bar is 

context-sensitive – it offers commands specific to the current tool.   

 These controls can be anchored to the edge of the screen and reduced to tabs by clicking the active 

docker’s tab (not its title bar). You can tear them off (undock them) and float them right next to where 

you are working in the interface. You can make your own groups of commonly used dockers. And, if 

you have a multi monitor setup, you can even drag them out of the application window and stick them 

on a different monitor so you have the maximum amount of space for your drawing window. It all 

begins on the Window | Dockers menu. 

Opening, Moving, and Closing Dockers 

Dockers can be opened using shortcut keys (if your memorized list isn’t complete!), through menu 

commands, or through toolbars. For example, to open the Contour docker, choose Window | 

Dockers | Effects | Contour, or press CTRL +F9. 

Dockers open to their last-used screen position and state, either docked or undocked. While docked, 

they are, by default, attached to the right side of your application window. Alternatively, dockers can 

be positioned on the left side of the screen or anchored on both sides of the screen with your 

document window in the middle. 

While undocked, dockers float above the document window and can be positioned anywhere on your 

monitor screen(s). Docked or floating is not an all or nothing choice; you can have some dockers 

docked and some floating at the same time.  The only situation you can’t have is more than one copy 

of a specific docker open at one time.  

Nested (Grouped) Dockers 

When more than one docker is open, they often appear nested, meaning that multiple dockers overlay 

each other on the right side of your application window. While dockers are nested, clicking their 

individual title bars or name tabs brings them to the front of the interface. 

A very quick way to build your own group of floating dockers—new to version X7—is to begin with 

one docker: display it by using the Window | Dockers command. Drag it by its tab into the drawing 

window to float it. Then click the Quick Customize button at bottom right of the floating docker. As 

you can see in the next illustration, the Quick Customize button offers an incredible wealth of 

additional, docking palettes. 
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By default, the new docker you checked appears in the right-side, docked position. You then 

click+drag the docker by its tab (not its title bar) and then drop it into the right column where the 

first floating docker’s tab is located. 

 

To separate a docker when it’s nested, you perform the reverse operation. You drag the tab away from 

the group until you see a gray preview box of where the docker is going to land. 

Finally, if you want to maximize your drawing window area but still keep docked and nested dockers 

handy, you click any tab, and the entire collection of dockers collapses to a neat row of titled tabs. To 

access any of the dockers once again, you click the tab of the docker you need and the group extends 

again with the selected docker open and the others tabbed in the right column, an improvement over 

docker behavior in previous versions of CorelDRAW. 
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CHAPTER 2 
Getting Started  
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2.1 Single and Multi-Page Documents  

You have an idea for promoting your product or service; you have your graphics, and you have some body 

copy and a snappy headline in mind. The next step is to define the dimensions within which you express your 

promotional idea. You’ll learn about layout styles, page dimensions for your screen and for printing, page 

reordering, and in the process, gain a good working knowledge of what you need to do—and what you can tell 

CorelDRAW to do—to create a page that suits your ideas. 

Setting Up Your Document Page 

Every new file you create has its own set of page properties that have two attributes: physicalproperties 

and display preferences. The physical properties refer to the size, length, and color of each page as you’d define a 

physical page in the real world. Display preferences control how page values are viewed. Let’s begin with the most 

common options and then move on to the more specialized features. 

Controlling Page Size and Orientation 

If you’ve unchecked the Always Show The Welcome Screen At Launch checkbox, the default size of a new 

document is CorelDRAW’s default, which might depend on the language version of CorelDRAW you use. For 

this US author, it’s US Letter, 8 1/2” by 11”, but this can be changed. The quickest route for document size 

change is through the Property bar while the Pick tool–and no objects–are selected. The Property bar features 

options for setting your page to standard-sized pages, custom sizes, and orientation.   If you have a multi-page 

document, the Property bar also has ways to change all pages at once or only the currently visible page. 

 

 

The Paper Type/Size and orientation options control the format of your document. When you have a specific 

format for a design you need to print, the following sections cover the options available to you in CorelDRAW. 

Paper Type/Size 

To make sure your CorelDRAW page matches the paper in your printer, clicking a Paper Type/Size option 

from the Property bar is the quickest method. From the drop-down box, you can choose Letter, Legal, Tabloid, 

or other common sizes. Once you’ve made a selection, the dimensions are automatically entered as values in 

the Page Width and Height boxes on the Property bar. If you have a limited need for different paper sizes, click 
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the Edit This List button at the bottom of the drop-down list, and you can delete seldom-used sizes: click 

Delete Page Size in the Options box.  

• Page Width and Height You are not limited to a page size that’s the same as the paper in your printer; page 

width and height values can be freely adjusted to match just about any paper size. For a custom page size, type 

specific values directly into the Page Width and Height boxes, and then press ENTER. 

• Landscape/Portrait Orientation Clicking either Portrait or Landscape on the Property bar while using the 

Pick tool (with no objects selected) sets the page orientation. If the page width you enter is less than the page 

height entered, the orientation is automatically set to Portrait, and vice versa for Landscape. Changing from 

one orientation to the other automatically switches the values in the Page Width and Page Height fields. 

• All Pages/Current Page You can create a document up to 999 pages long, with different pages set to any 

size or orientation. The All Pages and Current Page buttons operate in “either/or” fashion–like the orientation 

buttons–so you can set the page size either for all pages in your document at once (the default) or only for the 

current page. To set only the current page to be different from the others in your document, click the right of 

these two buttons on the Property bar (directly to the left of the Units drop-down) and set your new page size 

and orientation as needed. Other pages in the document aren’t resized when you choose this option. 

Page Viewing Options 

With CorelDRAW at its default settings, when you select File | New, you’ll see a rectangle in the workspace. 

This rectangle represents your document page in height and width. However, what youwon’t see is how your 

page will be printed to a personal printer or to a commercial press. Whenever you print a page, you’ll see two 

areas called the printable area and bleed area, and you can add nonprinting guidelines to provide a page preview 

… so objects and text at the edges of your work don’t get partially printed. You certainly want these features 

visible when designing for print; the grippers on printers often prevent edge-to-edge prints. 
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Naming Pages  

Whenever a new document is created, CorelDRAW automatically creates the names, such as “Page 1,” “Page 

2,” and so on. These default page names can be customized using several different methods. 

When creating web page documents—where each document page is a separate web page—adding a unique 

name to the page creates a title for the exported page. When your document is printed, page names can also 

be printed in the margins, can indicate the contents of the page, and can provide other page-specific 

information. 

Using the Rename Page Command 

Use the Rename Page command to assign a unique name to pages. Choose either Layout | Rename Page, or 

(more quickly) right-click the Page tab of your document window and then choose Rename Page from the 

pop-up menu to access the command. The Rename Page dialog can rename a page with a name of up to 32 

characters, including spaces. 

 

 

Navigating a Multi-page Document 

To go to different pages in a document, click a Page icon at the lower left of the document window. If the 

page isn’t in view, you can scroll to locate it, or (for lengthy documents) open the Go To Page dialog, shown 

next, by clicking between the Next Page and Previous Page buttons at the lower left of your document 

window. It’s the field that lists the pages, “2 of 4,” for example; the field turns light blue when you click on it. 

You can move quickly to a specific page in your document with this feature. 
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Using the Object Manager 

The Object Manager docker offers the advantage of mass-editing page names from within a single docker. To 

open the Object Manager, choose Windows | Dockers | Object Manager. Once the docker is open, you 

want to be able to see all the pages in your document, so first make sure the Layer Manager View (the third 

button at top) is set to All Pages, Layers, And Objects. Then click the first of the three buttons at top, Show 

Object Properties. 

 

Page Commands 

There are several ways to add and delete pages from a document; using menu commands, shortcuts while 

holding modifier keys, and certain page views are three methods. However, quick is best, and in this section, 

you’ll see the most convenient way as well as methods that are easiest to remember. You can decide for 

yourself which best suits the way you work. 

Inserting Pages and Setting Options 

From the main menu, choose Layout | Insert Page to open the Insert Page dialog, which has a host of 

options for specifying your new page properties and where you would like to add the new page in relation to 

your existing pages.  
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Deleting Pages 

Deleting document pages can be done by choosing Layout | Delete Page from the main menu; you can delete 

one or more of the existing pages in your document. By default, the dialog opens to display the current page 

as the page in the Delete Page box, shown at right, but you may select any page before or after your current 

page if you choose. To delete an entire sequence of pages, click the Through To Page option, which enables 

you to delete all pages in a range between the page specified in the Delete Page box through to any page 

following your current page. Pay careful attention to the word “Inclusive” after the last page number: if you 

type, for example, 10 when you want to delete pages 1–9, well, oops–there goes your day unless you press 

CTRL+Z immediately!  

Moving and Duplicating Pages 

You’re going to create such fantastic content in CorelDRAW that you might not even want to delete it. 

Instead you might want to move and/or copy pages. To move a page, use a click-drag action on the Page tab 

to drag it to a new position. To copy a page–and all its contents–thus creating a new page order, hold CTRL 

while click-dragging the Page tab, dragging the page to a new position. You can see this in the next 

illustration. CorelDRAW does not duplicate the name of a user-named page; you’d wind up with an 

organizational nightmare if it did, so it’s a good practice to name a duplicate page after you’ve created the 

copy. 

 

Using the Page Sorter 

Page Sorter is a view that provides you with a broad look at your document and all its pages. In this view, you 

can add, delete, move, or copy pages in a single view. You can also change the Paper/Type Size and the page 

orientation of all the pages or just selected pages. A CorelDRAW document can contain pages of different 

sizes, which can be very handy when you are designing matching business cards and letterhead or other 

similarly related materials. To open your document and all its pages in Page Sorter view, choose View | Page 

Sorter View. Page Sorter displays all pages in your document. 

In Page Sorter view, a single click selects a page. Holding SHIFT while clicking pages enables you to select or 

deselect contiguous multiple pages. Holding CTRL while clicking enables you to select or deselect 

noncontiguous pages. The following actions enable you to apply page commands interactively to single or 

multiple page selections. 
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• Move page(s) To move a page and change its order in your document, click-drag the page to a new 

location. During dragging, a vertical I-beam appears, indicating the insertion point for the page or the first 

page of the selected sequence of pages. 

• Add page(s) To add pages to your document, right-click any page and choose Insert Page Before or Insert 

Page After from the pop-up menu to insert a page relative to the selected page. 

• Copy page(s) To copy pages–and their contents–hold CTRL while click-dragging the page to a specific 

location. During dragging, a vertical I-beam appears, indicating the insertion point for the page copy or the 

first page of the selected sequence of pages. 

• Name or rename a page To add a new name or change an existing page name, click the page name below 

the page to select it; click a second time to highlight the page title, and enter a new name; then press ENTER. 

You can also rename a page by right-clicking a specific page and choosing Rename Page from the pop-up 

menu to highlight the page name for editing. 

• Change page size/orientation of all pages In Page Sorter view, the Property bar displays typical page 

property options for applying standard or custom page sizes and changing the orientation between Landscape 

and Portrait. 

If you want to change the orientation of all of the pages in the document, click the Apply Page Layout To All 

Pages button on the Property bar and then click either the Portrait or the Landscape button to change all 

pages to that orientation. 

• Change page size/orientation of selected pages If you only want to change the orientation of some of 

the pages, click the Apply Page Layout To Current Page button. Then select the pages you want to change, 

and click the Portrait or Landscape button to change the page(s) to the desired orientation. 
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Changing the orientation in Page Sorter view not only changes the view, but also changes how the pages 

themselves are oriented in the document. As you can see above, the first and last pages have drawings that 

look better in Portrait view; you CTRL-click pages 1 and 4 in this example, click the Current Page button, and 

both the Page Sorter view and the pages themselves are reoriented. If you want to rethink this dynamic 

change, repeatedly pressingCTRL+Z (Edit | Undo) to restore your document. 

Exiting Page Sorter view is easily done; click the Page Sorter View button. Any changes applied while in the 

Page Sorter are applied to your document. 

 

Working with Guidelines and Guide Layers 

Now that you have a handle on page setup, multi-page particulars, and page dimensions, it’s time to turn to 

perhaps the first thing you put on a page: a guide. Guides help you design with accuracy and give you a 

perspective on a composition so you save time second-guessing where items should be in relation to one 

another. 

CorelDRAW’s page guides, dynamic guides, and objects you put on guide layers don’t print. Guides are just 

like the blue pencils some of us used on drafting tables before computer graphics. With today’s digital tools 

and electronic guidelines, you have the precision only a computer application such as X7 can offer, plus the 

same speed and ease with guides as any object you draw on a page. 

Using Guidelines 

Guidelines placed on your document page extend between the top, bottom, left, and right edges of the 

document window. Guidelines appear as vertical and horizontal dashed lines, but guidelines can also 

be rotated. In CorelDRAW, guidelines are considered unique objects–they have their own properties but are 

manipulated in many ways like objects you draw. 

To view and hide the display of guidelines in your document window, right-click a blank area of the page and 

then choose View | Guidelines. By default, a new document doesn’t have any guidelines–you need to create 

them.  To have objects snap to the guidelines you create, choose Snap To | Guidelines on the Standard bar. 
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Manipulating Guidelines 

• Make sure the rulers are visible; they’re where many of the guides live. With the Pick tool selected, and no 

objects selected, right-click and then choose View | Rulers. Then, using any Toolbox tool you like, click-drag 

beginning on a ruler, and release the mouse button anywhere in the workspace. Although dropping a guide 

on the page is most useful, you can certainly create a guide on the pasteboard area to measure and align 

objects not currently placed on the page. 

• To move a place guide, you need to select the Pick tool. Then hover the cursor over the guide you’d like to 

move; when the cursor turns into a double-headed arrow, you’re all set and all you need to do is to click and 

drag the guide. 

• If you want to eliminate a guide, hover over it with the Pick tool until you see the double-headed arrow 

cursor (to indicate you’ve selected it), click the guide to confirm the guide is “in focus” in the interface, and 

then press DELETE or CTRL+X. 

• If you need a guide that travels diagonally, you create a guide first. Next, click it to select it, and then click a 

second time, and you’ll see a center and rotation handle. One of the neat things about rotating a guideline is 

that you can move its center point before dragging on the rotation handles to, for example, rotate a guide 

around the corner of a shape you have on the page. You move a slanted guideline exactly as you do a 

perfectly horizontal or vertical guide–you click-drag it to reposition it. In the illustration of the light bulb, 

where the design needs shafts of light emanating from a center point, that is not the default center of a guide 

that’s put into slant mode. No problem; you change the center of rotation, and then drag a rotation handle 

clockwise or counterclockwise.  
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Controlling Guideline Properties 

If you place several guidelines at an exact spacing, you manage all guidelines via Tools | Options | 

Documents | Guideline. Separate subsections are here for controlling the vertical, horizontal, and slanted 

guidelines. You can also right-click either of the rulers, choose Guidelines Setup, and a Guidelines docker 

appears. Additionally, while a guideline is selected in a document, you can open the Guidelines docker by 

clicking the Guidelines button on the Property bar. 

The engineers at Corel have simplified the process and centralized your options for guidelines placement, all 

through the Guidelines docker. You first choose Horizontal or Vertical Guides from the drop-down list; the 

Y box becomes active; and you type in a value, then press Add. Remember, the Y measurement is, by default, 

the same as the rulers: values increase from bottom to top. You also have a lock option. You can change a 

guide’s value on the page by typing in a new value after you’ve clicked the guide in the list and then click the 

Modify button. Additionally, at any time, your cursor can “step out of the box”; you can make a manual 

adjustment and that adjustment is reflected in the inches value on the Guidelines docker’s list.  
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Adding, Deleting, and Moving Guidelines 

You can adjust guides using the Guidelines docker’s Modify feature. The list below the main area on this 

docker contains the position of the existing guidelines on your document page. Here are steps to perform 

common tasks: 

1. To create a new guideline, first choose Horizontal or Vertical from the button drop-down. Now, 

enter a value in the Horizontal, Vertical, or Angled num box according to the position where you 

want the new guideline to be created. Then click the Add button. A new guideline is created where 

you want it. 

2. To move an existing guideline, click it in the list, type the new value in the x or y num box, and then 

click the Modify button. The selected guideline has moved, and on the list, you can see its new location is 

correctly entered. 

3. To delete a specific guideline, select it in the list, and then click the Trashcan button at lower right on 

the docker. The selected guideline is gone from the page, and as you see the page from your current view, 

your document is immediately updated. 

4. To remove all guidelines in the list, marquee-select all the entries on the list, and then click the 

Trashcan button. 

Locking and Unlocking Guidelines 

All guidelines are editable by default; you can move or delete them using the Pick tool. But occasionally a 

guide that moves accidentally is as welcome as a friend holding your ladder sneezing accidentally. You can 

lock guidelines simply by selecting the guide with the Pick tool; the cursor should turn into a double-headed 

arrow straddling the guide, and then you choose Lock Object from the pop-up menu when you right-click. 

Unlocking a guide is the inverse process of locking one. With the Pick tool, right-click over the guide and 

then choose Unlock Object from the context menu. 

Working with the Guides Layer 

Guides belong to a special layer–named Guides on the Object Manager–reserved just for these assistants. To 

view the layers in your document, open the Object Manager by choosing Window | Dockers | Object 

Manager. There are two Guides layers: if you click the Guides (All Pages) entry on the Object Manager list 

under Master Page, every guide you create will be featured on this page and on every page you create in the 

future in this document. On the other hand, every new page, including the first page, comes with its own 

Guides layer, and guides specific to a layer will not show on other pages. By default, all guidelines on the 

Guides layer are set as Visible, Non-Printable, and Editable. You can change any of these by clicking the 

symbols to the left of the Guides layer in the Object Manager docker. 

To set all options for a layer at once–including the display color of objects on the Guides layer in the Object 

Manager docker, right-click the layer name, for example, the Guides layer, and then choose Properties from 

the pop-up menu. Doing this opens the Guides Properties dialog to reveal further options. 
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Make an Object a Guideline 

You can make almost any drawing shape into a guideline. Going the other way around, you can also turn a 

guide into a drawing object, and moving any guideline to a drawing layer automatically makes it a printable 

object. You use the Object Manager docker to move objects between layers. Moving any object to the Guides 

layer makes a guideline, with all the same properties as a typical guideline, except it doesn’t have to be a line–

spirals and trapezoids make useful guides. After an object becomes a guideline, anything you draw in its 

proximity snaps to it, as long as the Snap To Guidelines option is active. Think of the artwork you can clean 

up and refine when you’re tracing over the original with a drawing tool that snaps to the original. 

To move an object to the Guides layer, follow these steps: 

1. Create or select at least one drawing shape that you want to use as a guideline. 

2. Open the Object Manager docker by choosing Windows | Dockers | Object Manager. 

3. Expand the tree directories in the Object Manager docker to locate both the Guides layer on the Master 

Page and the shape you want to make into a guideline so both are in view. 

4. In the Object Manager docker, click-and-drag your shape icon (not the shape on the page) from its current 

page and layer to on top of the Guides layer title on the Master Page. As you drag, your cursor changes to an 

arrow pointing at representations of layers, indicating the shape’s current position as it is dragged. You then 

release the mouse button and the operation is a success.  

 

 

 

 

The New Alignment and Dynamic Guides Docker 

Corel Corp. has made a dramatic change and improvement to Dynamic Guides, adding Alignment and 

Margins between aligned objects as an additional perk in X7. You’ll find the Alignment and Dynamic Guides 

docker under Windows | Dockers. The docker actually has three areas of functions–Alignment, Guides, and 

Margins–and you can enable all of them (although your screen might become cluttered with data you don’t 

need), or uncheck one or more of the functions to use only what you need.  
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Alignment Properties on the Docker 

Before moving forward, do not mistake the Alignment feature on this docker for the Align and Distribute 

docker (CTRL+SHIFT+A). The Alignment and Dynamic Guides docker is a manual feature–it reports to 

you and offers suggestions but it does not align things for you. It’s a really sophisticated ruler, not a pocket 

calculator as analogies go. 

To begin at the beginning, you must check the box for Alignment Guides on the docker before you can do 

anything with the Alignment and Dynamic Guides docker. 

 

The goal here is to align the house at the bottom right of the housing.cdr file (open it and try this yourself). By 

simply using only the Alignment features–Margins and Dynamic Guides are disabled–you don’t have to hold 

CTRL to constrain movement and all you do is drag up and a little to the left until you can see that the 

chimney hasn’t moved horizontally at all as it’s moved up vertically–the dashed light-blue alignment guide 

demonstrates this when your object is aligned, and the guide disappears if your object is moved off-alignment, 

or you release the mouse button. 

• Object Centers Click this button if you want these temporary guides to appear when the object you’re 

moving becomes aligned, vertically or horizontally, with the center of other objects on the page. This option 

is really good for quickly making an accurate distribution of several objects that you need to equally space 

apart. 

• Object Edges This option is good to use in combination with Object Centers, so you can see exactly where 

in relationship to another your desired object lays. In the case of aligning a square with another square, you 

will see two guides, one indicating top-edge alignment and the other indicating bottom alignment. 

• Individual Objects in a Group When you need to align grouped objects, it’s not necessary to ungroup 

them and then use either the Alignment and Dynamic Guides or the Align and Distribute dockers. Nope: you 

use the Pick tool to CTRL+click the lucky object to be aligned to something else in the drawing, and then 

move it around until the temporary guides tell you that your object is now realigned. 
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• Intelligent Spacing This feature is sort of like an equidistant distribution function. In the illustration here, 

you can see that the diamond is selected and the goal is to place it an equal distance between the club and the 

spade. You’ll see these unique divider guides when the object is in the desired position, and the Intelligent 

Spacing option even tells you onscreen what the distance is between objects, in this case the x-spacing 

(horizontal) is 0.115 inches. Naturally, if you have units set up to a value other than inches, Intelligent Spacing 

will report picas, centimeters, and so on. 

 

• Intelligent Dimensioning Ordinarily, you’d want to hold CTRL to proportionately scale a selected object 

larger or smaller, but this is unnecessary when you’ve selected an object and clicked the Intelligent 

Dimensioning button. Open Brochures.cdr and give this a try. The left pamphlet is smaller than the one at right; 

also they are identical copies of each other. Suppose your boss unreasonably demands (at a quarter to five) 

that the left pamphlet be the same size as the larger one at right. No problem; as shown in this illustration, 

you click the Intelligent Dimensioning button in the Alignment Guides area of the docker, and then with the 

Pick tool, you drag any corner control handle away from the center of the tiny pamphlet. Once the special 

blue guies appear for either the height or the width, you can release the mouse button and both objects are 

identical out to three decimal places.  
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Adding Margins to the Mix 

Aligning things can be an exciting sport, especially on rainy days, but artistically, there are often times when 

you need to not only align objects, but also add space–a margin–between the objects. And this is where the 

Margins area of the Alignment and Dynamic Guides docker comes into play. 

Like the alignment options, margins can be set to any color and be dashed or solid in appearance, so there’s 

zero chance that what you’re aligning will be the same color as these guides. The feature is simple to use and 

to explain: You should have Object Edges and/or Object Centers enabled in the Alignment Guides area first 

or the margins won’t be awfully relevant to your aligning efforts. Enable Margins you want between the 

aligned objects. Pick one of the objects and then start dragging it toward the other object. See the following 

illustration; it can’t hurt. You’ll see by the alignment guides when the tops and or bottoms are aligned, but 

then you’ll see markers, shown in the next illustration, that tell you when you’ve reached the desired margin 

between the objects. 

 

 

Dynamic Guides 

Okay, this is the weird and wonderful part of the Alignment and Dynamic Guides docker. Dynamic Guides 

can actually help you draw technically accurate objects because your cursor snaps to the nearest of angles that 

you enable on the docker. 
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• Default angle increments You have a number of degrees, spread out in 15 degree increments, that you 

can use (or not use by unchecking their boxes) when the Dynamic Guides feature is enabled. This means that 

every time you draw a straight line (let’s say you use the Polyline tool), end the path segment, and begin 

another, when you come to a 15 degree or 30 degree angle relative to the angle of the first path segment–

CorelDRAW pops up onscreen info called a tool tip, informing you that you are beginning this next segment 

from the edge of the preceding one, the number of degrees off the original path’s orientation, and how far 

you’re traveling away from the end of the first path. 

• Extend Along Segment Without needing to pull a guide out of a ruler and rotating it so it’s perfectly 

aligned with a path you’ve drawn, you can activate Extend Along Segment, and the temporary Dynamic 

Guide will keep you on the straight and narrow. 

 

• Snap To Tick spacing There are invisible tick marks when you drag a path segment; you’ll “feel” some 

resistance when you use your mouse to pull the onscreen cursor a specific distance. Tick spacing is found in 

the Alignment and Dynamic Guides docker. First, click the right-most icon, and then the num box becomes 

active for Tick Spacing tweaks. You enable and disable this feature by using this button on the docker. 

• Creating a custom angle and saving the custom angle You might find that 15 degree increments aren’t 

what you need–for example, to make a five-sided polygon (yeah, yeah, you could use the Polygon tool, but 

play with me here), you’d need an angle of 72 degrees, not to be found on the preset list. So you type in this 

value, click the +button to add it to the list, and off you go. 
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If you have any doubt that Dynamic Guides can make quick work of shapes that are exceptionally 

complicated, check out this next figure. It was created entirely using Dynamic Guides at default preset values 

and paying attention to how long each segment was using the tooltips. 

 

 

 

2.2  Basic Shapes and Transformations 

You have to begin somewhere with the DRAW part of CorelDRAW–and this is it. Therefore, you need 

to know the steps to create simple geometric shapes and the basic editing moves to create exactly 

the shape you want to fill and stroke. 

Using the Rectangle Tool and Property Bar 

The Rectangle tool is simple enough to use, but it doesn’t just create a four-sided, right-angle polygon–it 

creates a rectangle that has special properties in CorelDRAW. You’ll find the Rectangle tool in the Toolbox; you 

can quickly select it by pressing the F6 shortcut key. 

The Rectangle tool gives you the option to apply corner “roundness” based on a percentage value.Roundness 

can be set either manually by dragging a corner with the Shape tool–the most common technique experienced 

Corellians use–or by using the Property bar’s Corner Roundness option, which is available when a rectangle is 

selected. By default, you round all four corners equally and together. However, if you unlock the Edit Corners 

Together toggle button, you can manually enter different values for each of the four corners, as discussed in 

the following section. There are several more features for changing the shape of a rectangle object that are 

reversible (no destructive changes are made) on the Property bar. 
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Drawing a Rectangle 

To create a rectangle, choose the Rectangle tool from the Toolbox, and click-diagonal-drag in any direction to 

define its corner positions, as shown here. The act of click-dragging begins by defining the first two legs; as 

you drag, the corner positions can be redefined, depending on where your cursor is on the page; and then 

before you release the mouse button, you’ve defined the position for the remaining rectangle corners and 

you’ve built the remaining sides. 

 

While the Rectangle tool is selected, notice that the cursor is a crosshair with a small rectangle shape at its 

lower right. As you click-drag using the cursor, you’ll also notice that the Status bar and Property bar show 

the coordinates, width, and height properties of your new object shape. 

Setting Rectangle Corner Properties 

Corner Roundness is one of three different effects you can apply and dynamically edit when you’re into 

rectangles. Corner Roundness, as well as the Scallop and Chamfer corner styles, can be applied to a rectangle 

from a value of 0 to about one-half the overall length of one of its sides. If you think about this one, a 2” 

rectangle can’t have more than a 1” rounded corner on each side! The Corner Roundness amount can be 

changed anytime while the shape remains a native rectangle, that is, as long as it has not been converted to 
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curves. By typing 0 into any of the size boxes while the rectangle is selected, you remove the corner style. 

Corner Roundness, Scallop, and Chamfer can be set uniformly for all corners (the default) or independently 

when the Edit Corners Together lock option is in the unlocked state. 

 While a rectangle is selected, use any of the following operations to change corner properties according to 

your needs: 

• Click the type of corner style you want on the Property bar, and then either type in the size for the corner 

values or drag the elevator buttons up or down to adjust the size of the corners. 

• Set your rectangle’s corners manually using the Shape tool, by first unlocking the Edit Corners Together 

toggle button, and then CTRL+dragging any corner control point away from its corner (toward a side that 

makes up the rectangle). Enabling Edit Corners Together causes all corners to be rounded or scalloped an 

equal amount by dragging on any of the control points. 

• Use the Object Properties docker by pressing ALT+ENTER, clicking the Rectangle tab, and then editing 

any property you so choose. 

 

 

 

Creating 3-Point Rectangles 

If you want to create a rectangle and rotate all in one fell swoop, you can use the 3-Point Rectangle tool. You’ll 

find it grouped with the Rectangle tool in the Toolbox. 

Using this tool, you can draw new rectangles at precise angles. The rectangle you create is a native rectangle 

shape, so you can round its corners and manipulate it as you would any other shape. 
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To create a rectangle using the 3-Point Rectangle tool, you click-drag–clicking sets the first point of the 

rectangle and the subsequent distance you drag determines both the angle and length of the rectangle. As 

soon as you release the mouse button, you move your cursor (without clicking–this is called hovering) to 

determine the height of the rectangle. A final click seals the deal and you now have a rectangle whose corners 

you can round and perform other operations on. 

Using the Ellipse Tool and Property Bar 

Ellipses are a staple of commercial design work. Essentially an ellipse is a circular shape that is not perfect. 

The Ellipse tool can be used to draw both circles and ellipses, but in CorelDRAW, an ellipse shape has 

additional, special properties, just like a rectangle can be a round-cornered rectangle. Ellipse shapes can be 

edited to create dramatically new shapes while retaining their elliptical properties. In contrast, a shape you 

might draw that looks like an oval, using the Bezier tool, for example, will have no special properties and 

always remains an oval. 

Ellipses are easy enough to draw with the Ellipse tool and can be set in several different states: as an oval or 

circular closed-path, pie wedge, or arc. Pie wedges are the portions of an ellipse–like a single slice of a pie or, 

conversely, a whole pie with a slice removed. Arc shapes are open paths, exactly like pie wedges, except the 

two straight line segments are missing. 

To create an ellipse, choose the Ellipse tool from the Toolbox or pressF7, followed by a click-drag in any 

direction. 

 

While the Ellipse tool is selected, the Property bar shows ellipse-specific options that enable you to control 

the state of your new ellipse shape before or after it has been created. Choose Ellipse, Pie, or Arc. A 
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complement is reserved for pie and arc shapes: for example, if you specify a 15-degree pie wedge, clicking the 

Change Direction icon changes the shape to a 345-degree wedge. Additionally, if you want a Pie or Arc to 

travel in a different path direction, double-click the Ellipse Tool icon on the Toolbox, which takes you to 

Options, where you can choose clockwise or counterclockwise path directions. 

Round One with the Ellipse Tool 

1. Choose the Ellipse tool (F7) and use a click-diagonal-drag action in any direction. As you drag, an outline 

preview of the shape appears. An ellipse shape has two overlapping control nodes (so onscreen it looks like 

only one node); if you drag down and left or right, the nodes will be located at 12 o’clock. Conversely, if you 

drag up and left or right, the control nodes will be located at 6 o’clock. 

2. Release the mouse button to complete your ellipse shape creation. 

Controlling Ellipse States 

All ellipses have two control points (nodes–a start and an end) that overlap each other and are visible when the 

ellipse is selected. When these control points are separated, they create either a pie or an arc state, and each 

control point determines either the starting or ending angle of the pie or arc. 

You can separate these control points either by using Property bar options or by dragging the points using 

the Shape tool. Dragging inside the ellipse’s shape creates the Ellipse Pie state. Dragging outside the shape 

creates the Ellipse Arc state. 

 

To draw a new pie or arc without drawing an oval-shaped ellipse first, click either the Pie or Arc button on 

the Property bar before you start drawing. You can also switch any selected ellipse between these states using 

these buttons. By default, all pies and arcs are applied with a default starting angle of 0 degrees and a default 

ending angle of 270 degrees. Starting and ending angles are based on degrees of rotation from –360 to 360 

degrees; this is counterclockwise in orientation. 

Creating 3-Point Ellipses 

The 3-Point Ellipse tool is the key for creating ellipses while setting a rotation angle (perfect circles show no 

possible rotation angle; we’re talking ovals here). You’ll find it grouped with the Ellipse tool in the Toolbox. 

This tool’s operation is very much like the 3-Point Rectangle tool. 

 



P a g e  | 41 

 

 

 

You can create ellipses at precise angles without needing to create and then rotate an existing one.  The shape 

you create is still an ellipse with all associated properties, such as optional pie and arc states. 

To create an ellipse using the 3-Point Ellipse tool, choose the 3-Point Ellipse tool, click to set the beginning 

point of the ellipse, and then drag to specify its width and rotational angle. Release the cursor and then 

position your cursor where you want the maximum height of the oval defined. Click, and your ellipse is 

complete. 

Using Polygons and the Property Bar 

The Polygon tool (the shortcut is Y) is unique to the category of vector drawing software; competing 

applications offer a polygon tool, but CorelDRAW’s Polygon tool produces shapes that can be edited–making 

dynamic changes, just like CorelDRAW rectangles and ellipses. The shapes you create with the Polygon tool 

can have as few as 3 or as many as 500 points and sides; by default, all polygon sides are straight paths. You’ll 

find the Polygon tool, together with the Star, Complex Star, and other group tools, in the Toolbox. While the 

Polygon tool is selected, the Property bar offers the number of sides for the polygon you’ll draw. 

Drawing and Editing Polygons 

To create a default polygon, you use the same click-diagonal-drag technique as you use with the Rectangle 

and Ellipse tools. This produces a symmetrical shape made up of straight paths. Because you’ll often want a 

shape more elegant than something that looks like a snack food, it helps to begin a polygon shape by 

holding SHIFT and CTRL while dragging: doing this produces a perfectly symmetrical (not distorted) 

polygon, beginning at your initial click point and traveling outward. Therefore, you have the shape positioned 

exactly where you want it and can begin redefining the shape. 

Here, you can see the Polygon tool cursor and a symmetrical default polygon. Because the Polygon tool can 

be used to make star-shaped polygons, there are nodes that govern the outer points of the star, and then there 

are “inner” nodes in between the points that control the curves between points. When you edit a polygon, the 

position of these points can be reversed. These nodes have no control handles because they connect straight 

path segments. However, in the following tutorial, you’ll get a jump start on advanced shape creation and 

really get down in very few steps to creating a dynamite polygon shape through editing. 
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Reshaping a Polygon 

1. Choose the Polygon tool from the Toolbox. Before you do anything else, set the number of sides to 12 on 

the Property bar. 

2. Hold CTRL to constrain the shape to a symmetrical one, and then click-diagonal-drag on the page. Release 

the mouse button after you have a polygon that’s about 3” wide. 

3. To better see what you’re doing, left-click over the color palette with the polygon selected to fill it. By 

default, polygons are created with a small stroke width and no fill. 

4. Choose the Shape tool from the Toolbox. Click any of the control points on the polygon to select it, but 

don’t drag yet. Hold CTRL and then drag outward, to constrain the movement of the cursor so the polygon 

doesn’t take on a lopsided appearance (although you can create interesting polygons by dragging in any way 

without holding CTRL). You should have a star shape now. 

 

5. Notice that on the Property bar you now have a lot of icons that control how line segments pass through 

nodes and whether the segments are straight or curved. Click any line segment that makes up the polygon; 

your cursor should have a wiggly line at lower right, as shown here, meaning that you’ve clicked a line. Then 

click the Convert To Curve button on the Property bar, converting not only the line, but also all the lines in 

the polygon that are symmetrical to the chosen line, to a curve. Or perhaps more simply, use the same 

command by right-clicking a point and using the pop-up contextual menu. 
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6. You’ll now see two control handles. They lay exactly on the segment that appears to be a line but now has 

curve possibilities. First, click an inner or outer original node along the polygon path, as shown next. This 

reveals the handles. It is now possible to create a curve by dragging on the segment between the control 

handles. Doing this, as you can see here, creates a very interesting and complex symmetrical shape, and you 

can now see the control lines and handles for the curve segment much more easily and can manipulate the 

control handles to further embellish your creation. 

 

 

Stars and Complex Stars 

You have variations on polygons at the ready in CorelDRAW, in the same group as the Polygon tool. The 

Star tool can be used to create pointy polygons with anywhere from 3 to 500 points. The Complex Star tool 

creates a number of combined polygons to make a star shape; you can create interesting symmetrical shapes 

by filling a complex star–the result contains both filled and vacant polygon areas as the component paths 

intersect one another. 

Working with the Star Tool 

The Star tool produces objects by using the click-diagonal-drag mouse technique; CTRL-SHIFT-dragging 

creates symmetrical stars beginning at the initial click point traveling outward. 

On the Property bar, when the Star tool is selected, you’ll see options for the number of points for the star 

and the “pointiness” (sharpness) of the resulting object–how severe the indents are between points. At a setting 

of 1, the star object is not at all pointy–you’ll see that it looks quite like a Polygon tool object. So, if you can 

make a star using the Polygon tool, why would you ever choose the Star tool? The answer is because when 

using the Star tool the geometric structure of a star shape is always perfectly symmetrical. Although you can 

use the Shape tool to tune the sharpness of a Star tool object’s points manually, the angle between points is 

always consistent. In the illustration here, you can see a Star tool object compared with a Polygon tool object 
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that has been clumsily edited. You can’t perform this goof with the Star tool; its interior angles are always 

mirrored and symmetrical. 

 

Using the Complex Star Tool 

Think of the kaleidoscope images you enjoyed as a child (or still do) when you choose the Complex Star 

tool–because with only an edit or two using the Shape tool, you can create mesmerizing symmetrical shapes, 

unlike with any other tool in CorelDRAW. 

To use the tool, you know the drill if you’ve read this far! You click-diagonal-drag to create a shape; by 

default, the complex star has 9 points of a value of 2 on a 1- to 3-point sharpness scale (available to define on 

the Property bar. 

 

CTRL, SHIFT, and CTRL+SHIFT perform the same modifiers as they do with other shapes. One unique 

characteristic of complex stars is that they have two control points: one for the inner, negative space, and one 

for the points. When you edit using the Shape tool, holding CTRL constrains your edits on the control points 

to symmetry, but if you want a spiral treatment of a complex star, don’t hold CTRL and drag any way you like 

on both the inner and outer control points. You’ll probably want to assign a fill to a complex star as your first 

edit because unfilled complex stars aren’t as visually interesting. The illustration here shows what you can 

create by moving the inner control point to outside the outer control point. Imagine the snowflake patterns 

you can build; and like snowflakes, no tow complex stars are alike. 

Next, you can see other examples of simply playing with the Shape tool on a complex star object. Also 

try assigning a wide white outline property to a complex star as a property to create still more variations. 
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Using the Spiral Tool 

With the Spiral tool (press A as the keyboard shortcut), you can create circular-shaped paths that would be 

tedious, if not impossible, to create manually. Spiral objects are composed of a single open path that curves in 

a clockwise or counterclockwise direction. They can also be designed to expand in even segment distances or 

in increasing distances as the spiral path segments travel away from its center (called a logarithmic function). You 

find the tool in the Toolbox, grouped with the Polygon and Basic Shapes tools. 

The Spiral tool options share space on the Property bar (shown next) with options for the Graph Paper tool 

and include Spiral Revolutions, Symmetrical, and Logarithmic Spiral modes, and a Spiral Expansion Factor 

slider. 

 

 

The objects you can create can have between 1 and 100 revolutions, each of which is equal to one complete 

rotation around its center point. The direction of the revolutions is set according to the click-diagonal-drag 

action you take when creating the initial shape, as shown here… 
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• Symmetrical vs. Logarithmic A symmetrical spiral object appears with its spiral revolutions evenly spaced 

from the center origin to the outer dimensions of the object. To increase or decrease the rate at which the 

curves in your spiral become smaller or larger as they reach the object’s center, you may want to use the 

Logarithmic method. The term logarithmic refers to the acceleration (or deceleration) of the spiral revolutions. 

To choose this option, click the Logarithmic Spiral button on the Property bar before drawing your shape. 

• Logarithmic Expansion option While the Logarithmic Spiral tool is selected, the Spiral Expansion slider 

is available–as well as a value field you can type into–and you can set this rate based on a percentage of the 

object’s dimensions. Logarithmic Expansion may be set from 1 to 100 percent. A Logarithmic Expansion 

setting of 1 results in a symmetrical spiral setting, whereas a setting of 100 causes dramatic expansion. If you 

need a shape that is reminiscent of a nautilus, increase the Logarithmic Expansion to 50 or so. 

Converting Shapes to Curves 

Any of the shapes discussed in this chapter can be converted to curves by using the Object | Convert To 

Curves command (CTRL+Q). Using this command removes any dynamic-editing properties. For example, an 

ellipse shape many be converted to a pie or arc (and vice versa); but after it is converted to curves, you’ll no 

longer have the option of turning the object into a pie wedge. The same applies to rectangles, polygons, and 

so on. With the exception of the Undo command, once an object is converted to curves, there is no way to 

return the object to its dynamically editable state. 

Using the Convert Outline To Object Command 

Many of the shapes covered in this chapter, the spiral in particular, are shapes that have outline properties but 

no fill. So what do you do, for example, if you want a gradient-filled spiral? The Object | Convert Outline To 

Object command converts any shape’s outline properties to a closed path. To apply the command to a 

selected object, choose Object | Convert Outline To Object, or use the shortcut: CTRL+SHIFT+Q. Once 

the outline is converted, the resulting closed path looks exactly like the shape of the original, except it can be 

filled because it’s not an outline, but instead a closed path object whose shape is based on an outline. 

When an outline is converted to an object, CorelDRAW performs a quick calculation of the Outline Pen 

width applied to the object and creates a new object based on this value. When applying this command to 

objects that include a fill of any type, a new compound-path object is created based on the outline width. If 

the object includes a fill of any type, the fill is created as a new and separate object applied with an outline 

width and color of None. When you’re converting open paths, only the path itself is created as a single 

outline object of the path according to the Outline Pen width applied. 
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CHAPTER 3 
All About the Objects 
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3.1  Arranging and Organizing Objects 

When you create or import an object, it’s might not be exactly where you want it on the page. Or the position 

might be fine, but the object’s a little too large. It might also be rotated by a few unwanted degrees, or it’s part 

of a group or on the wrong layer–you get the picture. This chapter covers the techniques to use in 

CorelDRAW to transform objects–both the manual approach and pinpoint precise numerical entry approach 

are covered. You’ll soon have the skills to compose elements on a page the way you want them, and then you 

can stop cursing at the cursor. 

Basic Object Selection 

The Pick tool–by default, the tool at the top of the Toolbox–can move, scale, or create other transformations 

when you click an object to select it and then drag to move the selection, for example. Use the SHIFT key as 

the modifier when you’re selecting things on a page; you add to your existing selection by SHIFT+clicking 

other objects. If you’ve selected an object unintentionally, SHIFT +click on the object (that’s already selected) 

to deselect it. 

With one or more items selected, you’ll notice that information about the selected shapes is displayed on the 

Status bar. The other workspace area to watch is the Property bar, which shows the position and size of the 

selection and offers options relevant to the tool being used, such as the number of degrees to rotate the 

selected object(s). Also, if you press ALT+ENTER when something is selected, the Object Properties docker 

provides you with not only details about the object, but also the opportunity to quickly change many of the 

object’s properties. 

 

Pick Tool Selections 

The Pick tool can be used for at least two things, the most important of which are to choose an object or 

several objects and to create a change in the selected object(s) by moving it and adjusting its selection handles. 

Clicking an object once selects it. While an object is selected, selection handles appear–the eight black markers 

surrounding the object. Additionally, depending on the type and properties of an object, you’ll see nodes at 

various areas around the object, which indicate the first node in an object path or subpath (of combined 

vector objects) when a vector object is selected or the edge of an object when a bitmap is selected. A 

small Xmarker appears at the centermost point of the object, indicating its center origin. This origin can be 

moved and is quite useful for defining a center of rotation for an object. 
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Picking and Freehand Picking 

The Freehand Pick tool is located in the Pick Tools group, and both new and experienced CorelDRAW users 

might want to give this selection tool a try; the Freehand Pick tool behaves exactly like the (regular) Pick tool 

after an object is selected, so you can move or perform other transformations without switching tools. 

The main difference between these tools is that with the Pick tool, you must click-drag to define a rectangle 

that the desired objects are completely within. The Freehand Pick tool is used more like a shape creation tool 

than a rectangle creation tool; you can click-drag around objects, selecting some and avoiding others, 

regardless of how closely the objects neighbor one another. The illustration here visually demonstrates the 

different properties of the Pick and Freehand Pick tools. 

 

Selection Techniques 

You can use mouse and keyboard combinations while navigating through a collection of objects and for 

selecting more than one object at a time using the Pick tool. Many of these object-selection techniques can 

also be used in combination with each other. Here’s how to select more than one object in one fell swoop: 

• SHIFT-clicking to select Holding the SHIFT key while clicking an unselected object adds it to your 

current selection. This also works in the reverse: holding SHIFT while clicking a selected objectdeselects the 

object. This technique works with both the Pick and Freehand Pick tools. 
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• Marquee-selecting objects To select all objects in a specific area, use the (regular) Pick tool and click-drag 

diagonally to surround the objects; a dashed blue outline representing the rectangular area being selected 

appears until you release the mouse button. When you do so, all object shapes completely within the area you 

define are selected. 

• Holding ALT while marquee-selecting If you come to CorelDRAW from Adobe Illustrator, you can use 

the convention of selecting objects by merely touching a shape in a marquee-selection technique. Holding the 

ALT key as the modifier while click-dragging to marquee-select a specific area selects all objects within–and 

even ones whose edge you touch. Holding SHIFT+ALT while marquee-selecting causes the reverse to occur, 

deselecting any objects that are already selected. There is also a option (Tools | Options | Workspace | 

Toolbox | Pick Tool and then click Treat All Objects As Filled) that saves you from holding ALT all the 

time. 

• Pressing TAB to select next object Suppose you have a bunch of objects in a document, but some of 

them overlap, and you’re getting nowhere by attempting to click the one you need. Pressing the TAB key 

alone while the Pick tool is active selects a shape and selects the next single object arranged directly behind 

your current selection (whether or not it overlaps the current object). Holding SHIFT while pressing 

the TAB key selects the single object arranged directly in front of your current selection. This tabbing action 

works because each new object created is automatically ordered in front of the last created object. Tabbing 

cycles through single object selections on a page, whether you have a current object selected or none at all. 

The key is to begin tabbing after you’ve chosen the Pick tool. 

ALT+ click to select objects covered by other objects To select an object that is ordered in back of and 

hidden by other objects, hold the ALT key while the Pick tool is selected and then click where the object is 

located. Each time youALT+ click with the Pick tool, objects that are ordered farther back in the stack are 

selected, enabling you to “dig” to select hidden objects. 

The Pick Tool’s Shape Tool State 

If you’re getting an idea that the Pick tool has a host of hidden features, you’re right. One of these is its 

alternate state—the temporary Shape tool state. The Pick tool can temporarily act like the Shape tool while a 

single object is selected and when held over object nodes, but this isn’t its normal behavior, and you need to 

first enable this feature in Options; choose Workspace | Display and then check Enable Node Tracking. 

The temporary Shape tool state lets you move object nodes without changing tools, conveniently giving you 

control to modify selected characters in a line of Artistic Text, to edit open and closed paths, and to modify 

an ellipse, star, polygon as star, graph paper object, and even a bitmap. When the Pick tool is outside of a 

shape it looks like an arrow cursor. After an object is selected and the tool is over an object node, however, 

the tool changes to the Shape tool and you can move nodes. 
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Selecting Objects by Type 

So far, you’ve learned to select any objects on or off your page. But you can also select objects by their type 

(such as text objects, guidelines, and path nodes), using commands from the Select All menu, shown in the 

following illustration. Shown here all text objects are selected, and CorelDRAW is being very clever; it didn’t 

select the “O” or the “a” because they are drawings and not text. You can extrude, add a perspective, and put 

any type of fill you like on text, and it’s still text. See how effortless sifting through a page of objects can be? 

Each time you use a command, a new selection is made (and any current selection of objects 

becomes not selected). 

 

• Select All Objects Choosing Edit | Select All | Objects selects all objects in your current document 

window. Quicker is the CTRL+A keyboard shortcut, which accomplishes the same thing and is easy to 

remember. 

• Select All Text Choosing Edit | Select All | Text instantly selects all text objects both on and off the 

current document page. Both Artistic and Paragraph Text objects are selected after using this command 

(unless they have been grouped with other objects, in which case they are ignored). Text objects that have 

effects (such as Contour or Extrude effects) also are selected using this command. 

• Select All Guidelines Guidelines are actually a class of document page objects, different from objects you 

draw, but objects nonetheless. To select all guidelines on your document page, choose Edit | Select All | 

Guidelines. Selected guidelines are indicated by a color change (red, by default). To select guidelines, they 

must be visible and cannot be locked; probably the fastest way to unlock or unhide a bunch of guidelines is to 

double-click one using the Pick tool to display the Guidelines docker. The Guidelines docker has options for 

locking/unlocking and hiding/revealing existing guides. If guidelines you’ve placed merely aren’t visible on 

your page, and you’re sure you laid some down in your last session, try choosing View | Guidelines. 

 

 

 

 

 

 

 



P a g e  | 53 

 

 

• Select All Nodes You can have the Shape tool or the Pick tool (which will magically change into the Shape 

tool) and an object selected (closed or open paths qualify) when using this Select command. Choose Edit | 

Select All | Nodes to select all the object’s path nodes. For a quicker method in the same situation, use 

the CTRL+A shortcut when either the Pick tool (which changes to the Shape tool) or the Shape tool is your 

current tool. Special CorelDRAW objects, such as rectangles, ellipses, and polygons, can’t be selected this way 

because their shapes are defined dynamically by “control points” instead of nodes. 

 

Using the Pick Tool 

Holding the Pick tool over certain areas of a selected object activates the tool’s positioning cursor, as shown 

in the illustration. This means a click-drag action on the area will move your selected object(s) in any 

direction. As you drag your object, you’ll see a preview outline, indicating its new position. When you release 

the mouse button, the move is complete. 
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Using Nudge Keys 

As an alternative to using the Pick tool, you can also move selected objects by a distance you specify by 

nudging using your keyboard arrow keys. To nudge a selected object, press the UP, DOWN, 

LEFT, or RIGHT arrow key. Your object will be moved by the nudge value specified on the Rulers page of 

the Options dialog. You can customize the Nudge distance by opening the Options dialog (CTRL+J), 

clicking to expand the tree directory under Workspace and Document, and clicking to display the Rulers 

options page. 

 

 

Using nudge keys, you can perform moves according to the Nudge value or by larger or smaller values. These 

are referred to as Super and Micro nudges. Like “normal” nudges, these values are set on the Rulers options 

page. Here are the techniques for using Super and Micro nudges: 

• Super nudge This action moves a selected object in larger increments than a normal nudge. To use Super 

nudge, hold SHIFT while pressing the UP, DOWN, LEFT, or RIGHT arrow key on your keyboard. By 

default, this moves your selected object by twice the default value for a “normal” nudge distance, although as 

you can see in the preceding illustration, you can change that 2 to a larger value in the Super Nudge num box. 

• Micro nudge The pint-sized version of a typical nudge is the Micro nudge, which moves your object in 

smaller increments. To use Micro nudge, hold CTRL while pressing the UP, DOWN, LEFT, 

or RIGHT arrow key on your keyboard. By default, Micro nudges move the selected object by one-half the 

default nudge distance, but again, this value’s in the Micro Nudge num box and you can make it even smaller. 

Transforming Objects 

A transformation is any type of object shape or position change, short of actually editing the object’s properties. 

This includes changing an object’s position, size, skew, and/or rotating or reflecting it. Dragging an object 

directly in a document is more intuitive than precision transformations–but both approaches have their own 

special advantages. In this section, you’ll learn how to apply transformations using both techniques. 

Transforming Objects Using the Cursor 

For the intuitive method, the Pick tool is what you need to transform objects by the simple act of click and 

dragging. Depending on the type of transformation you need to apply, you can click-drag any of the four, 

black, square selection handles that surround the selected object or group of objects to change an object’s 
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size proportionally–by width only and by height only. Dragging any middle selection handle or side handle 

scales the object disproportionately–“smush” and “stretch” are the more common terms for disproportionate 

scaling. 

 

During transformations, CorelDRAW keeps track of the object’s transformed size, position, width, height, 

scale, and rotation angle. CorelDRAW remembers your object’s original shape from the time it was created, 

regardless of how many transformations have been applied to it. You can remove all transformations and 

restore the object to its original state in a single step: choose Object | Transformations | Clear 

Transformations to return your object to its original shape immediately. 

While transforming objects, you can constrain certain shape properties by holding modifier keys. Here are the 

effects of holding modifier keys for constraining a transformed object’s shape: 

• To change object size (scale) Click-drag any corner handle to change an object’s size proportionally, 

meaning the relative width and height remains in proportion to the original object’s shape. Hold ALT while 

dragging any corner selection handle to change an object’s shape disproportionally, meaning width and height 

change, regardless of original proportions. 

• To change width or height only Click-drag any side, top, or bottom selection handle to change the size of 

the object in the drag direction. Hold SHIFT while doing this to change the width or height from the center 

of the object, or hold CTRL while dragging to change the width or height in 200-percent increments. 

You can also rotate or skew an object using Pick tool states that become available after you click a selected 

object a second time–you click an object that is already selected once to display rotation and skew controls 

around the object. This action causes an object (or group of objects) to look like the illustration of 

the 45 here, an ancient analog sound device best known to listeners who know who Little Anthony and the 

Imperials were. 
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You control the point around which objects are rotated or skewed, by moving the center origin marker or 

anchor point of an object or group of objects. Your cursor will change to display either the rotation or skew 

cursor when held over a corner or side handle. A good creative example of offsetting the original center of an 

object is covered in the following tutorial, where you’ll make a circular pattern from a group of objects. 

Using the Free Transform Tool 

The Free Transform tool is the middle ground between controlling transformations entirely with mouse 

gestures and the hands-off controls of the Transformations docker. When you use the Free Transform tool, 

the Property bar offers four transformation modes: Free Rotation, Free Angle Reflection, Free Scale, and 

Free Skew, as shown here, performing the Free Angle Reflection, to mirror the drawing’s original location 

and left-to-right orientation. 

 

To transform a selected object in one of these four modes, click to select the mode, and then use a click-drag 

action on your object. A live preview of the new object’s shape appears. While using Rotation or Angle 

Reflection modes, a reference line appears as you drag to indicate the object’s angle transformation from its 

original state. 

Using the Free Transform tool and then applying a little transparency can yield compositions that contain 

believable reflections. The Free Transform tool works with bitmaps as well as native CorelDRAW vector 

objects. 
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Applying Precise Transformations 

The Transformations docker is terrific for applying multiple transformations with a single command. The 

docker has five Transformation buttons: Position (Move), Rotation, Scale And Mirror, Size, and Skew, as 

shown in this fantastic illustration. To open the Transformations docker, choose Window | Dockers or 

choose Objects | Transformations, and then click any submenu command and the entire docker appears 

docked to the right edge of the drawing window.  

 

For all transformations, the procedure is the same: click the button for the type of transformation, enter the 

values you need, and then click the Apply button in the docker to transform the selected object(s). In this 

section, you’ll learn what each area does for you and the options offered for each. 

Positioning (Moving) Objects 

Options for the Position page will move your object selection a specified distance, either horizontally (x) 

or vertically (y), to a specific point on your document page. 

 

While the Relative Position option is selected, entering new values and clicking the Apply button moves your 

objects by a specified distance. If the Relative Position option is not selected, you’ll be moving your object to a 

specific location, for example, if you type 11 in the x (horizontal) field and then click Apply, your object 

moves to the 11” mark on the horizontal ruler. 

If you specify a value greater than zero in the Copies field, and use the Relative Position option, you create a 

duplicate object every increment of the x value you’ve typed in. 
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Rotating Objects 

On the Rotation page, you can enter exact angles of rotation based on degrees and in default increments of 5 

using the spin boxes. Here, you see two very different results when using relative and absolute positioning 

and two copies of the tea kettle. 

 

Entering negative values rotates an object clockwise, whereas positive values cause counterclockwise rotation. 

Selecting the Relative Center option lets the object be rotated around its center marker position. By default, 

the marker is at position x=0 and y=0–at the object’s geometric center. Entering new values has the same 

effect as moving the center marker position with the Pick tool, but with the advantage of mathematical 

precision. When Relative Center is not selected, the x and y values represent fixed page coordinates for the 

center of rotation. 

Precision Skewing 

The term skew means to change the position of two sides of a shape in a parallel fashion while leaving the 

other two sides alone; slanting is a more common synonym for “skew.” The Skew transformation also gives 

you the chance to apply both vertical and horizontal skew independently or simultaneously by entering degree 

measures, in turn, transforming the object either x or y. As with rotation commands, negative degree values 

produce clockwise skews, whereas positive values cause counterclockwise skews. Choosing the Use Anchor 

Point option lets you specify left, center, right, top, bottom, sides, or corner points as the point around which 

your objects are skewed by choosing the Use Anchor Point option. 
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Controlling the Order of Things  

Object order is another of the basics you need to know to organize shapes. Setting the order of 
objects lets you set whether an object appears in front of, or behind another object.  When 
overlapping objects are ordered, they appear in front of or behind each other, according to their 
order. As you create each new object, it is put in front of all existing objects on the current document 
layer. Changing the object order lets you rearrange overlapping objects without changing their 
position on the page. To do this, CorelDRAW has a series of order commands that let you shuffle 
the order of objects in various ways. You’ll find them in the Object | Order submenu, but you can 
also apply them using shortcut keys or the To Back Of Layer and To Front Of Layer buttons, 
available toward the far right on the Property bar, when an object is selected. 

 

 
 

Here’s how each of the object order commands works: 

 

• To Front This command shuffles your selected object(s) to the very front of the current layer. 
Press SHIFT+PAGE UP or choose Object | Order | To Front to apply it. The To Front command 
is also available as a Property bar button when an object is selected. 

 

• To Back This command shuffles your selected object(s) to the very back of the current layer. 
Press SHIFT+PAGE DOWN or choose Object | Order | To Back to apply it. The To Back 
command is also available as a Property bar button while an object is selected. 

 

• Forward One This command shuffles your selected object(s) forward by one in the object order of 
the current layer. Press CTRL+PAGE UP or choose Object | Order | Forward One to apply it. 

 

• Back One This command shuffles your selected object(s) backward by one in the object order of 
the current layer. PressCTRL+PAGE DOWN or choose Object | Order | Back One to apply it. 

 

• In Front Of This command is interactive and puts your selected object directly in front of any 
object you specify in the current layer order. A targeting cursor will appear, and you use it to choose 
which object to shuffle your selection in front of. Choose Object | Order | In Front Of to apply it. 

 

• Behind This command also causes a targeting cursor to appear, enabling you to specify which 
object you want your object selection to be shuffled behind in the object order on the current layer. 
Choose Object | Order | Behind to apply it. 
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• Reverse Order This command effectively shuffles the order of your selected object so that it’s in 
the reverse of its current order on the layer. Front objects become back objects and vice versa. For 
example, if your objects were numbered 1, 2, 3, and 4 from front to back, applying this command 
would reorder them to 4, 3, 2, and 1. Choose Object | Order | Reverse Order to apply it. 

 

Working with Views of a Document’s Depth: Layers 

 

CorelDRAW’s layer feature provides invaluable ways not only to organize but also to view complex 
drawings. You can create several layers and move shapes among layers. You can also name layers, 
control their order and appearance, change object ordering within layers, group objects, and quickly 
see object information.  

 

Exploring the Object Manager 

 

The Object Manager docker is your resource for viewing layer content and using layer options. With 
the Object Manager, you can perform a whole range of actions: navigate document pages, create and 
name layers, select and move objects among layers, and set layers as editable, printable, and visible. 
To open the Object Manager docker, choose Windows | Docker | Object Manager.  

 

The Object Manager shows a listing of the layers, each accompanied by options and a flyout menu. 
A Master Page also appears and includes default layers for controlling guides, the desktop, and grid 
objects. If more than one page is in a document, you can specify whether you want odd, even, or all 
pages in the file to have Master Pages. 
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Navigating Pages, Objects, and Layers 

 

The best way to use the Object Manager docker to navigate through your document, select layers, 
and control layer options is by experimenting yourself; the following steps are a guide. You’ll learn 
exactly how these operations are performed; look at the next illustration, which shows a default layer 
structure for a new document. 

 

 
Using Object Manager Editing and View States 

 

Objects can be on different layers, and you can edit across layers in CorelDRAW. Create a new file 
that has objects on, let’s say, three layers to better learn through example about the editing and view 
states of CorelDRAW layers. Open the Object Manager docker. You’ll see three view state buttons 
at the top of the docker–that’s where information about viewing and editing behavior are set. 
Clicking each button toggles its state on or off. Each button has the following effects: 

 

• Show Object Properties Click the Show Object Properties button to set whether you want to view 
a detailed name for a layer’s contents (color, type of object, and so on), or just the name, either the 
default or your own custom name. 

 

• Edit Across Layers Click the Edit Across Layers button to set whether objects can be selected, 
moved, and copied between layers. While cross-layer editing is disabled, objects appear grayed out, 
allowing only objects on your current page layer and/or the desktop to be selected or edited. While 
cross-layer editing is enabled, you can select, move, or edit any object on an unlocked layer. 

 

• Layer Manager View The Layer Manager View button toggles your view to show only your 
document’s layers. When working with complex drawings that have many pages, layers, and objects, 
using this view can make managing layer properties a lot easier. In this state, all page and object 
information is omitted. 
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Controlling Layer Properties 

 

Using the Layer Properties dialog, you can control specific properties for each layer. To access these 
options, right-click a specific layer in the Object Manager docker and choose Properties from the 
pop-up menu. You can access properties directly from the pop-up menu or display a modeless 
dialog for defining the properties of a specific layer. There is a minor difference between using the 
dialog and the pop-up: the pop-up (right-click) menu has the Delete, Cut, Copy, and Paste 
commands. However, in X7, you can now rename layers in the Layer Properties dialog in addition to 
the Object Manager.  Options in this dialog control the following layer properties: 

 

• Visible This option enables you to toggle the view state of a layer between visible or hidden. You 
can also control the visibility of objects on a layer by clicking the Eye symbol to the left of the layer 
name. 

 

• Printable This option toggles the printing state of objects on the layer on or off. You can also set 
whether layer objects are printable by clicking the Printer symbol beside the layer in the Object 
Manager docker to toggle the printing state of objects on the layer. 

 

• Editable Use this option to lock or unlock all objects on a layer. While a layer is locked, its objects 
can’t be edited (or even selected), which is a little different than the Lock (object) command. You 
can also set whether layer objects are editable by clicking the Pencil symbol beside the layer in the 
Object Manager docker to toggle the editing state of objects on the layer. 

 

• Master Layer(s) You can have layers for odd, even, and all pages in the Master Page entry on the 
Object Manager docker. You can create a new Master Layer, and you can also drag an existing layer 
from a page to the Master Page entry. Changing a layer to a Master Layer makes it part of the Master 
Page structure. Any objects on a Master Page appear on all pages. For details on working with 
Master Pages and Master Layers, see the next section. 

 

• Layer Color This selector sets the color swatch as it appears in the docker listing directly to the left 
of a layer name, for easy recognition. Layer Color also determines object colors when viewed using 
Normal or Enhanced views while the Override Full Color View option is selected. You set the color 
coding for a layer by double-clicking the color indicator next to a layer name to open a typical color 
selector menu and then clicking any color from the drop-down color picker. 

 

Working with Master Page Layers 

Whenever a new document is created, a Master Page is automatically created. The Master Page isn’t a physical 

page in your document, but instead a place where document objects can be placed so they appear on every 

page of your document. Objects on a Master Page layer are visible and printable on every page in your 

document, making this an extremely powerful feature. For example, placing a text header or footer or a 

company logo on a Master Page layer is a quick and easy way to label all the pages in a pamphlet or brochure. 

Moving any object onto a layer on the Master Page makes it a Master Page object and causes it to appear on 

each page. 
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3.2 Align and Distributing Objects 

Alignment  

CorelDRAW offers precision when using its Align and Distribute commands that enable you to 

align or evenly space object shapes in various and relative ways. You can access the menu 

commands by choosing Arrange | Align and Distribute and make a selection from the submenu. 

 

 

Align Command Options 

The Align and Distribute tab of this box enables you to align a selection of objects precisely, based 

on their outline shape.  

To have your selected objects align in a specific way, simply select an option and press Apply. Click 

the Close button to confirm and close the dialog.  

Align and Distribute options are organized into three areas: Vertical, Horizontal, and Page options. 

Vertical Alignment 

Choose Left, Center, or Right to align your objects. 
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Horizontal Alignment 

When aligning objects horizontally, you have the option of using Top, Center, or Bottom. Only one of these 

three options can be selected at any one time 

 

Edge of Page Alignment 

Choosing Edge of Page option alone won’t change your selected object’s alignment. It must combined with 

one of the vertical options (Top, Center, Bottom), or one of the Horizontal options (Left, Center, Right). On 

the other hand, you can use one option from both the Vertical and Horizontal options. 

 

Center of Page Alignment 

This option centers your objects to the center of the page according to each objects center point. 
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Align To Grid Option 

When using this option, objects align to the nearest grid. Select the Align to Grid option and either one 

selection from the Vertical options (Top, Center, Bottom) or Horizontal Options (Left, Center, Right), or an 

option from both the Vertical and Horizontal options. 

 

What Aligns to What, and When? 

Align – Based on Order Objects are Created  When marquee-selecting objects, the first object that was 

drawn or created will be the object to which all other objects are aligned. 

Align – Based on the Order of Selection  If you use the selection process with the Pick Tool, the last 

object selected will the object which all others will align. 

Using Distribute Command Options 

The CorelDRAW Distribute command allows you to control the precise spacing of selected objects. You can 

add automated spacing between objects based on their width and height or their center origins. 

Objects can be evenly spaced based on one of two position reference points. With the Extent of Selection 

option is selected, your objects are evenly spaced between the two objects farthest from each other. Objects 

are distributed vertically and/or horizontally according to their Top, Center, Left, Right, or Bottom edge, or 

by adding equal spacing between their width or height.  

The Extent of Page option causes objects to be evenly spaced within document page borders. Choose a 

Vertical and/or Horizontal spacing option together with Extent of Page to apply even spacing between the 

selected reference point on your objects. 

Here’s an actual sample that was created using CorelDRAW’s Align and Distribute command.  
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3.3 Selecting the Correct Path Tools 

CorelDRAW’s path building and editing tools are at your disposal, so you can create exactly what you 

envision. The Curve Tools group on the Toolbox has tools that make any shape you can imagine 

(and some you can’t) a snap to design. 

Sidling Up to CorelDRAW X7’s Curve Tools 

The most basic shape you can draw in CorelDRAW (and any vector drawing program) is a line: a line is a path 

that passes through at least two points, called nodes in CorelDRAW. A line is actually a mathematical equation, 

and as such, it doesn’t necessarily have an outline color or width, and it doesn’t even have to be a straight line. 

However, a line does have adirection–the direction in which you draw the line. This might seem obvious, but 

vectors do have a direction, and you can end up with arrowheads on the wrong end of a line and all sorts of 

unwanted stuff if you fail to remember the basic properties of a vector graphic. 

You can assign a line scores of different properties: arrowheads, a dashed outline around clip-out coupons, 

solid colors, and varying widths. Joining the beginning and ending points of a line (a path) closes the path. If 

the beginning doesn’t meet the endpoint, the shape is called an open path. 

CorelDRAW X7’s Curve tools are task-oriented; although they all produce paths, your choice of tool(s) for a 

task depends on what you want to draw. For example, do you need an object whose curves are flawless–like 

those of a physical French curve? This task calls for the B-Spline tool. You can also “mix and match”; you 

can begin an object with one tool and finish it with a different tool–your choices depend on the object you 

want to create. Some of these tools work similarly so it’s best to become acquainted with what the different 

cursors look like. 
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How to Fill an Open Path 

When you draw a path and the beginning and ending points don’t meet, you have an open path, and ordinarily 

you cannot apply a fill to its interior. But you can indeed fill an open path—just like in Adobe Illustrator—

when you know how to turn on this option. 

To change DRAW’s behavior so all open paths are filled—so you don’t need to close the path first—follow 

these steps: 

1. Open the Options dialog; just click the button on the Standard bar. 

2. Expand Document, and click General to display the associated options on the right side of the dialog. 

3. Click the Fill Open Curves option to select it, and click OK to close the dialog. 

After choosing this option, the open paths you draw can have an interior area. 

How to Draw in CorelDRAW 

. In the Curve Tools group, you’ll find CorelDRAW’s path and node creation pens; you can use them for 

both accuracy and artistic expression, and they each have varying degrees of ease of use that correspond 

directly to their power. 

Drawing with the Freehand and Polyline Tools 

The Freehand and Polyline tools share a common function, giving you the freedom to draw as if you were 

sketching by freehand on a physical sketch pad, but the tools work in slightly different ways. Sketched lines 

can create a single open or closed vector path. Both tools are located in the Toolbox grouped with other line-

creation tools. 

For mouse users and stylus users alike, click-dragging initially produces a Start node for a path segment and 

then, when you release the mouse (or stylus) button, a node is placed, setting the end of the path segment. To 

use these tools: 

1. Begin by selecting the Freehand tool. 

2. You can create a continuous line by click-dragging a path shape. As soon as the mouse button is released, 

the line is complete. 
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3. To extend this path–to add a path segment after the first segment’s End node–you position your cursor over 

either the Start or End node (the cursor now features a tiny bent arrow), and to continue with a freeform 

path, just start click-dragging again. 

4. Now, let’s say you want to extend this path with a straight line segment or two. Instead of click-dragging 

on the End node of the previous segment, you click and then release the mouse button; the cursor turns into 

a little line segment icon; and at whatever point you want to end this segment, you single-click. 

5. If you want to keep going with straight line segments, don’t just click an End node and move your 

cursor; double-clickan End node and you are now creating a new line segment that is joined to the previous line 

segment by a node. 

6. To create a path that only has straight lines, you single-click, and then move the cursor and double-click 

each time you want the line segment to end and a new one to begin. Along with what the cursors look like 

and do depending on the position of the cursor over the page or the path. Do not freak out at the apparent 

complexity of this figure! It’s a map to the treasure of mastering the Freehand tool. 

The Polyline tool, on the other hand, can be used similarly to the Freehand tool, except only a single click 

adds a node and you can continue to add path segments. You’ll notice that when you click-drag with the 

Polyline tool, your curves appear smoother, and this, like the Freehand tool, might serve digitizing tablet users 

the most.  

 

The Polyline tool has an extended function that lets you draw straight lines, mixed with perfectly circular arcs if 

you single-click the end of a straight line segment, hold ALT, release the mouse buttons and move the cursor 

position (this is called hovering), and then single-click. The next illustration shows that with a minimum of 

patience and a good idea in your head, you can easily create French-curve-like abstract objects. If you want 

your work to be an open path, double-click when you’re done with the pen. 
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Using either of these tools, you can control the smoothness of path shapes drawn using click-drag actions by 

adjusting the Freehand Smoothing option on the Property bar before drawing your path. You can control 

smoothness after drawing a path by selecting nodes with the Shape tool and then using the Reduce Nodes 

slider. Reduce Nodes has a range between 0 and 100 percent; lower values apply less smoothing, and higher 

values apply more smoothing. 

 

Drawing Arcs with the 3-Point Curve Tool 

The 3-Point Curve tool was created for artists to build perfectly smooth arcing line segments, with complete 

control over the direction and steepness of the curve between two points. First, you hold-drag the tool to set 

a straight line that defines the angle of the curve. This sets the start and end points for the curve. Then you 

release the mouse button and hover the cursor to define the slope and degree of the curve; you’re provided 

with an onscreen preview until you decide and click a point and thus create the curve. 
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The terms angle, slope, and other common words don’t adequately describe the characteristics of a curve to 

anyone other than a geometry professor. This might help: these are two additional, slightly nerdy, yet highly 

accurate terms describing the characteristics of a curve: 

• Bias When you draw an imaginary straight line through the endpoints of any curve, bias describes which of 

the two endpoints the curve leans toward. 

• Tension Similarly, when a straight line runs through the two points that define a curve, tension describes 

how closely or how far the curve’s farthest point is from the line. 

 

 

 

Drawing with the 2-Point Line Tool 

This is the most self-explanatory tool in the Pen Tools group: you click-drag at any point on the page, and 

when you release the mouse button, the line is completed. Although this might seem like a “toy tool” 

compared to the others, it’s actually quite useful for creating callouts in technical manuals, and it was used 

extensively in this book. Create a 2-point line, add an arrowhead, end of task. 
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Using the Bézier and Pen Tools 

The Bézier tool and the Pen tool are variations on the same theme of drawing connected curves and straight 

segments through the action of first clicking to set a path point, and then either dragging to define a curve 

behind the click point orclicking (no dragging) to define a straight path segment behind the click point. You’ll 

find these tools grouped together with other line-drawing tools. 

One of the less obvious differences between the two tools is that the Pen tool offers a “look ahead” point 

when you draw with it: before you click or click-drag a point, the proposed path between the point before 

you click and the previous (already defined) point on the path is shown in light blue. Although control 

handles are displayed when a curve is defined with the Pen tool. 

The Pen tool doesn’t afford you as much control steering the shape of the curve as the Bézier pen tool. The 

Bézier tool always requires a click-drag mouse gesture to produce curves, whereas the Pen tool lets you hover 

your cursor before clicking to set the preceding curve in an object’s path segments. When you’re just 

beginning with CorelDRAW, the Pen tool provides a preview of the next segment you’ll create, and after you 

gain some experience, you might want to skip the previews, pick up some drawing speed, and use the Bézier 

tool. 

 

Getting a Handle on Béziers 

Both the Bézier tool and the Pen tool can create curves between two nodes whose connection to a 

neighboring node is smooth and symmetrical. You’ll see control handles on smooth, symmetrical nodes when 

you click one using the Shape tool. These handles are used for intuitively reshaping the curve. 

You can also create straight path segments between curves using the Bézier tool. Click-dragging creates smooth 

curves that have smooth connections between segments, whereas clicking without dragging sets a path point 

that is not smooth–if you click again in a different location, you’ll get a straight path segment.  

 

 

Because straight line segments and curve segments share so much fundamental anatomy, there is almost no 

distinction between the terms line and curve in the discussions in this chapter. The shapes of Bézier lines are 
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controlled, in part, by node properties and the position of curve handles. Two paths can have nodes in the 

same relative page position, but have completely different shapes. 

 

 

Nodes and Control Points 

When a vector path describes an arc, nodes (points) connect a start and ending point, and the nodes 

have control handles, at the end of which are control points (also referred to as nodes), the screen element you use 

to manipulate curves. The number of control handles and points depends on the segment connected by each 

node. For example, an arc (a curve) connected to a straight line segment has one control handle visible and it 

controls the slope of the curve segment. When two curve segments are connected, you’ll see two control 

handles if you click the connecting node with the Shape tool; this node can have different connection 

properties (cusp or smooth—described later in this chapter). A straight path segment can be described as two 

nodes connecting the segment, and the control handles for the nodes coincide in position with the node 

itself. For all intents and purposes, the control handles can’t be seen; they become visible when the segment is 

changed to a curved segment: the control handles appear on the segment, and you can move them away from 

the launch point of the curve and then freely manipulate the slope of the curve by dragging the control 

points. 

Nodes can be defined as cusp, smooth, or symmetrical by using the Shape tool in combination with the 

options on the Property bar, as shown in the next illustration. Cusp nodes can be used to create a 

discontinuity in direction between two line segments; in English, the two segments connect in a nonsmooth 

fashion. Think of the moon being on the cusp; it’s crescent shaped, and this is the sort of shape you can 

create using cusp node connections. Smooth nodes cause the path slope and direction to align on either side of 

a node; their relationship is in 180-degree opposition, which has the effect of creating a smooth transition at 

the node point itself. Control handles surrounding a smooth node may be unequal distances from the 

node. Symmetrical nodes are not only smooth, but the control handles are an equal distance from the node. 

You’ll immediately appreciate the effect of a symmetrical node; when you drag one control point away from a 

node, the opposing control handle moves an equal distance from the node in exactly the opposite direction. 

The artistic effect is that the two joined path segments take on an almost circular appearance, which is very 

useful for technical illustration work. 
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Drawing Conventions for the Bézier and Pen Tools 

Both of these tools are used to create compound paths (segments connected by a common node) by combining 

a series of clicks or click-drags, but each is used in slightly different ways for different results. Using either of 

these tools, single-clicks define new node positions joined by straight segments. Curve segments are created 

by clicking to define the node position and then dragging to define the curve shape. Click-dragging in 

succession creates a continuous curved path shaped by multiple nodes and off-the-curve control handles. 

While using the Bézier tool, each click-drag defines and completes the curve segment. However, while using 

the Pen tool, the cursor remains active, and a preview of the next curve segment appears, so you can define 

both the curve shape and the next node point. Double-clicking ends the series of path segments. 

Editing Bézier Paths 

All lines are controlled by properties of the nodes they include, which are edited using the Shape tool (F10). 

You’ll find this tool, shown here, grouped with the Smooth, Smear, Twirl, Attract, Repel, Smudge, and 

Roughen tools. 

 

 

 



P a g e  | 74 

 

 

Using the Shape tool, you can change node positions and curve shapes by click-dragging the nodes and their 

control points, or by directly click-dragging on a path segment. While using the Shape tool, icons appear on 

the Property bar when one or more nodes are selected; you can select several nodes to change by marquee-

dragging them or SHIFT-clicking a few. These icons are used to set node attributes to cusp, smooth, and 

symmetrical, to join nodes and break nodes to create individual path segments, and to create straight lines 

from curves (and vice versa) when you’ve selected a segment or a node connecting segments. The bevy of 

functions on the Property bar provides exceptional control and flexibility in your design work. In short, you 

should get to know the functions for the Shape tool. 

 

• Shape Tool Selection Mode You can marquee-select nodes the way users always have, by click-dragging a 

rectangular shape around the nodes you want to select, or Freehand style, which produces a lasso-like 

marquee you can use to be careful and exacting about which nodes in a group you want to edit. Using 

Freehand style, you might also want to use SHIFT to add to selected nodes. 

• Add/Delete Selected Nodes These buttons give you the power to add new nodes to a curve or delete 

selected nodes after you’ve drawn a path, using the Shape tool and clicking at specific points on a path. To 

add a node, click any point on a line to highlight the new position and then click the Add Node button. You 

can also add a new node to a line by clicking one or more nodes and then clicking the Add Node button to 

add a node midpoint between the selected node and the next node on the path. To delete a node, click to 

select it with the Shape tool and click the Delete Node button. You can also marquee-select (drag diagonally 

with the Shape tool to create a rectangle surrounding the nodes) and then delete all the selected nodes in one 

fell swoop. Pressing the minus (–) key on your numeric keypad or your DELETE key also deletes selected 

nodes. 

• Join Two Nodes/Break Curve When two unconnected nodes on an open path are selected, for example, 

when the start point is close to the endpoint, pressing the Join Nodes button connects them to create an 

unbroken path. On single paths, only the unjoined Start and End nodes may be joined. On compound 

paths (paths that aren’t necessarily close to one another, but have been joined using the Object | Combine 

command–CTRL+L is a shortcut worth memorizing), the Start and End nodes selected on two existing–but 

separate–paths can also be joined. While a single node is selected or while a specific point on a segment is 

clicked, pressing the Break Curve button gives you two unjoined nodes, breaking a closed path into an open 

path. 

• Line To Curve/Curve To Line These two buttons are used to toggle the state of a selected straight line to 

a curve state, and vice versa. A single click with the Shape tool selects a line or curve indicated by a black 
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marker on the line. When curves are converted to lines, the path they follow takes on a shortcut: “the shortest 

distance between two points.” When converting a straight line to a curve, the path remains the same shape, 

but control handles appear directly on the “line,” and the quickest way to make the control points visible is to 

drag on the line to force it into a curve shape. 

• Extend Curve To Close For this command to be available, you must have both the Start and End nodes 

of an open path selected (marquee-select the points, or SHIFT+click to select them both). Under these 

conditions, clicking the Extend Curve To Close button joins the two nodes by adding a straight line between 

them, closing the path. 

• Auto-Close Curve While selecting an open path, clicking this button joins the Start and End nodes to form 

a closed path by adding a new straight line between the two nodes. Although similar to Extend Curve To 

Close, depending on the closeness of the Start and End path nodes, you might not even see a visible straight 

line connection. You can also join the endpoints of a selected curve using the Close Curve option on the 

Object Properties docker’s Curve tab. Press ALT+ENTERto open object properties. The Start and End 

nodes don’t even have to be selected to use the Object Properties’ method. 

• Reverse Curve Direction While selecting a curved path on a line, clicking this button changes the direction 

of the path. By doing this, the start point of the path becomes the endpoint (and vice versa). The results of 

using this command button are most noticeable when the start or end of the line or path has been applied 

with an arrowhead, meaning the arrowhead is applied to the opposite end of the line or path. You may also 

notice subtle changes in the appearance of line styles applied to a path after using this option. 

• Extract Subpath This option becomes available only when a compound path is selected. After clicking the 

Extract Subpath button, the selected path is separated from the compound path, converting it to a separate 

path. Using this command on a compound path composed of only two different paths is essentially the same 

as using the Break Apart command. It’s more useful when you need to extract a specific path from a 

compound path made up of three or more paths. 

• Stretch Or Scale Nodes This powerful CorelDRAW feature is not available in competing applications. 

When at least two nodes on a path are selected, clicking Stretch Or Scale Nodes allows the transformation 

between nodes using their relative distance from each other vertically, horizontally, or from center. Eight 

selection handles become available, just like selecting an object using the Pick tool, and you can use a click-

drag action from any corner or side selection handle toward or away from the center of the node selection. 

Holding SHIFT constrains the stretch or scale operation from the center of the selection. For example, if you 

draw a cartoon portrait of a man in profile, you could select the nose nodes, and enlarge the fellow’s nose 

without significantly affecting any other curve segment in the drawing. 

• Rotate Or Skew Nodes Similar to Stretch Or Scale Nodes, when at least two nodes on a path are selected, 

clicking the Rotate Or Skew Nodes button lets you rotate and skew the selected nodes; this is a great feature 

for refining a shape just a little and also for creating more dramatic appearance changes (see the following 

illustration). Eight selection handles become available, enabling you to use a click-drag action from any corner 

selection handle to rotate the nodes in a circular direction either clockwise or counterclockwise. Dragging 

from any side handle enables you to skew the node selection either vertically or horizontally. 
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• Align Nodes When two or more nodes are selected, clicking this button opens the Align Nodes dialog, 

from where you can choose the Align Vertical or Align Horizontal options that automatically align your node 

selection accordingly. In addition to these options, while only the Start and End nodes of an open path are 

selected, you can also choose to align control points. This has the effect of moving the two endpoints of the 

line to overlap each other precisely. This command is wonderful for quickly sketching a zig-zag (perhaps for 

an illustration of a saw blade), and then in one step, aligning the nodes to create a precise illustration. 

• Reflect Nodes Horizontally/Vertically These two buttons become available when two or more nodes are 

selected. You use these options to move nodes using nudge keys (the up, down, left, and right keys on your 

keyboard) or click-drag actions in opposite directions. 

• Elastic Mode With this command, you move selected nodes according to their relative distance from each 

other; the effect is like experimenting with a rubber band. For example, while a collection of nodes is 

selected, dragging one of the nodes causes the others to be dragged a shorter distance in relation to the node 

that is being dragged. While Elastic Mode is off, all the selected nodes are moved equal distances. Try this 

option to add a more organic feeling to a drawing you feel looks a little too studied and stiff; it adds 

expression to a path. 

• Reduce Nodes When you use this command, CorelDRAW evaluates the overall shape based on the nodes 

you’ve selected, deletes nodes that deviate from a predictable course along the path, and then repositions the 

remaining nodes–the effect is to smooth the curve. To use this feature, select the nodes controlling the 

segments you want to smooth and drag the Reduce Nodes slider control position toward 100. As you drag 

the slider, the shape of the curves is smoothed and you’ll notice superfluous nodes disappear from the curve. 

This option is helpful for smoothing lines drawn using the Freehand tool with either the mouse or a digitizing 

tablet stylus. 

• Select All Nodes This button selects all the nodes in a path (or compound path) using one click. It’s a great 

feature for users who aren’t expert with the marquee-select dragging technique yet. You may also select all the 

nodes in a path with the Shape tool by holding CTRL+SHIFT and clicking any node on the path. 

Controlling Freehand and Bézier Tool Behavior 

The options to control how the Freehand and Bézier tools create the curves and lines you draw are set in the 

Freehand/Bézier Tool pane of the Options dialog, shown next. To access these options, click the Options 

button on the Standard bar. Then expand the tree subdirectory under Toolbox, and click Freehand/Bézier 

Tool. The quick way to get to this box, however, is to double-click the Freehand or Bézier tool buttons after 

choosing them from the Curve Tools group. 
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• Freehand Smoothing The Freehand Smoothing option lets you to set the default value of the Freehand 

Smoothing option on the Property bar while drawing with the Freehand tool. Smoothing may be set based on 

a percent within a range between 0 (minimum smoothing) and 100 (maximum smoothing). This option is 

largely redundant with the Freehand Smoothing option available on the Property bar when a curve and the 

Shape tool are selected. 

• Corner Threshold This option is for setting the default value for corner nodes when drawing with the 

Freehand or Bézier tool. Lower values make nodes more likely to be set to cusp nodes, and higher values 

make them more likely to be smooth nodes. The range may be set between 1 and 10; the default is 5. 

• Straight Line Threshold This option pertains to how the shapes of lines or curves are created when 

drawing with the Freehand tool. Lower values make nodes more likely to be set to straight lines, whereas 

higher values make them more frequently curved. The range may be set between 1 and 10; the default is 5. 

• Auto-Join This option sets the behavior of the Freehand or Bézier tool while drawing closed-path objects. 

This value represents the distance in pixels your cursor must be when clicking near the first node of a newly 

created path to close the path automatically. Auto-Join can be set anywhere within a range between 1 and 10 

pixels; the default is 5 and is probably the best overall choice for the large screen resolutions we all have 

today. 

Working with Compound Paths 

Compound paths have at least two separate paths (either open or closed) composing a single shape. To examine 

an example of a compound path, use these steps: 

1. Choose the Text tool (F8), click once to define a text insertion point, and then type an 

uppercase Q character. You can assign the character any typeface you like; the more ornamental the character, 

the more obvious the compound path will be. This character shape, shown in the illustration, has combined 

two paths: one represents the “positive” space and one represents the “negative” space shape. 
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2. While the text object is selected, convert it to curves (CTRL+Q). The Status bar now indicates the object is 

a Curve on Layer 1. 

3. Change your view to Wireframe; choose View | Wireframe. 

4. Press CTRL+K (Object | Break Curve Apart). With the Pick tool, click one of the shapes and drag to 

move it; clearly the two paths are now separate. You have just converted a compound path featuring two 

subpaths into two individual objects. 

 

Combining Objects 

When separate objects are combined, they behave as a single object. When two or more closed paths are 

combined, they form positive and negative spaces within the object. Applying a fill to this type of object fills 

the positive shapes, but the negative shapes remain clear, as shown here. The Combine command does this: 

choose Object | Combine, or use theCTRL+L shortcut. You can also click the Combine button on the 

Property bar, or choose Combine from the pop-up menu. 
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Breaking Paths Apart 

You can separate the individual paths in a compound path using the Break Curve Apart command 

(CTRL+K). This command is available when a compound path composed of at least two subpaths is 

selected. (Using the Extract Subpath command button on the Property bar also does this, but only for 

the selected path.) 

Converting Objects to Curves 

Converting special types of objects to curves–such shapes auto-created with the Rectangle and Ellipse tools–

frees them to be manipulated with the Shape tool as if they were ordinary paths. Choose Object | Convert 

To Curves; press CTRL+Q; click the Convert To Curves button on the Property bar; or right-click the object 

and choose Convert To Curves from the pop-up menu. 

Converting an object to curves removes any special editing properties; text loses its editability as text and 

rounded rectangles can no longer be edited to refine the curvature of the rounded corners. Converting to 

curves applies to polygon, ellipse, and Artistic Text objects, and certain effects objects such as envelopes and 

perspective effects. 

 

3.4 Special Shapes and Connectors 

CorelDRAW’s Smart Drawing Tool 

Even if you use a graphics tablet and stylus, you’re still drawing freehand, and using a mouse introduces still 

more flubs when it comes to freehand drawing. Fortunately, the Smart Drawing tool takes the guesswork out 

of drawing polygonal and rounded objects–in a nutshell, you click-drag an approximation of what you intend, 

tune the options for the Smart Drawing tool based on your first drawing, and in a jiffy you have a precise 

object with the proportions you need. Pictured next on the Toolbox, the Smart Drawing tool instantly 

translates rough drawings into shapes you’d usually consider drawing with the Rectangle tool or Ellipse tool–

or with other tools that require more effort and skill. 

When the Smart Drawing tool is selected, the Property bar displays Shape Recognition Level and Smart 

Smoothing Level options (shown next) for setting the sensitivity CorelDRAW uses to translate your roughs 

into precise shapes. 

 

 



P a g e  | 80 

 

 

You control how precisely your sketch shape is translated into a precise shape by setting these options: 

• Shape Recognition Level This option determines how precisely your sketched shape is matched to a 

recognizable shape. You can set it to one of five levels, ranging from Lowest (sketched shapes are not easily 

recognized) to Highest (sketched shapes are easily recognized), with Medium being the default; None turns 

off the feature. 

• Smart Smoothing Level After you’ve completed a sketch by releasing the mouse button, a level of node 

smoothing is applied to make object recognition more, or less, precise. This option gives you total control 

over the smoothing action, much in the same fashion as using the Reduce Nodes spin box on the Property 

bar when a path is selected with the Shape tool. Choose from five options ranging from Lowest (less 

smoothing applied) to Highest (more smoothing applied), with Medium as the default; None turns off the 

feature. 

Editing Glyph Nodes 

Glyph nodes are edited in similarly to the control points on a polygon. As they are moved, the glyph nodes 

often have the effect of resizing, changing proportion, or dynamically moving a certain part of an individual 

symbol. Complex symbols can include up to three color-coded glyph nodes. 

To explore glyph node editing, take a moment to try this: 

1. Choose the Banner Shapes tool from the Shapes group on the Toolbox. 

2. On the Property bar’s Perfect Shapes flyout button, click it to expand the list and then choose the second 

preset shape. 

3. Using a click-diagonal drag action, create a new shape on your page. Notice the shape includes two glyph 

nodes–one yellow, one red. 

4. Click-drag the yellow glyph node up or down to reposition it several times. Notice its movement is 

horizontally constrained; as it is moved, the vertical width of each portion of the banner changes. 

5. Click-drag the red glyph node left or right to reposition it several times. Notice its movement is vertically 

constrained; as it is moved, the horizontal width of each portion of the banner changes to match your 

movement 
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Glyph nodes can be edited using both the Perfect Shape tool you used to create the shape and the Shape tool 

(F10). You can also edit glyph nodes by using the Object Properties docker for a selected Perfect Shape. This 

docker offers precise control over glyph node position; just right-click your shape and choose Object 

Properties from the pop-up menu or press ALT+ENTER. Depending on the Perfect Shape you’ve selected, 

the Object Properties docker might display one, two, or more controls. 

 

The Connector Tools 

The Connector Tools group is almost so self-explanatory, it’s not necessary to cover how they work here. 

Connector lines come in one straight segment, a right-angle, and a rounded right angle, and there’s also an 

Edit Anchor tool, shown in the illustration here, to modify the exact location of the connector line relative to 

the object (or group of objects) to which the line is anchored. 

 

There are more uses in everyday work for Connector tools than you might imagine. Everything from 

mapping genealogy, to org charts, to seating arrangements at receptions–these all need text in boxes and 

some sort of connecting line to establish relationships. The marvelous thing about DRAW’s Connector tools 

is that once you’ve connected two objects, regardless of where you move an object, the connector line 

preserves the connection. This makes arranging and laying out complex hierarchical maps and charts a snap.  

 

As with dimension lines, set connector line properties–arrowheads, line widths, colors, and others–after 

you’ve created the connector line. 
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3.5 Editing Objects  

Because every object you draw on a page can be broken down into rectangles, ovals, path segments, and so 

on, this chapter covers the tools and features for doing exactly this: breaking down shapes, combining them, 

subtracting a little of this, and adding a little of that. Often, arriving at the design of your dreams can be 

realized by creating an approximation of the shapes you seek. Then, with a pull and a tug here and there, 

you’ll get your desired results faster than by creating the drawing from scratch. 

Shaping and Reshaping Objects 

You have a choice of two places to begin when you want to edit an object: you can use Property bar 

commands, or you can use the hands-on approach. Both approaches will serve you well, and your choice 

largely depends on what you need to edit, and then what type of operation is required. 

CorelDRAW has great shaping commands to speed the object-creation process, such as Trim, Weld, 

Intersection, and Boundary. You’ll also find three other shape commands at your disposal: Simplify, Front 

Minus Back, and Back Minus Front. 

You’ll learn exactly how to use these commands to shape and reshape your objects. Before getting into the 

specifics, though, let’s take a look at where you can find these commands in X7. 

Shaping Commands and the Property Bar 

X7’s Property bar includes shaping command buttons that let you shape selected objects instantly. These 

Property bar options are available only when at least two objects are selected–and the shaping commands are 

available whether or not the objects are positioned to overlap. The Property bar shaping buttons are shown 

here. 

 

Source and Target Objects 

When using Property bar shaping buttons, shapes are subtracted, added, and so on, but the original objects 

go away. To keep your original objects, use the Shaping docker, which offers options to specify that the source 

object (the one performing the operation—the “scissors”) and/or the target object (the object receiving the 

operation—the “paper”) should remain after shaping. 

When using the Shaping docker and the Weld and Intersect operations, you have an additional helper: the 

Intersect With or the Weld To button at the bottom. When only one object is selected, naturally it’s hard for 

CorelDRAW to perform these operations. The idea behind this option is that if you have several objects 

nestled closely together (making a target object hard to select), you click the Weld or the Intersect button, 

your cursor changes to a unique shape, and you then click the desired target object to complete the 

operation,  



P a g e  | 83 

 

 

 

• Weld The Weld command creates a new shape based on the outline shape of two (or more) overlapping 

objects, as shown at right. You can specify via the Shaping docker whether the original shapes remain on the 

page. 

 

• Trim The Trim command removes any area of the backmost object that overlaps the frontmost object, as 

shown here–the rectangle used in this operation is not deleted and has been moved to make the result more 

obvious. No color change takes place; the back object does not inherit the front object’s color, transparency, 

or any other trait. 
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• Intersect The Intersect operation creates a new object based on the overlapping areas of two or more 

objects. The original objects remain on the page, and the result is not obvious because the new object 

is in the same position as the overlapping parts of the original objects. In the following illustration, 

the square was on the bottom, and the resulting object takes on the color of the bottom object. 

Intersect is a great operation for creating difficult crops of complex objects. 

 

• Simplify The Simplify command removes all hidden areas of objects that “underlap” foreground 

object. This command is great for simplifying an intricate drawing, and it can also make a design that 

otherwise might not print to PostScript print just fine. A different order and arrangement of objects 

will give you slightly different results. 

• Front Minus Back When two or more shapes are selected, applying the Front Minus Back 

command removes the hidden area of the object in back from the shape in front. When more than 

two shapes are selected, it removes all portions where the shapes in back are overlapped by the 

object in front, leaving only the object in front remaining, as shown in the center of the next 

illustration. 

• Back Minus Front This shaping command works in reverse of Front Minus Back. While at least 

two shapes are selected, applying the Back Minus Front command removes the portions of the 

shape layered in front from the shape in back. When more than two shapes are selected, it removes 

all portions where the shapes in front overlap the shape in back, leaving only the shape in 

back remaining. The following shows the results of Front Minus Back and Back Minus Front, when 

applied to two objects, in the same front-to-back order. 
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• Create Boundary This operation is similar to Weld, except it leaves the target objects on the page. 

Also, if there are empty spaces between objects, Create Boundary ignores them when making the 

combined single object. Here is an example of several selected objects and, below them, the resulting 

shape. By default, the new object has no fill and is ordered on top of the target objects. Just click a 

foreground color on the color strip, and the new object will become immediately apparent. 

 

Embellishing Corners and Object Node Editing 

Subtracting and adding objects is only the beginning of your adventures in making a shape that’s approximately 

what you had in mind to exactly what you envision. The following sections introduce you to a trio of effects 

on the Fillet/Scallop/Chamfer docker, and a tool that can change the corners or the line segments that connect 

object corners.  

Fillet/Scallop/Chamfer 

Display the Fillet/Scallop/Chamfer docker by choosing it from Window | Dockers. With this docker, 

you can truncate the sharp corners of an object you draw. 

• Fillet Rounds the corners of an object. 

• Scallop Trims a semicircle from the corner of an object. 

• Chamfer Lops a straight angle off a corner at an angle perpendicular to the interior angle of the 

corner. 

When Fillet/Scallop/Chamfer evaluates sharp direction changes along a path, it “rounds off” the 

point of a convex area toward the inside of the path and adds to concave areas. This feature is terrific 

for quickly building elegant objects such as furniture pieces and machine parts and simply nice 

ornaments for a desktop publishing document. Enter a positive value in the Radius field (or use the 

elevator buttons on the docker), and you’ll see a faint outline preview in your document. Click Apply 

when you’re happy with the preview. Fillet/Scallop/Chamfer is a destructive operation, unlike the 

Shaping operations, so if you want to keep your original object, duplicate it before using this docker. 

The following shows the effects of the Fillet/Scallop/Chamfer docker on the same zig-zag object 

created with a single-click and the Pen tool. Because the Radius of this trimming effect is measured in 

page units, it’s usually a good idea to keep rulers visible in your document, and to refer to them to 

achieve the exact degree of corner truncation you need. 
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Using the Eraser Tool 

The Eraser tool, shown next, completely removes areas of selected objects you click-drag over—just like a real 

art eraser, but without the stubble landing in your lap. The Eraser comes in two different shapes, and you can 

define the size by using the Property bar. You’ll find it in the Toolbox grouped with the Knife, Virtual Segment 

Delete, and Crop Tools. 

 

Working with Eraser Operations 

With this tool, you can remove portions of shapes in four ways: 

• Double-clicking When you double-click a selected shape, you remove an area that is the shape of the cursor. 

Therefore, if you double-click a lot with the circular cursor, you can quickly design a slice of Swiss cheese. 

• Single-click two points If you single-click, move your cursor, and then click a second time, the Eraser tool 

erases a straight line through the selected object. 

• Click-drag This is the most common method of erasing, and the results are totally predictable and usually 

look like hand-painted strokes. If you click-drag, you erase the area you’ve dragged over on a selected object. 

 • Click, hover over a different area, and then press TAB This technique creates several connected straight-

line segments, and after you get the hang of it, it will feel like you’re painting with an eraser. You’ll quickly 

produce phenomenally expressive and complex drawings. 
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CHAPTER 4 
Experiment with Text and Fonts 
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CorelDRAW’s Text Tool 
All text you want to enter on a page in CorelDRAW is created with the Text tool, the tool with an A as its 

icon in CorelDRAW’s Toolbox. To begin, click its button in the Toolbox or press F8. If there’s already text 

on the page, double-clicking the text with the Pick tool switches the current tool to the Text tool and gives 

you an insertion point for adding text. The Text tool cursor is a small crosshair with an A below and to the 

right, which becomes an I-beam (a text-editing cursor) when it’s over a text object. You click anywhere on the 

page or the pasteboard to create an insertion point and then start typing. 

When you use the Text tool, you can produce two different types of text objects in a document: Artistic Text 

and Paragraph Text. Below you see a layout that uses Artistic Text in combination with the Text | Fit Text 

To Path command—the path is hidden in this illustration. The smaller body copy text uses Paragraph Text; 

the top paragraph wraps around the top of the image using a CorelDRAW Envelope. Artistic Text and 

Paragraph Text have different properties, but both are added to a document using the same Text tool. Artistic 

Text, because of the way it’s produced in a document, is easy to reshape and distort—you’ll find it simple to 

do artistic things with it, such as creating a company logo. Conversely, Paragraph Text is optimized for longer 

amounts of text, and it’s a great text attribute for quickly modifying columns of, for example, instructions, 

recipes, short stories, and so on. In short, Paragraph Text is best used for several paragraphs of text in a 

composition whereas Artistic Text should be reserved for headlines and just a few lines of text you might 

want to curve along a path, extrude, or do something else unique and fancy with. 

 

 

Formatting options can be accessed from the Text Property Bar (shown below) or from the menu Text -

>Character Formatting, or Text ->Character Formatting 
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4.1 Artistic Text  

Artistic Text is best for illustration headlines, callouts, and other occasions when you want to create text with 

a special effect such as extrusion, an envelope, text on a path, and so on. To add a line of Artistic Text to a 

document, with the Text tool, click an insertion point and then type your phrase; alternatively, after clicking an 

insertion point you can press CTRL+V to paste any text you have loaded on Windows’ Clipboard. To create 

several lines of Artistic Text, press ENTER when you want to skip to a new line and then continue typing. By 

default, all Artistic Text is set in Arial, 24 point. 

Artistic Text is also easy to convert to curves so you can modify a character in a word: for example, Microsoft’s 

logo has a tick missing in the second “o”. To duplicate this effect (but not Microsoft’s logo), you begin with 

Artistic Text for the company name, press CTRL+Q (Object | Convert To Curves), and then edit away using 

the Shape tool. Artistic Text can be fine-tuned using the features on the Property bar when the text is selected 

using either the Pick tool or the Text tool.  

 

Mirroring (Horizontal and Vertical) In addition to creating special effects, the Mirroring buttons are also 

useful when, for example, you want to print a T-shirt transfer with your company name. The name needs to 

be reversed (mirrored horizontally) to print on the transfer paper, so the unreversed print on the T-shirt reads 

correctly (or at least without the need for a mirror). 

• Type of font (file) To the left of the font name in the Font Name drop-down list is an icon signifying what 

file format the chosen font uses: OpenType, Type 1, or TrueType. This option is nice when you’re sorting 

your fonts in Bitstream Font Navigator or the Fonts utility in Control Panel. 

• Font Name, Font Family The font name is the name of the typeface. By default, you’re using Arial 24 

point. Youchange fonts in a new document by selecting the text you’ve typed with the Pick tool and then 

choosing a different font from the Font Name drop-down list. If a font has family members, you’ll see a 

right-facing triangle to the right of the font name when the drop-down list is extended; choose it by hovering 

above the triangle to reveal the flyout and then click the family member you want to use. You can also 

perform a speed-search by clicking the current name in the Font Name drop-down and then typing the first 

few letters of the font you want. The drop-down list immediately scrolls to the right neighborhood of 

installed fonts, making your selection a fast and effortless one. Note also that on the Font Name drop-down 

list, at the top, above the divider bar, are the fonts you’ve chosen recently for previous documents and even 

from previous CorelDRAW sessions. 

• Point Size Text has traditionally been measured in points; with current digital typeface technology, the 

measure is 72 points to the inch. Artistic Text used as a printed headline can be anywhere from 18 points for 

a flyer headline to 72 points for a newspaper headline to 300 points and up for headlines that fairly scream at 

the reader. 
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• Bold and Italic These buttons on the Property bar are shortcuts to formatting a whole line of text or only 

selected characters as bold and italic members of the typeface shown in the Font Name box. If a specific font 

has no family members, CorelDRAW doesn’t “fake” a bold or italic look, and the buttons are dimmed. If you 

need an italic treatment of a font that has no italic family member, a quick fix is to use the Transformation 

docker, and then set Skew to about –12 degrees to apply to the Artistic text. 

• Underline An underline is an effect available for every font you have installed—you click the button when 

text is selected and CorelDRAW renders an underline. You can modify the style of the underline by 

highlighting the underlined text and choosing Object Properties. Then, in the Character area of the Object 

Properties docker, you click the Underline flyout and choose the type of style you prefer. 

• Text Properties This button appears on the Property bar when you select the Text tool. Clicking 

this button displays the Text Properties docker. The Text Properties docker is very similar to the top 

area of the Object Properties docker. Essentially, anything you need to do to customize one or more 

characters in a text string, you can do using the features on the Text Properties docker. You can access 

the features of the Text Properties docker by clicking the button when text is selected with the Text 

tool and Pick tool or by pressing CTRL+T when the Shape tool is the active tool. 

• Interactive OpenType Explained shortly, Interactive OpenType shows alternative characters in 

highlighted OpenType text you’ve typed. OpenType fonts sometimes contain scores of custom 

characters that are very hard for average users to access and add to text. The Interactive OpenType 

button shows and hides alternatives, allowing a one-click addition of special characters when a specific 

OpenType font contains them. -  

• Bulleted List With text selected (with the Pick tool) or highlighted (using the Text tool), clicking 

the Bulleted List button creates a bulleted list from your text, using a standard bullet symbol, a hanging 

indent for the text, and a new bullet wherever you’ve inserted a hard return in Paragraph Text. This 

button is inactive when using Artistic Text. 

• Drop Cap By default, when Paragraph Text is highlighted and this button pushed, a three-line-tall 

drop cap is auto-created. Options to adjust the drop cap’s height, spacing, and whether a hanging 

indent is used or not is found on the Text menu. This feature is covered in Chapter 11. 

• Quick Customize Although technically not a part of the Text Properties features, if you want to 

add or remove a button on the Property bar when the Text tool is active, clicking this button will do 

the job. 

• Edit Text This button displays a text editing box, which also appears when you click the Text tool 

on text that has an effect applied such as an envelope or an extrude. CorelDRAW is designed with 

text-editing flexibility in mind, so to transform text using just about any feature—and to allow the text 

to still be editable—you work in a proxy box so you don’t have to start over when you make a 

typographic error.  You can use the text cursor to select one character at a time, by words, or by whole 

paragraphs. You can also the UP, DOWN, LEFT and RIGHT arrow keys on your keyboard to 

select strings of sequential text, a word, a line, or a paragraph at a time. 

If some text is already selected, the selection can be extended by clicking at the new endpoint of the 

selection while holding down the SHIFT key. 

* Double-clicking with the cursor selects the word in which you double-clicked. 

https://www.safaribooksonline.com/library/view/coreldraw-x7-the/9780071833141/ch11.html#ch11


P a g e  | 91 

 

 

*Triple-clicking with the cursor selects the entire paragraph in which you triple-clicked. 

*Hold down the CTRL when you single-click to select a single sentence. 

Options for Formatting Characters 

The Text Properties docker takes the place of other UI features in previous versions, and includes more 

comprehensive options to change selected characters. If you’re new to CorelDRAW, you can change Artistic 

Text characters in three different ways: 

• Use the Shape tool in combination with the Property bar. This method gives you control over character 

positioning, rotation, and other properties as covered in the next section. 

• Use the Text tool or the Shape tool in combination with the Character section of the Object Properties 

docker. Using this method gives you more options and thus more control than the Property bar. Using Object 

Properties with characters is covered later in this chapter. 

• Use the Text tool, the Shape tool, or the Pick tool (which works but you cannot select individual characters) 

in combination with the Text Properties docker. The same comprehensive options are on the Text Properties 

docker and in the Character area of Object Properties, but for experienced users this feature might be easier to 

remember by its historic shortcut, CTRL+T. 

4.2 Paragraph Text  

Paragraph Text is similar to text objects used in desktop publish applications. Paragraph text can be 

used for larger bodies of text that have greater formatting requirements. It is most often used when 

creating columns for names on a plaque, or wrapping text around an object. When adding paragraph 

text, you must first create a text frame. 

 

To create a Paragraph Text object, choose the Text tool from the Toolbox, and then click-drag diagonally to 

create a rectangle into which you’ll enter the text. The click-hold+diagonal-drag technique (commonly called 

a marquee-drag) is the way to create a paragraph block. A paragraph block is just a container. It can be filled with 

text you type, or you can fill it immediately with loaded text. The sample text inside the Paragraph frame is 

simply a placeholder; it disappears after you’ve added your own text. Paragraph Text frames have resizing 

handles as well as kerning and leading handles (Artistic Text features these as well), discussed later in this 

chapter. You can fill a Paragraph Text frame with text in one of three ways: 

• Type in the frame. You’ll probably want to run spell-check (Text | Writing Tools | Spell Check or press CTRL-

F12) when you’re finished typing. 
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• Paste from the Clipboard. You’ll see a dialog before you can paste if you press CTRL+V, or choose Edit | Paste 

(and Edit | Paste Special). Here, you can choose to keep or discard the formatting of the text on the Clipboard. 

• Import a text file. Depending on the text file type, you might be prompted to install a compatibility pack, 

especially for older MS-Word documents. With a broadband connection, the process takes about three minutes; 

you don’t have to quit CorelDRAW; and you can paste after the compatibility program is installed. By contrast, 

a plain TXT file with no font or paragraph attributes will import perfectly after you choose an import style 

from the Importing/Pasting Text dialog. 

The frame you drag for imported Paragraph Text might not accommodate the amount of text. As a result, 

the overflowtext is hidden; in this case, the frame is a dashed red outline instead of black. To reveal the text, you 

drag down on the “windowshade handle”—the small square tab, bottom-center, on the text frame; when there’s 

hidden text, the handle has a down arrow at its center. 

You always have the option to link Paragraph Text frames. Instead of spoiling a design by increasing the size 

of a frame, you can create a second, third, or any number of additional frames, and then flow the excess text 

into the new frames as you create the frames. You can move the linked frames around in your design, and 

the content (the meaning of the typed text within Paragraph Text) remains in perfect order.  

Fitting Text to Curve 

Wrapping text around an object has its alter ego: putting text inside a shape, so it looks as though the 

text itself forms a shape. And there’s a third variation called Fit Text To Curve—you can have Artistic 

Text follow an arc, a freeform line, and an open or closed shape, and you have options for the style 

in which the text follows your line. 

Pouring Text into a Shape 

The simplest way to form text so it appears to have a geometry other than rectangular is to first create 

a shape, copy some text to the Clipboard if you don’t have a message in mind, and then carefully 

position your Text tool just inside the line of the shape (perhaps 1/8th of a screen inch inside) until 

the cursor turns into an I-beam with a tiny text box at its lower right. Then click to start typing, or 

click and then press CTRL+V to paste your Clipboard text.  

In this next illustration, you can see sample Paragraph Text at left; it’s been copied to the Clipboard, 

and then the Text tool has been placed close to the white ellipse; it makes no difference whether the 

container object is selected. When the cursor changes to the one shown in this illustration, start typing, 

or in this case, press CTRL+V, and then format your text, and probably assign the container outline 

no color and no width to complete the illusion. 
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One popular treatment for text “bound” to an object is the arc of text. You apply this treatment by 

first creating the arc shape (a circle usually works well) and then, instead of clicking inside the shape, 

you hover above the shape until your Text tool cursor becomes an I-beam with a tiny swooping curve 

beneath it. 

CorelDRAW’s Font Playground 

Corel Corp. has added a utility to CorelDRAW X7 that’s both useful and fun. The Font Playground 

is an onscreen panel that looks like any other CorelDRAW docker, but aside from copying and pasting 

text, its purpose is not to enhance drawings or modify text, but to preview and compare a phrase or word 

when set in different font styles. 

Type some Artistic Text, something like FLASH SALE 8 HOURS ONLY! Then Choose Text | 

Font Playground. The illustration shown here is a composite of the Font Playground docker, showing 

multiple views of it to clue you into your options visually. 
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From left to right, your display options for the font type and the preview you’ve entered (covered in 

a moment) are as follows: 

• Single-line Display Clicking this button displays a phrase once, in as many font styles as you like. 

• Multiline Display Clicking this button displays an entire phrase you might choose as the display 

sample, again, in any number of chosen font styles. 

• Waterfall This button option shows you only the text sample you’ve clicked on in the preview 

window, at various increasing point sizes. This option is useful for predetermining whether your 

chosen font is legible at, say, very small point sizes. 

Additionally, you have a Type Size slider toward the top left of the docker. But perhaps the neatest 

part of Font Playground is the option to copy a phrase into the Playground so you can compare it in 

several styles and then copy the chosen phrase and typeface to the drawing page. 

To put a phrase into the Font Playground preview window, select the text on the drawing page with 

the Pick tool, pressCTRL+C to copy your text selection, and then click an entry in the preview 

window and press CTRL+V. Remember this shortcut because the docker doesn’t have a Paste 

command or button. 

To put your dream font and phrase on the page, all you do is click+drag the desired version of your 

text from the text entry list on the docker into your CorelDRAW document. 
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CHAPTER 5 
Using Advanced Tools and Special Effects 
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5.1 Filling Objects 

A shape without a fill on your drawing page is like a brand-new coloring book. To make a coloring 

book—and your CorelDRAW artwork—more complete, you need to fill your shapes with colors 

and textures. CorelDRAW has more than a half-dozen types of fills you can apply to your shapes, 

and these types have hundreds of variations. In computer graphics, you have over 16 million solid 

shades of color at your disposal; imagine what you can do with blends, patterns, and textures of colors! 

The worst part of filling CorelDRAW objects will be deciding on a style of fill. 

Each type of CorelDRAW fill has its own special characteristics: 

• Uniform fills apply flat, solid color. 

• Fountain fills make a color transition from one color to another, in different directions—sometimes also 

called agradient fill. You can also create a fountain fill composed of more than two different colors. 

CorelDRAW ships with many preset fills, and this chapter demonstrates how to pick and apply them. 

• PostScript fills are good for repeating patterns. Although PostScript is a printing technology, you don’t need to 

print a CorelDRAW document to see a PostScript fill, and you can indeed export a PostScript-filled object to 

bitmap format and the fill looks fine. PostScript fills support transparency and are ideal for exporting to EPS 

file format to use in desktop publishing programs. And, naturally, a PostScript fill is valid for printing to a 

PostScript printer. 

• Pattern and texture fills can fill shapes with bitmaps, including photographs, and a large supply of preset 

bitmaps is included with CorelDRAW. 

• Mesh fills take multicolored fills and present you with the option of “smearing” colors within the fill, much 

like finger-painting. 

Every fill type is applied in a slightly different way through the use of onscreen tools, docker windows, or the 

Interactive Fill and Mesh Fill tool  

 

From Uniform to Non-Uniform Object Filling 

The quick way to apply any of the fill types is to use the Fill tool, shown here. You’ll find it at the bottom of 

the Toolbox; to select it quickly, press G. You’ll see a hint here that the Fill tool is also a selection tool—the 

cursor is an arrow cursor with a paint bucket. You don’t have to have already selected the object that you 

want to fill when you use this tool. You can click an unselected, solid-filled object with the Fill tool to select 

it, and then a click-drag on the object, by default, applies the Linear-style fountain fill, making a transition 

from the current solid color to white. You can then change the colors used, or choose a different fill type 



P a g e  | 97 

 

 

from the Property bar—and here’s where version X7 has been reworked to make applying different types of 

fills easier than ever. 

 

Suppose you just filled an object with the default Linear-style fountain fill. If you’ve used a previous 

version of CorelDRAW, you’re going to be pleasantly surprised to see more than one control node 

on the fill: a mini–color and transparency picker pops up when you click over a color node. And all 

the fill types you can imagine are on the Property bar. Additionally, you can change some controls 

for the fountain fill parameters, so this streamlined, fortified Fill tool will get you where you need to 

go in a jiffy.  The illustration shows you what you’ll see on your page when you click-drag with the 

Fill tool to create a linear gradient. The element names and what they do are described in a moment. 

 

5.2 Cropping Tool 

The Cropping Tool works with both vector and bitmap graphics. You could achieve the same with 

the Trim Option in the Shaping Tool, but it’s far more time consuming. The standard from most 

programs is the Cropping Tool, which CorelDRAW X3 now has. You 'crop' the area you want to 

save and everything else on the drawing page disappears. 
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To define the protected area to which you want to crop the selected objects, click and drag. 

You can use the Crop tool on both bitmap and vector objects. 

 

To crop the selected objects to the protected area, double-click the protected area. Results after 

double-clicking within the 'cropped area'. 
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5.3 Contouring 

Contour effects instantly create perfect outlines of shapes or paths by the dozens or even hundreds. 

The result is similar to viewing a topographical or contour map, hence the name. 

During a contour effect, dynamically linked shapes are concentrically created outside or inside an 

object’s path. CorelDRAW effectively calculates the shape of each contour step and applies 

progressive outline and fill colors based on the original object’s properties and selected contour 

options. 

While a contour effect is linked to an object, the object itself becomes a control object, and the new 

shapes created become the contour group. Changes made to the properties of the original immediately 

affect the linked group. While the contourgroup is selected, its properties can be edited at any 

time—without your having to begin the effect from scratch. 

Using the Contour Tool and Property Bar 

To apply contour effects, you’ll need to use the Contour tool, shown here, in combination with the Property 

bar. You’ll find the tool in the Toolbox, with other interactive tools: Blend, Drop Shadow, Envelope, Distort, 

Extrude, and Transparency. 

While you’re using the Contour tool, the Property bar displays options for customizing the effect. These 

options include contour presets, contour direction, steps and offset spacing, color rotation, outline and fill 

color, and buttons for copying and clearing the effect. 

 

Below are the actual steps in CorelDRAW for creating the Contour effects: 
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Editing Contours Interactively 

The easiest way to edit a contour effect is by hand, using the Contour tool to change the interactive markers 

in combination with adjusting Property bar options. Use the options to adjust the direction, spacing, and 

offset values of the effect. 

The black diamond-shaped marker indicates which object is the effect’s control object. The white rectangle 

marker indicates the End object in the contour group, and its position sets the distance between the control 

object and the End object in the effect. A slider between these two enables you to adjust the spacing between 

the contour steps interactively, which, in turn, sets the number of steps by dividing the difference.  

 

You’ll also notice the Contour tool cursor changes its appearance as you drag outside, inside, or to the 

centermost point of your selected object. While held over an object, the cursor will also indicate whether you 

can apply the contour effect to the object. 

 

5.4 Shape Editing Tools 

Corel has added tools to the Shape Edit group on the Toolbox: Smear, Twirl, Attract, and Repel are 

incredibly dramatic and powerful tools that will make you feel as though you’re dragging your finger through 

wet paint. 
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Using the Smooth Tool 

New to version X7 is a tool that can undo accidental bumps and curves you’ve inadvertently created along a 

path. You can get better results with the Smooth tool than you can selecting nodes with the Shape tool and 

then using the Reduce Nodes slider, because you might want some areas to remain rough, while smoothing 

other areas. With the Smooth tool, you have complete control over which areas are smoothed. 

Three controls on the Property bar govern how the Smooth tool works: 

• Nib Size Determines the size of your cursor. 

• Rate Determines how quickly the tool responds. At a fast rate (a high value), scrubbing over a path 

produces immediate results; the curve is smoother and usually there are fewer nodes. At low rates, you can be 

more selective and leisurely about smoothing your object. 

• Pen Pressure Works only if you are using a tablet or a digitizing stylus. You set how much pressure is 

applied with the tool, and what result you get when you press harder or lighter. You might want pressure set 

to determine the rate of the Smooth tool. 

 

The Smear Tool 

The Smear tool behaves like the Smudge tool’s big brother (covered later), offering more plasticity to areas 

you drag over, more control, and with a little practice, a gallery of freeform shapes that look like anything but 

vector graphics. On the Property bar, you have the following options: 

• Nib Size Nib size determines the tool’s diameter. 

• Pressure Artists who use a mouse can use the num entry box or the flyout slider to set the tool’s intensity. 

• Smooth and Pointy Smear buttons Use one or the other type of smear to affect the end of a stroke. 

Smooth is good for natural, freeform distortion, whereas Pointy—an aesthetically severe effect—might be 

useful for embellishing machined parts and metal band logos. 

• Pen Pressure Digitizing tablet users should click the Pen Pressure button to use physical pressure to add 

character to strokes. 



P a g e  | 102 

 

 

 

Using the Smudge Brush 

The Smudge brush is sort of a paint tool in a drawing program: you can dramatically alter shapes in a natural, 

painterly fashion, with results that would take hours using any other method. You move areas of a vector 

object by dragging from a starting point inside the object and dragging outward, or starting outside and 

dragging inside the object. The result is a little like the Eraser tool if you move object areas inward, and if you 

drag from the inside out, the result might remind you of dripping paint. 

Applying Smudge to Shapes 

Using the Smudge brush, you can alter the outline shapes of open or closed paths by click-dragging across the 

outline path, in either an outward direction (to add to the object) or an inward direction (to create a recess in 

the object). As you drag, the path is altered according to your drag action and the Smudge Brush cursor’s 

shape settings. The following illustration shows a creative example of using the Smudge brush: the rectangle 

is almost a puzzle piece now, the editing took less than five seconds, and the resulting path can be refined 

using the Shape tool or other CorelDRAW features. 
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5.5 Creating the Illusion of a 3D Image  

For centuries, traditional artists have studied and sweated, and sometimes failed, to create artwork that 

conveys a sense of dimension. Perspectives, vanishing points, and angle of view can easily elude all but the 

most diligent, talented people because the sense of a third-dimension on a 2D canvas is, after all, an illusion. 

Fortunately, you don’t have to go to school for years and you don’t have to break a sweat when you want a 

little photorealism and dimension the next time you sit down to draw because you have CorelDRAW.  you’ll 

learn how to lift your graphical ideas right off the page with version X7’s perspective effect and 

CorelDRAW’s legendary Extrude tool. 

Getting a Perspective on Perspective 

Isometric views of objects are quickly accomplished in CorelDRAW by putting an object into Rotate/Skew 

mode (clicking once and then a second time), and then skewing the object by click-dragging a middle control 

handle. Isometric views are completely the province of computer graphics and geometry. They don’t exist in 

the real world with human eyes, but they are useful in illustration to put equal emphasis on all visible sides of 

an object. For example, if you want your client to read the side panel of a proposed cereal box design but 

want the box posed to show more than one side, you’d use an isometric view (occasionally called isometric 

perspective). At right, you can see the same kid’s block using a wide-angle perspective. In CorelDRAW, such an 

illustration is accomplished by putting the vanishing points outside of the drawing page. It’s exaggerated 

mostly because the human eye does not have a field of view as large as 76 degrees, that is, the view is not 

entirely in focus. 

 

The following illustration goes way over the top; the vanishing points are quite close to the object, and the 

result is dramatic, unrealistic, and unsuitable for presenting a product design. As you read through this 

chapter, you’ll learn that, on some occasions, you want a vanishing point on the drawing page, and on other 

occasions, you want the “normal” human-eye type of perspective. 
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Experiments in Perspective 

Experimenting with the perspective effect is a lot more fun and rewarding reading about it. The operations 

are fairly straightforward, and you’ll probably get ideas for future illustrations just by playing with it! Single 

objects and object groups can be put in perspective; you can change the angle of a perspective shape (or 

group) by click-dragging any of the four control corners or by click-dragging the vanishing point(s), which 

changes two of the four control corners at once. 

 

Tutorial Creating One-Point Perspective 

1. Press D, the keyboard shortcut for the Graph Paper tool. On the Property bar, set the number of columns 

to 12 and the number of rows to 12. 

2. Hold CTRL while you click-drag to constrain the graph paper object to a square. Make the object fairly 

large, about 7” is good. Because the perspective effect can appreciably shrink one or more sides of an object, 

it’s a good design practice to create objects that are a little exaggerated in size. 

3. Click a deep red swatch on the color palette to set the fill for all the cells and then right-click over a pale 

yellow to set the outline color. 

4. Choose Effects | Add Perspective, as shown here. Your object now has control handles around it, and 

your current tool has changed to the Shape tool. The Shape Tool is used during Perspective creation. 

Additionally, if you intend to edit a perspective effect while you’re working on a different area of a design, all 

you need to do is choose the Shape tool and then click an object that’s in perspective. 

5. Click the top-right handle of the Perspective Effect box surrounding the graph paper object. 

Hold CTRL to constrain the movement of your cursor to the first direction in which you drag, and then drag 

down to about the second or third cell in the right column. You’ve created a perspective effect on the object, 

as you can see the cells align more or less with the effect’s red-dotted overlay reference, and a vanishing point 

appears directly to the right. If the vanishing point lies off-screen—which it will when you use a small amount 

of perspective—press F3 to zoom out so it shows. 



P a g e  | 105 

 

 

 

6. Click-drag the vanishing point up and then down as long as this is an experiment and not playing for 

points. Notice what happens: you’ve defined one-point perspective—this is the right side of a hypothetical 

cube, and one-point perspectives have only one vanishing point. So the left side of the object is anchored; it 

doesn’t change with the perspective change. 

7. Click-drag the vanishing point left and right. The left side is still anchored, and what you’re doing is making 

the hypothetical box’s right side deeper and shallower, extending to and from an imaginary horizon on the 

page. 

8. Save this document; you’ll work with it in a moment, so don’t close it. This is only the beginning of the 

experiment with suggesting depth in a 2D document! 

Tutorial Creating a 3D Ground Plane 

1. With the graph-paper document you saved in the previous tutorial open, choose the Shape tool and then 

click the object to reveal its Perspective Effect control handles and the vanishing point you defined. 

2. Click-drag the top-right control handle up and toward the center of the object, until you see a second 

vanishing point marker at about 12 o’clock on the page. You might want to zoom out to better see the 

second vanishing point because it is initially defined quite far away from the object. In the illustration after 

Step 9, you can see how the graph paper object should look. Notice also that because this two-point 

perspective is so extreme, the graphpaper outlines are actually curved to accommodate the severely distorted 

perspective. This is not an optical illusion; the lines are indeed curved now. 

3. Choose the Pick tool, and with the graph paper object selected, click it to put it into Skew/Rotate mode. 

Rotate the object about 45 degrees counterclockwise—stop click-dragging when the Property bar reports that 

you’ve rotated the object by about this amount. Changing the orientation of the object by only changing the 

vanishing points’ positions would be difficult. 

4. Choose the Rectangle tool and then click-drag a rectangle to cover the graph paper object. 

5. Choose the Fill tool, and then click-drag from top to bottom on the object so the top is black, fading to 

white at the rectangle’s bottom. Then choose a red from the color palette to fill the Start color indicator of 

the fountain fill. 
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6. Choose the rectangle with the Pick tool, and then press SHIFT+PAGE DOWN to put the rectangle on 

the back of the drawing page, behind the graph paper object. 

7. Choose the graph paper object, and then right-click the white color swatch on the color palette. Then 

double-click the Outline Pen swatch on the Status bar to open the Outline Pen dialog. 

8. Type 4 in the Width field, and then click OK to apply this width. You’re done and your composition looks 

like the illustration following Step 9. 

9. Left-click the No Fill swatch now while the graph paper object is selected. 
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CHAPTER 6 
Bitmaps in CorelDRAW 
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6.1 Bitmap Artwork 

While CorelDRAW is noted for its ability to create and work with vector images, it can also handle 

the basic needs required by the laser owner for handing bitmap images.  

We can produce quality products with the tools with have in CorelDRAW. All we need is quality 

artwork. Sounds simple, but what is quality artwork. The two images shown below. Can you guess 

what they are? 

 

While these were not actual pictures, they are created to enhance your awareness that artwork needs 

contrast, especially when working with lasers. 

Bitmaps – the Basics 

Okay, here are the very basics about bitmaps! 

Bitmap images, also called raster or paint images, are made of individual dots, called pixels (picture 

elements), that are arranged and colored differently to form a pattern. When you zoom in, you can 

see the individual squares that make up the total image. 

 

 

Increasing the size of a bitmap has the effect of increasing individual pixels, making lines and shapes appear 

jagged. Reducing the size of a bitmap distorts the original image, because pixels are removed to reduce the 

overall image size.  

Applications like Corel PHOTO-PAINT work with bitmap images. Bitmaps are also the images that scanners 

and cameras create. The bitmap storage formats include: TIF, BMP, PCX, JPG, GIF and others. TIFF is the 

most preferred format because it is most widely used format.  
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Bitmaps cannot be edited in most graphics software.  Some basic functions such as cropping, scaling, or 

mirroring might be possible but it is usually necessary to use a bitmap image processing software to perform a 

dot by dot editing, rotation, or scaling of the bitmap. 

Bitmaps and the Laser 

The biggest misconception with working with lasers and bitmap images is our past experiences with cameras 

and photography. We have always been taught that the higher the DPI (dots per inch) we can use to take or 

picture or scan an image, the better the output. This is true with some of the really high end printers and 

scanner. However, this is incorrect when working with bitmaps that output to the laser.  

Here are some general thoughts about DPI and the laser (and note that general was italicized). 

 Lasers power in our industry usually runs from 25-120 watts, which can affect the size of the beam or 

spot size of the laser. And the lens available on these machines can range from .00125 up to .007 

inches wide. 

 Most lasers use a 2.0 lens - it is focused 2.0 inches from the surface of the material. When a laser 

fires, it produces a beam, or spot size which is approximately .005 wide, or about 200 spots in 1 inch. 

So theoretically, we only need a scanned image of 200 DPI. In the real world, 250-300 DPI is the 

most preferred to allow for overlapping and smoother edges. 

 Okay, that’s not too bad. But our next problem is the laser does not always produce the same width 

of burn or spot on all materials. Harder material likes anodized aluminum and brass may give a 

smaller spot, while burning deeply into wood may give a larger spot size. 

 And, if that’s not enough, we are assuming you are working with perfect artwork. 

 

6.2 Scanning Bitmaps into CorelDraw  

Scanning 

If you have a choice of accepting a computer file or an original photograph from a customer, always choose 

the photograph. You can control the file type, DPI and other options more precisely. 

Often users will quickly scan the image either directly into CorelDRAW via TWAIN, and then try to do most 

of the resizing and editing. 

Mode Types 

Next, you need to decide what output type you want the scan to be. There are primarily three types of 

bitmaps output modes available from your scanning program; black and white, grayscale, and color.  The laser 

system can print all three types of bitmaps providing that either the driver or the bitmap image-processing 

program converts the grayscale and/or color bitmaps into a monochrome bitmap.   
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Monochrome Bitmaps   Most often used for black and white line art. If you scan the 

image in monochrome (black and white) mode, set your scanner to at least 600 

DPI.  The higher the DPI, the smoother the image will be.  Scanning 

monochrome images at 300 DPI is the minimum recommended resolution, but 

scanning them at 600 DPI will provide a significant improvement in the image 

quality.  Clean it up in your bitmap image-processing program and save it to your 

hard disk.  Monochrome bitmaps are engraved in the same manner as black filled 

text.  The black area will turn the laser on and the white area turns the laser off.  

 

Grayscale Bitmaps   Preferred type when scanning photographs. When scanning image in the grayscale mode, you 

should scan the image at no more than 300 DPI.  Scanning at a higher DPI consumes more memory and will 

take longer to print. Unlike black and white, the laser fires different power pulses for the different shades of 

gray. 

Color Bitmaps   Should always be converted to grayscale or black and white. Most laser drivers handles color bitmaps 

the same as grayscale bitmaps. Since color bitmaps use more memory, they are unnecessary and are therefore 

NOT recommended. Many software programs have a difficult time interpreting large color bitmaps. They 

sometimes can crash your computer or send scrambled images to the laser system.  It is much better to avoid 

using color bitmaps altogether.  

 

6.3 Importing Bitmaps 

The Placement Cursor 

To import a file, go to File | Import or click on the Import icon on the Standard Property Bar. The 

placement cursor will appear and you can drop it on the Drawing Page by several methods. 

 

When the placement cursor appears, you can choose from a few options for sizing and positioning 

the imported file. The options include: 

Click the drawing page, the files original dimensions are maintained, and its top-left corner is 

positioned where you clicked. 

Press Enter or Spacebar, and the file's original dimensions are maintained, and it is centered on the 

drawing page. 

To have full control over the size and position of the imported file, you can click and drag the 

imported file to your exact specifications on the drawing page. The import cursor displays the 
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dimensions of the resized file as you drag on the drawing page. But remember enlarging the image 

reduces your resolution, or DPI. 

You can also hold down Alt key as you drag, and alter the original dimensions. The import cursor 

displays the dimensions of the resized file as you drag on the drawing page. 

Bitmap Options 

After we import the file, we follow the same procedure when working with all bitmap or raster artwork. 

CorelDRAW offers a variety of options for resizing, cropping and changing the mode of the image.  

Resample 

When you resample a bitmap, you can change the image size, the resolution, or both by adding or removing 

pixels. For example, if you make an image larger without resampling, you can lose details because the image’s 

pixels are spread over a greater area. By resampling, you can add pixels to preserve more detail from the 

original image. Resizing an image maintains the same number of pixels in a smaller or larger area. You can 

lose details when you make an image larger without resampling because the image’s pixels are spread over a 

greater area. Resampling adds pixels to maintain some of the original’s details. However, resampling does not 

maintain the original quality of the picture. 

Any artwork that is brought into CorelDRAW should be resampled. 

 

To resize a bitmap  

1. Select a bitmap. 

2. Click Bitmaps | Resample. 

3. Choose a unit of measure from the list box beside the Width and Height boxes. 

4. Type values in Width and Height boxes. 

5. If you want to minimize the jagged appearance of curves, enable the Anti-alias check box.  

Crop a Bitmap 

Cropping removes unwanted areas of a bitmap. The method of cropping an image is the same method that 

nodes are used to change vector artwork. When you click on the Shape Tool, four nodes become available for 

editing. Additional nodes can be added, and lines can be converted to curves. 

 

 

 



P a g e  | 112 

 

 

Cropping a Bitmap While Importing 

1. Click File | Import. 

2. Choose the folder where the image is stored. 

3. Choose a file format from the Files of type list box. 

4. Click the filename. 

5. Choose Crop from the list box, and click Import. 

6. In the Crop image dialog box, type values in any of the following boxes: 

Top specifies the area to remove from the top of the graphic 

Left specifies the area to remove from the left edge of the graphic 

Width specifies the width of the graphic you want to keep 

Height specifies the height of the graphic you want to keep 

7. Click the drawing page. 

Mode 

Depending on the source of the bitmap artwork you receive, you may have to convert it to work with your 

desired laser output. Remember, as a general rule, line art should be black and white mode, photographs 

should be grayscale, and color should be converted to black and white or grayscale. 

 Black-and-White color mode   you can change any image to the 1-bit Black-and-White color mode. 

In addition to conversion settings such as threshold, screen type, and intensity, there are several 

conversion options that affect how the converted images will appear. 

 Line art   produces a high-contrast, black-and-white image. Colors with a grayscale value lower than 
the threshold value that you set change to black, while colors with a grayscale value higher than the 
threshold value change to white. 

 Halftone   creates different shades of gray by varying the pattern of black and white pixels in an 
image. You can choose the screen type, angle for the halftone, lines per unit, and the unit of measure. 

 Jarvis  applies the Jarvis algorithm to individual pixels. This form of error diffusion is suitable for 
photographic images. 

 Stucki  applies the Stucki algorithm to individual pixels. This form of error diffusion is suitable for 
photographic images. 

Convert To Bitmap 

In most cases, the laser operator uses either black and white or grayscale modes. If you get a file that 
is in a color mode or you want to change modes, using the CONVERT TO BITMAP option is the 
best way to change modes. 
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Bitmap Effects 

If you did receive a file from the customer, you may have to some of the work in CorelDRAW that 
should have been done in the original scanning program. Some of these Effect options include: 

 Brightness/Contrast/Intensity similar to the Contrast option in most scanners. I use it on 
color photographs prior to changing the mode. The menu option in CorelDRAW is Effects 
| Adjust | Brightness|Contrast|Intensity. 

 

 Invert the most used option when working with photographs. It creates the negative image of the 
artwork. The menu option is Effects | Transform |Invert. 

 

 Dust and Scratch used to clean up scratches on old pictures. The menu option is Effects | 
Correction | Dust and Scratch. 

 

6.4 Power Clips 

CorelDRAW lets you place vector objects and bitmapped images, such as photos, inside other objects, or 

containers. A container can be any object such as artistic text or a rectangle. When you place an object into a 

container that is larger than the container, the object, called the content, is cropped to fit the form of the 

container. This creates a PowerClip object. 

You can create more complex PowerClip objects by placing one PowerClip object inside another PowerClip 

object to produce a nested PowerClip object. You can also copy the contents of one PowerClip object to 

another PowerClip object. 

Let’s start with a simple image. We would like to have only the image of the little girl. First draw the container 

which is shown over the little girls face. Then go to Effects | PowerClip | Place Inside Container. 

 

The default for CorelDRAW is to center the object inside the container. While you can move the image once 

it is in the container, you can have it center to the container by changing the PowerClip default CorelDRAW 

uses. Go to Tools | Options | Workspace | Edit and de-select the Auto-center new PowerClip contents 

option. Here is the same image (Figure 7-5) with Auto-center turned off. The outline was change to white. 
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6.5 A Trick with the Eyedropper Tool 

The Eyedropper and Fill tools have been dramatically improved to make your work easier. In addition to 

sampling and applying colors, you can now use these tools to copy:  

 complex fills  

 outline properties  

 text formatting  

 effects (extrusions, drop shadows, envelopes, and more)  

 transformations (rotating, moving, sizing) applied to objects  
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CHAPTER 7 
Raster to Vector 
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7.1 Converting Bitmap Files to Vector Lines 

“All I want to do is scan in the image, and laser it. I don’t have time for cleanup, but most of all I don’t want 

to learn how to cleanup. If I can’t press a magic button to convert it to a perfect image, or convert to vector 

for cutting out, then forget it.” 

Sound familiar? This was my attitude a couple of years ago. But in today’s extremely competitive market, you 

must be able to produce quality products from almost any kind of artwork. As a laser owner, we always hope 

that the customer can give us a vector file, or at the least, a computer file or a printed, “100% Camera Ready 

Artwork”, an old term used for perfect artwork. But you still have the customer that responds with a business 

card when you request the artwork for the logo on the acrylic award that was just ordered.  

And what if we get a great raster image for a Christmas ornament that needs to be cut out in wood or acrylic? 

There is only one way to get 100% professional results from inferior, raster artwork - recreate the artwork. . 

While you can do this in Photoshop or other raster/pixel based programs, I prefer CorelDRAW or other 

vector based programs. Unlike raster images, vector files can be resized once the initial artwork is created. 

Here are the most popular ways of converting bitmap images to vector format: 

• Use CorelTRACE, Adobe Streamline or other raster to vector software. 

• Use scanner software that converts the scanned image directly into a vector format. 

• Redrawing the image in CorelDRAW or other vector based program. 

• Have someone else do it. 

 

CorelDRAW Power Trace  

The new PowerTRACE in X3 allows you to quickly trace bitmap images with higher precision than 

in previous versions. The old trace was a separate module that opened separately from the 

CorelDRAW program. And getting the image back into CorelDRAW was rather awkward. But now, 

the new PowerTRACE is an option in the program, and is smooth as glass.  

Note: while I like the new version, it did leave out some of the options of the old trace. 

I’ll use the Coors Light logo, one of my favorites. (Note: I am using this logo as an example. Coors 

is the owner of this logo, and it cannot be used without their permission.) 

To trace a bitmap in PowerTRACE  

1. Select a bitmap –Click Bitmaps -> Trace bitmap,  or the Trace Bitmap option on the 

Bitmaps/OLE Object Property Bar 

2. Click one of the Line Art option. The PowerTRACE dialog appears with our Coors Light logo 
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After you click on Trace Bitmap, you need to select the type of image you are working with. Here are your 

choices, and a brief explanation of each: 

• Line art — to trace black-and-white sketches and illustrations.  

• Logo — to trace simple logos with little detail and few colors 

• Detailed logo — to trace logos containing fine detail and many colors 

• Clipart — to trace ready-to-use graphics containing a varying amount of detail and number of colors 

• Low quality image — to trace photos that lack fine detail or in which the fine detail is not important 

• High quality image — to trace high-quality detailed photos in which detail is important 

To help you see how each option affects our Coors logo, we need to first look at two options in the Trace 

Control Screen, smoothing and detail.  

• Smoothing — lets you smooth curved lines and control the number of nodes in the traced result. Higher 

values result in fewer nodes and produce curves that follow lines in the source bitmap less closely. Lower 

values result in more nodes and produce more accurate trace results. 

• Detail — lets you control how much of the original detail is preserved in the traced result. Higher values 

maintain more detail and result in a greater number of objects and colors; lower values discard some detail 

and result in fewer objects.  

CorelDRAW has helped us get started by providing default settings for smoothing and detail for each type of 

artwork. 
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Converting Bitmaps via Tracing 

There are numerous powerful Line Tools in CorelDRAW for creating lines and even intricate shapes. Let’s 

start with the basics, the Freehand Tool. 

The Freehand Tool 

This tool is used mostly for creating open path, simple curves. You click on the point from where you want 

to start and then click on the ending point. Or you may create a continuous line by click-drag a path shape. 

Both examples are shown below: 

 

When creating a straight line, first click on the starting point. Now hold down the Ctrl key. As you move the 

segment up and down, you will see it snap to certain points. The CTRL key constrains the line to 15 degree 

increments. To change the default constrain angle go to Tools | Options | Workspace | Edit and change 

the change the Constrain angle option. 

You’ve now created the most basic elements – a straight line and a curve. Now, we need to change the 

straight line to a curve. While there are numerous options, we will only use a few for the tracing lesson.  

 

Next, convert this line to a curve and manipulate it. Here are the steps for changing a line to a curve: 
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With the bitmap image on the CorelDRAW Drawing Page, Right-click on the object and from the flyout 

use the Lock Object option  so we won’t accidental double-click and open Corel PHOTO-PAINT, or move 

the logo. 
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CHAPTER 8 
Importing and Exporting  
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8.1 Importing 

One of CorelDRAW‘s strongest features for many years has been it’s powerful import and export capabilities. 

Filters are translators for files created in other applications or formats. Import filters bring in the data to from 

other applications and translate it into information that can be viewed and edited within CorelDRAW. Export 

filters translate file data from a CorelDRAW document to a format readable by another program or 

publishing medium. 

With CorelDRAW’s powerful filters, we can exchange artwork without having to own many, many over 

priced applications. It also offers the laser owner more sources for artwork which decreases drawing or re-

creating files. 

Importing is primarily for bringing in files that were created on a non-laser Corel workspace, laser workspace 

with different settings than your laser. CorelDRAW 12 has over 60 different import filters for bringing in 

various file formats into your document. Here are some of the import filters and their file extensions: 

 

These import filters allow you more opportunities to bring in artwork from your customers programs.  

CDR File 

Remember if you have a file created on a lower version than your current version, you don’t have to import 

it. Corel will automatically open it. This would apply to old files on your computer after you have updated. 

Why would you want to import a CorelDRAW file? 

While having a CDR file is great, here are two issues that you need to be aware; having the right font and 

possibility of importing excessive styles. 

Fonts can come from a variety of sources – programs, after market sources or those already installed in your 

computers operating system. It is virtually impossible to have all of the fonts. Have your customer send you 

two files – one with your text characters in tact, and the other file has the text characters converted to curves. 

If you don’t have the font, you can fall back to the curves version. You will not be able to text edit the curves file. 
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EPS 

EPS is the most widely usable file format for graphics which are to be included in page-layout and text 

processing applications. 

What is EPS?  An encapsulated PostScript file is a PostScript file which describes a single page. The EPS file 

can contain any combination of text, graphics, and images.  

Some EPS files contain a low resolution, bitmapped image preview, or header. If the header isn’t available, 

you will get a gray box. 

The original intention of this format was for outputting, not editing. You would import or place the file in 

your application and out put it to a printer. And, EPs files were intended for output to PostScript printers. 

Any non-PostScript printers, such as a laser engraver, will only print out the low-resolution header. 

PS, EPS, PRN 

The CorelDRAW import for the PS, PRN, EPS – PostScript Interpreted format is one of the best around, 

considering this file type was not originally intended to be edited.  When you get to the Import Dialog, you 

have several options. Leave the default VM (virtual memory) set at the default at 3.0 MB. If you have import 

issues, try a bigger setting. You have two options with Import Text As – Curves and Text. If you have the 

font, use Text. If you select Text and don’t have the font(s) the file will not have the original look. If you 

select Curves, the file will import in as the original, but the text will not be editable. 

HPGL 

The PLT file format, developed by Hewlett Packard is vector-based. It is used in programs, such as 

AutoCAD, for printing drawings on plotters. Other Corel applications can interpret a SUBSET of the HPGL 

and HPGL/2 command set. A scaling factor of 1016 plotter units = 1 inch is used. 

Exporting a HPGL/PLT file  

Only the outlines of objects are exported to the PLT file format. 

Dotted lines, dashed lines, and arrowheads are mapped to standard line types of the PLT file format. 

Bézier curves are converted to line segments. 

Outline thickness and calligraphic settings are lost. 

Outline colors are limited to eight: black, blue, red, green, magenta, yellow, cyan, and brown. 

AI 

While CorelDRAW can import Adobe Illustrator files, it is limited to older versions. If you are getting AI files 

from a customer, as them to try the version 7 format when they save the file. And often, the AI user will save 

the file with the EPS extension. You may not be able to import these files. Try importing these EPS files as 

AI file. Also, carefully check these files if you are using a vector output on your laser. Often you will have 

additional layers of the same data, causing the laser to cut twice. 

WMF 

A Windows metafile is a vector format file that can be used by most versions of Windows. Currently, it is the 

format that many HP scanners use when they convert a scanned bitmap to a vector or Scalable Image. The 

WMF format does not support some fills and effects that CorelDRAW can. 
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CGM 

Corel applications support all versions of compatible American National Standards Institute (ANSI) 

Computer Graphics Metafile (CGM) file formats. The CGM export filter supports radial and linear fountain 

fills but not square or conical ones. 

Bitmapped Files 

CorelDRAW is a vector based drawing program. But it can import and manipulate bitmap files.  

It’s a good idea to remember that if a customer sends you a CDR file, it may contain either a vector or a 

bitmap image, or both. If you are not sure, click on the image with the Pick Tool and note the description on 

the Status Bar. If it is grouped, click on Ungroup. 

TIFF  

TIFF (Tag Image File Format) is the most common and desirable format for exchanging raster graphics 

(bitmap) images between applications programs, including those used for scanner images. A TIFF file can be 

identified as a file with a ".tiff" or ".tiffs" file name suffix. TIFF files are commonly used in desktop 

publishing, faxing, 3-D applications, and medical imaging applications. 

BMP Files 

You can import BMP files conforming to the Windows and OS/2 BMP specification. 

BMP files may be black & white, 16 colors, grayscale, Paletted, or RGB color (24-bit), and will print 

accordingly, depending on your printer. 

JPG 

If you own a digital camera, you are most like using the JPEG format. The JPG and GIF images are the most 

desirable for web graphics. The JPG image Shrinks the large file size of your graphic files, and optimizes 

pictures for faster loading from the Web and for sending via email. Most of the JPG images you get are those 

that are saved from web graphics. And usually the web designer saves the JPG image in 72 or 96 DPI which 

is usually not suitable for laser work. If you do have to use a JPG, it’s better than nothing – but just barely. 

GIF 

The GIF (Graphics Interchange Format) is one of the two most common file formats for graphic images on 

the World Wide Web. While they are slightly better than JPEG, they are not the first choice of laser owners.  

Other Importing Tips 

If you are in the Artistic or Paragraph text mode, and you try to importing a graphics file such as a PLT or 

other CAD program, CorelDRAW will interpret it as a text file and bring in the CAD code. Depending on 

the file size, you may get many, many pages of plotter commands, and often it will crash your computer. 

Paste vs. Paste – the Paste command creates a copy of the contents of the clipboard. It’s used most often for 

duplicating objects within a program. For special applications where you want to copy data between 

programs, you can copy as usual (CTRL+C or from the Edit menu). But you should select Edit | Paste 

Special when you go to paste in another application. 

You can import multiple files if they are stored in the same folder. Click on a file you want to open, and then 

hold down the CTRL while clicking additional files. You can even open an entire folder’s contents by 

clicking the first file and then holding the Shift while clicking the last file in the folder. 
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8.2 Exporting Files 

The main purpose of exporting a file is to share the CorelDRAW layout with our customer for a proof, using 

it in another application in our shop or for graphics on our website. Let’s start with basics of exporting a file. 

Click on the icon on the Standard Toolbar, or go to File | Export. 

 

Here are the basic options you will use: 

Save in:    The directory where you want to export the file. 

File name:   The name used for you file. 

Save as type:   The format that the file will be saved. 

Selected:  Used if you want to save only selected items on your Drawing Page. 

Web safe file names:  Filename is compatible with Internet standards. 

Do not show filter dialog:  I rarely check this box as I prefer to see the filter dialog. 

 

Now let’s look at the most popular export formats used in the laser shop: 

PDF 

I use this format when I am sending a proof to a customer. This Adobe format is universal, and only needs 

the Acrobat Reader to view and print this file. The Reader can be downloaded from www.adobe.com at no 

charge. I also like to use this file when I want to share a file over the Internet, and do not want it edited, such 

as an invoice or other proprietary document. 

The options you pick when exporting depend how you want to use the file. If you use JPG compression, the 

printing output is not that good, but the file size is better, especially if you intend to send the file as an email 

attachment. If it is going to be printed, use the CMYK or Grayscale models. Also, embed the fonts so the 

printed file will be as you created it. And using the RGB mode will have a better output on the screen. 
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HPGL (PLT) 

When I first bought CorelDRAW 3, I only used it to drop in to transfer my DesignCAD files through 

CorelDRAW and export them to the HPGL format for use on my engraver. The HPGL format has a PLT 

extension, thus the name of the PLT format. When exporting, you will get a HPGL Export dialog that has 

much technical data about pens and pages. This was the format that the CAD guys used to print out to their 

early plotters. The colors could be set to the pens in their plotter. 

 

JPG 

There are only two uses for this file; web graphics and for emailing. The problem with this format is that data 

gets omitted each time the file is saved. If you continue to Open and Save, the quality of the file will continue 

to degrade. 

Other Formats 

While CorelDRAW is one of the top software programs for exporting, the file type depends on the 

application you want it to be used in. If you find an application that you need to share your CorelDRAW file, 

look in the Export dialog for your many choices. 

 

8.3 Saving Files 

Save 

Typically, while working with an existing document, you save the file by clicking the Save button on the 

Standard Toolbar, choosing File | Save or CTRL+S. The file is automatically saved without opening any 

dialogs.  

Save As 

But for saving a CorelDraw document for the first time, you will get the Save Drawing dialog when you tried 

to save. You will also get the same Save Drawing dialog when you use got to File | Save As menu option 
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Although using the Save As option may seem similar to using the Export command, the two are very 

different. It may be more advantageous to choose one over the other. Save As is the best technique when 

saving native CorelDRAW files, while exporting is best for saving your document or selected objects that will 

be used in non CorelDRAW programs.  

There are several options that you have for saving your CorelDRAW document: 

 Save In the location where the actual file will be saved. 

 Filename   the actual filename used for the saved file. 

 Save as type   the file format to which it will be saved. The default is CDR, the native CorelDRAW 

format. 

 Sort Type   options include Default, Extension, Description, Most recently used and vector.  

 Keywords   words that are used in the index of the Scrapbook Search command and in ROMCat. 

 Notes   memo area for keeping notes to remind you or share with others. 

 Version   the default if Version 12, however you can also save versions including 7 thru 11 when 

sharing with other users. Note Version 8 Bidi is Hebrew and Arabic. 

 Thumbnail    determines the size of the thumbnail. I always use the default. The Thumbnail includes 

only the images on the first page of multiple documents. 

 Selected Only this option becomes visible only if objects are currently selected in your document 

before the SAVE or SAVE AS command is selected. It enables you save only specific object 

selections. 

 Web Safe Filenames  makes the filename compatible across the Internet by placing underscores in 

place of spaces in the filename. 

 Embed fonts Using TrueDoc  use this option when the files will be share with computers that may 

not have the same True Type fonts as your computer. When the file is opened on another computer, 

the job can be printed, edited and saved with the embedded font. However, the font only exists 

within that job, and is not in the Windows system fonts. 

 Save With Embedded VBA Project if parts of our document have been created using VBA scripts, 

this option becomes available.  The VBA Scripts you have saved with your document may be viewed, 

copied, and used by whoever reopens the document. 
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8.4 Using File Backup Options 

Backup files enable you to retrieve recent versions of your files should a mishap occur.  To access 

CorelDRAW’s backup options, use Tools | Options | Workspace | Save 

 

The following define the available backup options: 

Auto Backup when selected, your document files are backed up at specified time intervals. The 

default time interval is 20 minutes, but can be set in a range from 1 to 120 minutes. 

Always Backup to This option specifies the location of the backups to be saved.  The default is 

your temporary folder. Remember that when you delete your Temp files, all of your backups are also 

deleted. Make sure you don’t need them. You can specify another location and delete when you 

prefer. 

Make Backup on Save the default, Make Backup on Save option causes CorelDRAW to update 

the backup file to match your original document each time you use save your file. The backup files 

created are named backup_of_filename.cdr. 
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CHAPTER 9 
Increasing Laser Productivity through Artwork 
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9.1 Which Layout System Works Best for You? 

Single Page vs. Multiples  

Here’s another option you have when creating a layout for your laser. Depending on your application, there 

are two main methods a laser operator uses in setting the page size in CorelDRAW.  

Set Same Size Page in CorelDRAW and Print Driver 

Set Page Size in CorelDRAW the same as the size of the laser bed. 

The method you will use depends on the application you use most often. You can also switch back and forth 

between the two methods, depending on you application or your mood. 

Set Same Size Page in CorelDRAW as you actual plate 

The first method is to set up the CorelDRAW page size to the same size as the item or plate size being 

engraved. 

 

Then, in the print driver change the engraving field or page size to the current CorelDRAW page size. This 

method is most often used by operators which engrave only one plate at a time, or by those doing rubber 

stamps. 

Advantages 

 Much more efficient for doing rubber stamps. The Rubber Stamp mode automatically converts and 

fills the drawing without additional CorelDRAW functions. 

Disadvantages 

 Unable to convert quickly to multiples; CorelDRAW centers current text/logs to center of new page. 

And most of the time you have to add a box for spacing. 

 Doesn’t take advantage of red-dot pointer. 
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Set Page Size in CorelDRAW the same as the size of the Laser Bed 

The second, and my personal preference, is setting the CorelDRAW page size to the size of the laser bed. 

Then draw a rectangle the size of your plate, and transform (move) the rectangle to 0, 0. Not only does it 

allow placement of the plate anywhere on the laser bed, it takes advantage of the number one reason 95% of 

all laser owners should use a full page size – multiples. 

 

Advantages 

 Better use of time; less time of loading and unloading plates. 

 Faster laser times - the motor has less starts and stops. 

 Less wear on one side of machine.  

 Ease of using irregular sized boards. Often boards vary as much as a ¼ of an inch. By using a center 

point for each outline of the plate, all the boards do not have to be exactly the same. 

 Ease of placing odd shaped objects anywhere on the laser bed, especially those that will not fit in the 

upper left hand corner due to their irregular shape. 

 Easily turn on rectangle (plate outline) in print driver and use for cut out of plate. 

 

9.2 Creating A Multiples Layout  

In this lesson, we will maximize our engraving output by creating a nametag. Then, with the Transformation 

Docker, we will duplicate or create an array. The laser will vector cut out the nametag after it raster’s the logo 

and lettering. 

 

Creating a Nametag 
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Moving the Nametag to the Upper Left of the 16 x12 Layout 

Use the Transformation Dock and align the nametag .10 from the top edge and .10 from the left edge. 

Moving the nametag away from the page edge also moves them away from the rulers on the laser bed. If you 

try to vector too close to the rulers, you will get flashback and burn the edges of the tags next to the ruler. 

 

Duplicating the Nametag across the page 

Use the Transform Docker to duplicate the nametags across the page. 

Select the nametag with the Pick Tool, and bring up the Transformation Docker. Click on the Relative 

position and put 3.10 in the H position and 0 in the V position. The nametag was 3.0 wide and I wanted a 

space of .10 between each tag (to avoid burning). 

 

Duplicating the Nametags Down the page 

Use the Transform Docker to duplicate the nametags across the page. 

Select the nametag with the Pick Tool, and bring up the Transformation Docker. Click on the Relative 

position and put 0 in the H position and 1.6 in the V position. The nametag was 1.5 tall and I wanted a space 

of .10 between each tag (to avoid burning). The multiples layout is shown below: 
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9.3 Maximizing the Layout for Productivity Examples 

Speed Optimizing 

It is advantageous to engrave an object in its longest direction because total engraving time will be reduced 

when the motion system has to make fewer stops and starts.  If the engraving object is longer than it is tall as 

in Figure 10-5, rotating the graphic 90 degrees and placing the material in the laser system sideways can 

achieve a greater engraving speed. 

 

If the artwork contains engraved objects of the same color with a great deal of space between them in the 

engraving direction (Figure 10-6), processing time can be longer since the laser must make long strokes to 

engrave both objects at the same time.  To reduce engraving time in cases like these, use different colors for 

each of the objects but assign the same power setting to both colors.  This will cause the laser to engrave one 

object at a time, skipping over all blank space, which in many cases will reduce engraving time.  However, if 

the objects are relatively close together in the engraving direction as with ruler (Figure 10-7), then leave them 

the same color because it will be quicker to engrave them both at the same time.  Experiment with these 

techniques to optimize the speed of engraving. 

 

    

Order of Vector Engraving In CorelDRAW 
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In object manager, the last object created is normally the first object vectored, unless the lasers print driver 

overrides this order. However, the color of the vector may also affect the order in which it is engraved. 

Order of Engraving vector objects in CorelDRAW 

Line   follows direction of creation as shown in the example below. The starting point is noted by the larger 

node. 

 

If the direction is wrong for the line, use mirror horizontal to change starting point. 

 

Circles   Starts at top (12 o’clock) and goes clockwise. Mirror and it goes 

counter clockwise. Mirror vertically and it starts at 6 o’clock and goes counter 

clockwise. Mirror vertically and horizontally, it starts at 6 o’clock and goes 

counter-clockwise.  

 

Order of engraving vs. stacking order 

Let’s look at the instrument panel example below. I have raised the material over the table to avoid flashback 

from the laser. I need to cut out the holes first, and then cut out the panel. If the panel is cut out first, it will 

fall down and will be out of focus when cutting out the individual holes. 

 

On the laser driver I use, I have an option of letting the laser sort the order of vectors cutting or controlling it 

myself.  

When the Sort option is turned ON in the Vector Optimizer of the laser print driver, the vector objects are 

cut first according to color, and second to placement on the engraving area. The Optimizer attempts to sort 

the order of the objects to avoid jumping around. 

When I turn the Sort OFF in the optimizer, the vector cutting order is first based on the color, and second, 

the order the vectors are drawn. The last object in the stacking order (or the first object drawn in 

CorelDRAW) is the first object to be cut.  

For this example, I turned the Sort OFF in the print driver, and made sure that the outline of the panel was at 

the top of the stacking order in the Object Manager Docker. 
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Other Productivity Notes: 

Hidden Vector Lines in Artwork   Most laser drivers doe not automatically filter out vector outlines that 

are overlapped by engraved objects such as fills.  If there are filled objects with some hidden outlines 

underneath, the laser system will then engrave out the fill and cut the hidden outline on top of the fill.  This is 

a common occurrence when using pre-drawn clipart designed for laser printers.   

Overlapping Fills   If the artwork created has overlapping filled areas, the most laser drivers will 

automatically filter these fills to prevent the overlapped area from being engraved twice.  This is similar to 

color separation in the printing industry.  The entire filled area of the object on top will be engraved and only 

the visible part of the underlying filled area will be engraved.  The final result is a what-you-see-is-what-you-

get output.  In this way the color white can be used as an effective drawing tool.  Since the laser system will 

not engrave the color white (this is the background color), it can be used to block out the undesired engraving 

areas of filled regions and/or bitmaps.  However, you cannot use a white fill to cover an outline, the outline 

will vector cut even though you cannot see it on screen. 

Overlapping Outlines   The laser driver does not filter outlines that overlap each other.   

Postscript (PS) Images   The laser system is not a postscript device.  This means that postscript fills, 

postscript textures, and especially postscript fonts will not be able to print to the laser system.  Sometimes 

using Adobe Type Manager (ATM) will allow some postscript fonts to print correctly but most of the time 

does not work properly. 

Font Problems  If you are having any problems printing a font and you cannot figure out what is going on, 

select the font and “convert to curves” or “convert to paths” in your graphics software.  This will convert the 

font into a bitmapped image and will print correctly to the laser system.  Refer to your graphics software on 

how to convert fonts.  However, postscript textures and postscript fills cannot be converted and will not 

print to the laser system. 

 



   

 

CHAPTER 10 
Tips, Tricks, and Extras 
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10.1 QR Codes 

Popular in consumer advertising and packaging, Quick Response, or QR, codes give smartphone 

users quick access to a brand’s website which can offer additional product information.  You can 

choose what information to include in the QR code, such a URL, email address, phone numbers, 

SMS, Contact, Calendar event, or Geo Location.  

What can QR codes do for you? 

 Increase awareness for your design, brand, company or unique product 

 Disseminate important information to a fan base or loyal customers 

 Promote a special deal or other savings benefit 

 Provide a wide-reaching way to share design tips, unveil a new illustration technique or showcase 

your portfolio 

 Expand your content or message with a QR code to direct readers to additional information, content, 

designs and more 

What are some examples of cool QR codes? 

Take a look at some of these well-known brands and see their clever and powerful use of QR codes. 

Add any combination of creativity, color, style and flair to get your message recognized and scanned. 

With a little design savvy, CorelDRAW, and your imagination, the creative combinations are endless! 
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Creating a QR Code 

To insert a QR code, click Object > Insert QR Code 

 

In the Object Properties docker, you can choose from a list of options from the QR code type list 

box.  

 

Once you have entered in a valid QR code [i.e. URL, Email, Etc] you can use the controls to 

customize the code.  

 

The smaller squares within the QR code are called pixels.  The larger squares in the corners, and the 

smaller squares with a border inside, are called markers. 
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Once you have finished customized your QR Code style you can save that style form so you can use 

it for other projects.  Simply click on the style indicator, beside the QR code header, and clock on 

New Style From.  

 

Visual effects in QR code can add an artistic look but may be considered errors by QR code readers.  

You can use the error correction settings, to minimize the possibility of errors when scanning the 

QR code. Higher correction levels duplicate more of the information, increasing the chance that it 

will be read.  

 

After formatting the QR code, you can validate it to make sure that it can be read by QR code 

readers. To do so, simply click the Validate button in the Object Properties docker.  Once it has 

been validated, you will see a pop-up message containing the QR code information.  

 

Now that you have customized the QR code you can add it to a logo.  Click: File > Import, and 

choose the file you want to insert. Place the logo in the center of the QR code.  
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nce the logo is placed, you will need to validate the QR code to make sure it can be read. If it does 

not validate correctly, it may be because there are too many of the pixels [in the logo] covering the 

QR code.  In this case, try making the logo smaller and click validate again.  

There is another method for validating QR codes that can be used to validate non-QR objects or 

QR codes that have not been created in CorelDraw.   If it cannot be validated on the Object 

Properties docker it can be validated a different way.  Go to Object > Validate Barcode.  

 

 

Then draw the marquee around the bitmap object [or logo] to validate.  Once validated you can 

copy the URL to your clipboard.  
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10.2 CorelDRAW for Adobe Illustrator Users 

Adobe Illustrator and CorelDRAW have many similarities, which makes it easy to move from one 

graphics application to the other.  Although they share most basic drawing capabilities, Adobe 

Illustrator and CorelDRAW are distinguished by some differences in both terminology and tools.  

Understanding these differences lets you make a quick transition to CorelDRAW.  
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GETTING STARTED

Adobe Illustrator CS6 is an illustration program that can be used for print, multimedia and
online graphics. Whether you plan to design or illustrate multimedia artwork Illustrator
offers all the tools needed to produce professional and quality results for even a beginner. This 
tutorial will take you through some of the basic uses of Illustrator CS6.
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1. GETTING STARTED

1.  Begin by opening Adobe Illustrator CS6.
 On a PC, click Start > Programs > Adobe > Illustrator CS6, or click on the Illustrator short 
 cut on the desktop.

 On a Mac, click Macintosh HD > Applications > Adobe Illustrator CS6 , or click the 
 Illustrator icon in the Dock. (Figure 1)

Figure 1. Navigation to Illustrator CS6 on a Mac.

2. SETTING UP THE DOCUMENT
Setting up your document correctly from the start will make your job much easier as you work
through your project. This will require some advanced planning. For example, if your final output
will be a brochure, you may need to set up your document to be horizontal and double-sided.  See Figure 
2 for an example of opening a new document on a Mac.

Figure 2. Opening a new document in Illustrator.

3



4

1.  To create a new document, click File > New. This will open the Document Setup
dialog box. Here you will be able to set up the correct page size and orientation for your
document. Options include, but are not limited to:

 Page Size: Choose a page size from the menu, or type values for width and height.  
 Page size represents the final size you want after bleeds or trimming other marks outside   
 the page. There are presets for common sizes such as letter, legal and tabloid.  To change  
 unit size from points to inches, click on the units drop down and choose inches. 
 
 Orientation: Click the Portrait (tall) or Landscape (wide) icons. These icons interact
 dynamically with the dimensions you enter in Page Size. When Height is the larger value,    
 the Portrait icon is selected. When Width is the larger value, the Landscape icon is 
 selected. Clicking the opposite icon switches the Height and Width values.

 Document Profile: Choose a profile that will best fit your project. For example, when  
 making a graphic for a brochure, choose Print. When making a graphic for Web, choose 
 Web. Each document profile has the appropriate presets for your project. 

2.  When you have entered all of your document settings, click OK.

NOTE: If you enter incorrect information in the Document Setup dialog box, or if you need to
adjust any of this information while you are working, you can make changes any time by clicking
File > Document Setup > More Options.

2. SETTING UP THE DOCUMENT CONT.

3. TOOLBOX

If you used Adobe PageMaker or Adobe InDesign before you should be familiar with the 
toolbox in Illustrator CS6 as it shares some of the tools from these applications. If you are a novice user 
of Adobe products you should keep in mind that you might not need to use all the tools. In this tutorial, 
only the basic tools will be discussed in depth.

Figure 3. Tools in Illustrator.
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Some tools in the toolbox have additional tools linked to them. These tools have small gray
triangles in the right-hand corner. To view the additional tools click and hold down on any tool
that has a gray triangle in the corner. (Figure 4)

3. TOOLBOX CONT.

Figure 4. Extra Tools in Illustrator.

If you need to use some of the additional tools often, you can tear off the additional tools into
their own toolbar. To Tearoff additional tools, do the following:

1. Click and hold on the tool you want to see the additional tools for.
2. While holding down your mouse button drag your mouse to the end of the tools to the button
with the gray triangle.
3. Let go of the mouse button to make the additional tools and new toolbar (Figure 5).

Figure 5. Sub-Toolbar in Illustrator.

4. TOOLBOX DESCRIPTION

 Selection tool
The most commonly used tool, which selects text and graphic frames and allows you to work
with an object using its bounding box.

 Direct Selection tool
Selects the contents of a frame, such as a placed graphic; allows you to work directly with
editable objects, such as paths, rectangles, or type that has been converted to a text outline.

 Group Selection tool
Selects a group of points all at once, such as the four points of rectangle.

 Magic Wand tool
Selects all objects in a document with the same or similar fill color, stroke weight, stroke color,
opacity, or blending mode. By specifying the Color Range, or Tolerance, you can control what
the Magic Wand tool selects.

 Lasso tool
Selects objects, anchor points, or path segments by being dragged around all or part of the object.
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 Pen tool
Creates a line between two anchor points you make. Creates straight lines if you simply 
click and release to make anchor points.

 Add Anchor Point tool
Adds a point to a path, which is a simple way to change any path. This helps to turn one shape
into another

 Delete Anchor Point tool
Deletes points from a path without causing a break in the path.

 Convert Direction Point tool
Changes the control handles around an anchor point reshaping the segments controlled by that
anchor point.

 Type tool
Creates resizable and moveable text frames in which you can type text.

 Type on a Path tool
Used to type on an object’s path.

 Line tool
Creates straight lines.

 Ellipse tool
Creates ellipse shapes that hold text.

 Rectangle tool
Creates rectangle shapes that hold color or text.

 Polygon tool
Creates polygon shapes that hold color or text.

 Paintbrush tool
Draws a path and applies a brush stroke simultaneously.

 Pencil tool
Draws open and closed paths as if you were drawing with a pencil on paper. It is most useful for
fast sketching or creating a hand-drawn look.

 Smooth tool
Removes excess angles from an existing path or a section of a path.

4. TOOL DESCRIPTION CONT.
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4. TOOL DESCRIPTION CONT.
 Arc tool
Creates a curved line segment or a closed, wedge-like shape.

 Spiral tool
Creates a spiral-shaped object of a given radius and number of winds.

 Grid tool
Creates rectangular grids of a specified size with a specified number of dividers.

 Polar Grid tool
Creates concentric circles of a specified size and a specified number of dividers.

 Star tool
Creates star-shaped objects with a given size and number of points.

 Flare tool
Creates flare objects with a bright center, a halo, and rays and rings. Use this tool to create an
effect similar to a lens flare in a photograph.

 Erase tool
Removes part of an existing path or stroke. You can use this tool on paths, but not on text.

 Rotate tool
Changes orientation, or angle, of the object on the page.

 Reflect tool
Flips the object across an invisible axis that you specify. You can copy while reflecting to create
a mirror image of an object.

 Scale tool
Scales a selected object by being dragged anywhere in the document window. Scales objects
relative to their center points, or to any reference point you make anywhere in the document
window.

 Shear tool
Slants or skews an object along its horizontal axis, also rotates both of the object’s axes.

 Reshape tool
Selects one or more anchor points and sections of paths and then adjusts the selected points
and paths globally.

 Warp tool
Stretches objects as if they were made of clay. When you drag or pull portions of an object
using this tool, the pulled areas attenuate.
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 Twirl tool
Creates swirling distortions of an object.

 Pucker tool
Deflates an object by moving control points toward the cursor.

 Bloat tool
Inflates an object by moving control points away from the cursor.

 Scallop tool
Adds random, smooth, arc-shaped details to the outline of an object.

 Crystallize tool
Adds random spike- and arc-shaped details to the outline of an object.

 Wrinkle tool
Adds random arc- and spike-shaped details to the outline of an object.

 Free Transform tool
Provides a way to perform any transformation, such as rotating and scaling.

 Symbol Spray tool
Creates a set of symbol instances or increases more instances to an existing set.

 Symbol Shift tool
Moves symbol instances around.

 Symbol Scrunch tool
Pulls symbol instances together or apart. Use this tool to shape the density distribution of a
symbol set.

 Symbol Size tool
Increases or decreases the size of symbol instances in an existing symbol set.

 Symbol Spin tool
Orients the symbol instances in a set. Symbol instances located near the cursor orient in the
direction of the cursors movement.

 Symbol Stain tool
Colorizes symbol instances changing the hue toward the tint color, while preserving the original
luminosity.

4. TOOL DESCRIPTION CONT.
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 Symbol Screener tool
Increases or decreases the transparency of the symbol instances in a set.

 Symbol Style tool
Applies or removes a graphic style from a symbol instance.

 Column Graph tool
Compares one or more sets of values by using rectangles whose lengths are proportional to the
values.

 Stacked Column Graph tool
Is similar to a column graph, but stacks the columns on top of one another, instead of side by
side. This graph type is useful for showing the relationship of parts to the total.

 Bar Graph tool
Is similar to a column graph, but positions the rectangles horizontally instead of vertically.

 Stacked Bar Graph tool
Stacks the bars horizontally instead of vertically.

 Line Graph tool
Uses points to represent one or more sets of values, with a different line joining the points in
each set. This type of graph is often used to show the trend of one or more subjects over a
period of time.

 Area Graph tool
Is similar to a line graph, but emphasizes totals as well as changes in values.

 Scatter Graph tool
Plots data points as paired sets of coordinates along the X and Y axes.

 Pie Graph tool
Creates a circular graph whose wedges represent the relative percentages of the values
compared.

 Radar Graph tool
Compares sets of values at given points in time or in particular categories, and is displayed in a
circular format.

 Gradient tool
Changes the direction of a gradient, its beginning point and endpoint, and applies a gradient
across multiple objects.

4. TOOL DESCRIPTION CONT.
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5. WORKING WITH LAYERS

Layers let you organize your work into distinct levels that can be edited and viewed as
individual units. Every Illustrator CS6 document contains at least one layer. Creating multiple
layers lets you easily control how your artwork is printed, displayed, and edited. You will use the
Layers palette (Figure 7) often while creating a document, so it is crucial to understand what it
does and how to use it.

NOTE: To show the Layers palette click Window > Layers.

Exploring the layers palette
Figure 7. Layers palette with two layers

A. Eye Icon (Hide/Show)
B. Lock Icon
C. Make/Release Clipping Mask
D. Create New Sub layer
E. Create New Layer
F. Delete Layer
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6. MAKING SELECTIONS
Using the selection tool
In Illustrator CS6 you will need to use the Selection tool often, so it is crucial to understand
what it does and how to use it. To select an object, choose the Selection tool from the toolbox
and click on the object you wish to select. When the object is selected, you can move,
transform, and change its properties.

Some selections may be easier to make by creating a marquee around the object. To make a
marquee selection, do the following:

1. Choose the Selection tool from the toolbar.
2. Click and drag the Selection tool over multiple objects to select them all.
NOTE: By holding down SHIFT you can make multiple marquee selections.

Duplicating objects
To duplicate objects, do the following:

1. Select the object you wish to duplicate.
2. Hold the ALT (Windows) or OPTION (Mac OS) key on the keyboard as you click and drag the object 
to another position on the artboard (Figure 6).
3. Once you release, a duplicate will show up where the object has been moved.

Figure 6. Duplication Objects.
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7. CREATING BASIC SHAPES

Illustrator CS6 offers a large variety of shape tools to create any shape.
To create a shape, do the following:

1. Select the Shape tool that corresponds to the shape you wish to create. Click and drag on
the art board to create desired size and proportion of the shape.
OR
2. Select the Shape tool you wish to use and click on the art board. This will open a window
with the properties of your new shape. Here you can type in specific height, width, number of
points on a star, etc.

NOTE: Holding down the SHIFT key while creating your shape will make an ellipse a perfect
circle, a rectangle a square, etc. (Figure 9). Also, don’t be upset if you make your shapes too big
or too small, you can always resize them.

Figure 8. Reshaping without shift. Figure 9. Reshaping with shift.
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8. INSERTING AND FORMATTING TEXT
One of the most powerful features of Illustrator CS6 is the ability to use type as a graphic
element. Like other objects, type can be painted, scaled, rotated, etc. You can also wrap type
around objects, make it follow a path, create type masks, import text files into containers, and
modify the shape of individual letters in a block of type.

To add type to a document, do the following:
1. Select the Type tool from the toolbox.
2. Click and drag anywhere on the art board to create a marquee for your text.
3. Use the Character palette to choose the font, font color, font size, etc.
NOTE: To view the Character palette, click Window > Type > Character.

Wrapping text around a graphic
To make your work, for example a brochure, look professional, you may want to use Text Wrap
(Figure 10). Objects, which you will wrap text around, must be in front of the type. To make a
Text Wrap, do the following:
1. Select the object you wish to wrap text around.
2. Choose Object > Arrange > Bring To Front.
3. Choose Object > Text Wrap > Make.
4. Set the Text Wrap Options (Figure 11).

NOTE:  You can change how close the text wraps around an image after you have made it by
changing the offset (Figure 11). Choose Object > Text Wrap > Text Wrap Options. The lower
the offset the closer the wrap. After your Text Wrap is set you can move the object freely without  
resetting your wrap options.

Figure 10. Texting Wrapping.

Figure 11. Texting Wrapping. Options
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Another way to create type in Illustrator CS6 is to enter type along a path (Figure 12). 
You can type along any path you make with the Pencil, Pen, and even the Shape tools. To type along a path, 
do the following:

1. Start by drawing a path on the art board (Figure 13).
2. Select the Path Type tool from the toolbox and click anywhere on the path to start your
text at that spot on the path.
3. Adjust the position of the type along the path by positioning the Selection tool over the
start, middle, or end of the type bracket until a small arrow icon appears.
4. Click and drag to the desired position.
5. When finished, you can move the type with the Selection tool.
NOTE: After typing on a path the path will have no stroke or fill.

Th
is i

s typing on a path!

Figure 12. Typing along a path. Figure 13. Create Path to type on.

10. PLACING IMAGES
If you need to insert an image into your document you should use the Place function.
To place an image into your document, do the following:

1. Make sure the layer you wish to place your image in is selected.
NOTE: Placed images are added to the selected layer. If you want it to be on its own layer,
create a new layer by clicking the New Layer button near the bottom of the Layers palette
(shown in Figure 1 of the Working With Layers section of the tutorial) and select it then place
your image.
2. Click File > Place.
3. Navigate through the pull down menus to find the file that you want to insert. Select the file
and click OK.

Once you have placed the object, switch to the Selection tool to move the object to the precise
location you want. If you single-click on your image, you can resize it with the “grippers” - little black 
squares around the image. Click and drag a gripper inward or outward to expand or shrink your image as 
desired.

If you would like to maintain the original proportions of the image when you resize it, hold down
the SHIFT key as you perform the resizing action.

9. TYPING ON A PATH
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11. WORKING WITH OBJECTS
To create professional and effective documents in Illustrator CS6, you need to learn how to work with 
different kinds of objects. Before you start working with objects it is crucial to understand what each of 
the objects is:

Text - a block of text within a defined “textbox”
Image - a picture file with one of the following extensions: .jpg, .gif, or .tif
Graphic - vector art created in Illustrator, or tables, charts, graphs, etc., created in another
program, for example, Microsoft Excel

To use objects such as images and graphics, you will need to use the Place function.
1. Click File > Place.
2. Navigate to the desired file and click Place.
The following sections offer an in depth explanation of how to adjust images, graphics, and text
within your document.

12. ARRANGING
Using guides
Guides help in arranging and aligning text and objects on the art board. When creating a poster
or a brochure you will most likely align objects in an organized manner; guides make this task
easy. To use guides, you must first make the rulers visible on your document. Choose View > Rulers > 
Show Rulers. To create a guide, do the following:

1. With the Selection tool click and drag the ruler on the edge of the page onto the art board.
2. A blue marquee line will appear where your guide will go. Move the marquee to the position
you want and let go of the mouse button.
NOTE: After you have created your guides you can’t move them because they are locked. To
unlock a guide, click View > Guides > Lock Guide. Remember to lock guides again after you
have unlocked them, or you might accidentally select and move them.

Creating clipping masks
Clipping masks are shapes that act as windows showing only the artwork located within the
boundaries of those shapes. The clipping masked object must be on top of the stack of objects
you wish to mask. To create a clipping mask, do the following:

1. Choose the object you wish to mask with using the Selection tool.
2. Click Object > Arrange > Bring to Front (Figure 14).
3. Select all objects you wish to include in the mask.
4. Click Object > Clipping Mask > Make (Figure 15).

Figure 14. Object Arrange. Figure 15. Object Clipping Mask.
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Grouping Objects
When there are multiple objects on the art board that you need to move as a whole you can
group them instead of selecting each of the objects every time you wish to move them. To group
multiple objects, do the following:

1. Select all of the objects that you want to group together. This can be done in two ways:
 (1) Hold down the SHIFT key and click on each object individually,
 (2) Starting in an empty space on the page, click and drag the mouse outward creating a
 marquee box around all of the objects you want to select.
2. Choose Object > Group (Figure 16).

If you click over the newly grouped objects with the selection tool you will notice that they are
bound together as one large object. To ungroup these objects, click on the grouped objects and
choose:
Object > Ungroup.

13. GROUPING

Figure 16. Grouping Objects.

Sometimes, you may have an object placed exactly where you want it and you want to avoid
moving it by accident. For example, if you have a large image or graphic as a background for
the page, you may select it and move it accidentally if you are not careful. To help you avoid
such situations, Illustrator CS6 has a function called Locking. When an object is locked it
cannot be moved, adjusted, or altered in any way.

To lock objects, select them using the Selection tool and choose Object > Lock > Selection. 
Notice how Illustrator restricts the object from being altered in any way. 

To unlock the object(s), choose Object > Unlock All.

14. LOCKING
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15. APPLYING TRANSPARENCIES
Changing the opacity of an object
In some cases, you may want to make an object almost transparent like a watermark. To do
this, you would use the Transparency palette. In this palette you can adjust the Opacity of an
object. Opacity refers to the solidness of an object shown in percentage, from 0% (completely
transparent) to 100% (completely solid).

Under the Transparency tab (Figure 17), you will see a dropdown menu that holds all the
blending options for applying transparencies. To apply a transparency, do the following:

1. Select the object you want to apply the transparency to with the Selection tool.
2. Choose which blending mode you want to use in the transparency.
3. Type in or drag the slider to the amount of opacity you wish to apply.
NOTE: Transparencies can always be edited by repeating the steps above or by choosing
Edit > Undo.

Figure 17. Transparencies.

16. APPLYING STYLES, EFFECTS, AND APPEARANCES
Styles
A style is a set of effects and appearances. Using styles, you can quickly and globally change
the appearance of an object. To add a style, do the following:

1. Select the object with the Selection tool.
2. Click on the Graphic Styles tab (Figure 18) . Select the style you wish to apply.

Figure 18. Graphic Styles.
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16. APPLYING STYLES, EFFECTS, AND APPEARANCES 
Effects
You may want to create your own style for an object instead of choosing one from the graphic
style that comes with Illustrator CS6. This can be done by adding multiple effects to an object.
To add an effect, do the following:

1. Select the object with the Selection tool.
2. Click on Effect in the menu bar at the top of the screen.
3. Select the effect you want, set the parameters and click OK.

Appearances
You can specify which part of an object you add styles and effects to by using effects in the
Appearance palette (Figure 19). The Appearance palette contains the following types of
editable attributes:

Fill - lists all fill attributes (fill type, color, transparency, and effects)
Stroke - lists some stroke attributes (stroke type, brush, color transparency, and effects
Transparency - lists opacity and blending mode
NOTE: All other stroke attributes are displayed in the Stroke palette.

Figure 19. Appearance.

You can duplicate strokes and fills in the Appearance palette which allows you to have multiple
strokes and fills with different effects and styles on a single object. An appearance attribute can
be changed or removed at any time without changing the original object or any other attributes
applied to the objects. Just like layers, you can move your appearances to any order you wish.

Figure 20. Appearance with green, red and blue.,

Figure 21. Appearance with pink, yellow, and blue.
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A Symbol is an object that is placed in the Symbols palette and can be applied multiple times
by painting them onto the page. Symbols used in combination with the Symbolism tools offer
options that make creating repetitive shapes easy.

Creating symbols
You can draw and create your own symbols using the Symbols palette. To create
a symbol, do the following:

1. Select an object with the Selection tool.
2. Click on the New Symbol button on the Symbols palette.
3. Delete the original on the art board once your new symbol appears in the Symbols
palette.
4. Select the Symbols Sprayer tool from the toolbox and select your new symbol in the
palette.
5. Click and drag to apply the symbols to the area you wish.

Editing symbols
In the Symbols palette you can update attributes of your symbols without deleting the ones you
already have on the art board . To update a symbol, do the following:

1. Click on the Place Symbol Instance button at the bottom of the Symbols palette. This
will place the symbol one time in the middle of your page.
2. With the symbol selected choose Object > Expand > OK to put the symbol back in the
editable mode.
3. After you have made your changes hold down ALT (Windows) or OPTION (Mac OS) key
and drag the new symbol on top of the original in the Symbols palette.
4. Release when you see a black border around the original symbol.

17. WORKING WITH SYMBOLS 

Remember to save your work often. Saving frequently reduces the risk of losing the work you
have been doing. To save your Illustrator document, do the following:

1. Click File > Save.
2. Navigate to the place you would like your document to be saved by using the dropdown
menu and the navigation window.
3. Enter the name of your document in the Save As text field.
4. Choose a format to save your project in from the Format dropdown menu.
5. Click the Save button in the bottom right corner of the dialogue box.
6. Check to make sure that your document is saved in the place you intended.

18. SAVING 



Paste board- non-printing area 
outside of the document which 
is useful for storing possible 
images

Tabs- easy navigation to 
open documents

Column Guide 
(purple)

Margin Guide 
(pink)

Document edge
(black)

Page Numbers

InDesign for Beginners Step-By-Step Guide
Learning Objectives
At the end of the workshop, you will be able to:
1. Adjust text with the Character panel and change alignment with the Paragraph panel or 
Control Panel
2. Add or subtract pages using the Pages panel
3. Create a new document and manipulate columns and margins
4. Place text and images 
5. Identify all viewing options
6. Finalize spelling as well as export to PDF

Non-Printing Guides

Image bounding 
box (blue)
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Selection

Direct Selection

Page

Gap

Content Collector
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Gradient Feather

Note

Eyedropper

Hand

Zoom
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Application Bar

Control Panel
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Leading- Space between rows of text

Tracking- space between a series of 
letters

Kerning- space between 2 letters

New Page Delete Page

Master Pages

Paragraph Panel
Home of alignment, Drop Caps, and 
indentation

Indicates active page (blue)

Indicates applied master

Tool Bar Character Panel 
(Objective 1)

Fill Stroke

Applies Fill or Stroke to:
Text
Object

Pages Panel (Objective 2)



3

1. File > New > Document
2. Select Intent (print)
3. Select number of pages (1)
4. Indicate Facing Pages if you want 
book style spread (N/A for 1pg doc)
5. Choose Page Size and Orientation 
(Width 51p0/ Height 66p0)
6. Enter Number of Columns and Gutter 
(space between columns) (Number: 1)
7. Enter Margin width (select gray link to 
keep all the same width) (all 3p0)
8. Click OK

Change Column/ Gutter Settings
1. Layout > Margins & Columns
2. Adjust Margins as desired
3. Under Columns
 Select Number
 Enter Gutter (Space between 
columns)
4. Click OK

Beginning of Poster Exercise
Create a New Document (Objective 3)

Create a Rectangle
1. Select Rectangle Tool
2. Click and drag to desired size
3. Release mouse
4. To Resize click the Selection Tool
5. Click on object then click, hold, and drag one of the white 
handles to desired size

Change Fill Color of Object
1. Select object with Selection Tool
2. Select the Fill drop down arrow
3. (Make sure the box, not “T” is selected) Click desired color

InDesign Tip not part of exercise
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1. File> Place
2. Select Item (01 Coverimage.
jpg)
3. Select Open

The cursor is now loaded with the 
picture.

To size the image as it is placed:
1. Click, hold and drag to the 
desired sized on the page
2. Release mouse button

To place the image at full size:
1. Click once on the page

Placing Images (Objective 4)

Create an image place holder:
1. Select the Rectangle Frame Tool
2. Click hold and drag to desired place
3. Click Selection Tool
4. Select place holder (white handles appear)
5. Follow Placing Images instructions above
with 04_SmallHiking.jpg and 
05_SmallWaterfall.jpg

Create a text box:
1. Select the Type Tool
2. Click hold and drag to desired size
3. Release mouse. Cursor will be ready to 
type in text box.

Format Text:
1. Select the desired text with the Type Tool
2. (To change color) Click the Fill drop down 
arrow and click on desired color
3. (To change font) Select desired font and 
text size from drop down list

STOP: End of poster exercise
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Normal- Shows non-printing guides
Preview- Hides non-printing guides
Bleed- (If built into page) Shows the area printed outside the page border which 
is cropped by professional printers
Slug- (If built into the page) Shows the slug (notes) area that is later cropped by 
professional printers
Presentation- Full Screen display of printing objects only

Finalize (Objective 6)
Spell Check
1. Edit > Spelling > Check Spelling
2. Select Search parameters (most likely Document)
3. Click Start
4. Select Change or Ignore as needed

Find/ Change
1. Edit > Find/Change
2. Enter desired text in “Find what:” field
3. Enter desired text in “Change to:” field
4. Select Search parameters (i.e. Document)
4. (Recommended) Click Find to move to next occurrence of text
5. Click Change
6. Continue with Find Next
7. Change All will replace every occurrence at once 
(Sometimes this will pull the word when its letters are found in 
another word. i.e. “in” from “within”)

Normal Preview Presentation

Screen Mode (Objective 5)
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1. File > Export
2. Select location to save
3. Enter desired name
4. Choose Desired PDF format
5. Click Save
6. Under Pages: Select All or Range 
(specify)
7. Select Pages (single page) or 
Spreads (side-by-side book view)
8. Recommended Options:
 Optimize for Fast Web View
 Create Tagged PDF
 View PDF after Exporting 
(opens in Adobe Acrobat)
9. Click Export

Export to PDF
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Package
Packaging allows you to share your 
completed InDesign documents 
with all the placed images, texts, 
fonts, etc. that you have linked to 
the document. 

1. File > Package
2. Click Package
3. Ignore Printing Instructions 
dialog box and click Continue 
(Most commercial printers ignore 
this file in your packaged folder. 
If you need to communicate with 
them, it is suggested that you call 
or email.)
4. Select location you want the 
packaged folder save.
5. Select:
 Copy Fonts
 Copy Linked Graphics
 Update Graphic Links in 
Package
6. Click Package
(At this point you will most likely 
receive a warning about the fonts. 
Most of the time if you are sending 
to a commercial printer for printing 
only, it is not a problem; however, it 
is always suggested that you check 
the font license.)
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Best Short Cut Keys in InDesign (Cntrl on PC/ Cmd on Mac)

Ctrl+z Undo
Ctrl+s Save
Selecting Tools
V, Escape Selection Tool
a Direct Selection tool
p Pen tool
\ Line tool
f Rectangle Frame tool
m Rectangle tool
l Ellipse tool
r Rotate tool
s Scale tool
i Eyedropper tool
k Measure tool
g Gradient tool
c Scissors tool
h Hand tool
z Zoom tool
Ctrl+Space Temporarily select Zoom In tool
x Toggle Fill and Stroke
Shift+x Swap Fill and Stroke
w Switch between Normal View and Preview Mode
Working with Type
Shift+Ctrl+b Bold
Shift+Ctrl+i Italic
Shift+Ctrl+y Normal
Shift+Ctrl+u Underline
Shift+Ctrl+/ Strikethrough
Shift+Ctrl+k All caps (on/off)
Shift+Ctrl+h Small caps (on/off)
Shift+Ctrl+L, R, /c Align left, right, or center
Shift+Ctrl+F (all lines) / J (all but last line) Justify all lines
Shift+Ctrl+>/< Increase or decrease point size*
Moving Through the Document
Arrow Keys Move selection**
Ctrl+[ Send object backward
Shift+Ctrl+[ Send object to back
Ctrl+] Bring object forward
Shift+Ctrl+] Bring object to front
Shift+Ctrl+click and drag Resizes image and frame at the same time
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How to design a book cover in InDesign
A book by its cover’, but the design of a cover can, in fact, make or break the success of a book. If you’re like me, the design of the front 
cover is the easy part. Your creativity can really �ow when you’re making a compelling design that re�ects the story. 

But then comes the spine. How big should it be? And don’t forget the back. Have you got all information you need for the back cover to
look o�cial? 

Over the following steps I'll walk through everything you need to know to design a book cover in InDesign Creative Cloud. This tutorial
is based o� Pariah Burke's course on Pluralsight. 

01. How big will your book be?  

https://www.facebook.com/sharer/sharer.php?u=https://www.creativebloq.com/how-to/how-to-design-a-book-cover-and-spine-in-indesign-cc
https://twitter.com/intent/tweet?text=How%20to%20design%20a%20book%20cover%20in%20InDesign&url=https://www.creativebloq.com/how-to/how-to-design-a-book-cover-and-spine-in-indesign-cc
whatsapp://send?text=How%20to%20design%20a%20book%20cover%20in%20InDesignhttps://www.creativebloq.com/how-to/how-to-design-a-book-cover-and-spine-in-indesign-cc?fwa
http://pinterest.com/pin/create/button/?url=https://www.creativebloq.com/how-to/how-to-design-a-book-cover-and-spine-in-indesign-cc&media=https://cdn.mos.cms.futurecdn.net/pSCPpfLzWwzfKS3DzWFAaM-1200-80.jpg
mailto:?subject=I%20found%20this%20webpage&body=Hi,%20I%20found%20this%20webpage%20and%20thought%20you%20might%20like%20it%20https://www.creativebloq.com/how-to/how-to-design-a-book-cover-and-spine-in-indesign-cc
https://www.creativebloq.com/author/laura-hawk


First, let’s look at some vocabulary. Trim size refers to the �nal dimensions of a printed page after all the bleeds are cropped. It’s the
size of the front and back covers of your book – not including the spine. (Sometimes you’ll see the words ‘back cover’ written as
‘bacover’, which is an industry standard term.) 

Most of the time, if you’re designing a book cover, the printing of the book will already be determined and the printer will have a
template for you. However, in special cases, you might need to calculate some of these things yourself. 

Ask yourself: am I designing for paperback or hardcover? Is my book �ction, non-�ction, digest, trade or technical? Will it have a lot of
images or be mostly just text? 

Smaller books work well for text-heavy publications without pictures or diagrams. You’ll see bigger sizes used when images are
necessary. Standard trim sizes for paperback are the same dimensions for front and back, while hardcover designs allow for some
overhang.

Use this diagram to get an idea of what size you should shoot for based on your genre

RECOMMENDED VIDEOS FOR YOU...

video playing

Affinity Designer: The
Export persona

17/10/18

17/10/18



02. Set up your template in InDesign

You might think it makes sense to design the entire cover – front page, back page and spine – on a single-page layout. After all, it's all
printed on the same piece of paper, right? However, this isn’t the best approach if changes will be made at some point during the
process. 

If you don’t have the �nal page count, for example, or if another design element changes half-way through, you would have to make
those changes and realign the design across the whole cover. It’s better to assign each piece of the cover an individual page. I’m going
to be using digest size for paperback.

03. Set up the bleed

Set the Pages �eld to 3, and add the appropriate width and height for the type of book you’ll be making



Don’t click okay just yet. We still need to set up the bleed, which is when the images, text or colours are printed all the way to the edge
of the paper. Have you ever tried to use scissors to cut the border o� an image you printed? It’s di�cult not to get little white edges if
you’re cutting right where the colour transitions to paper. 

Anything that’s meant to go o� the edge of the page should extend to the bleed boundary when you’re setting up a template like this
one. This is so if anything shifts in printing, you'll still have a small margin for error before the �nal cover is accidentally cropped. 

To set this area up, go to the bottom of the New Document dialog. Open the Bleed and Slug drop-down menu. InDesign calculates
bleed by ⅛ inch increments, so if you click the up arrow, it will change the bleed from 0 to 0.125 inches (which is the same as a ⅛ inch).
0.125 inches is a standard bleed area, but don’t be alarmed if your printer asks for something di�erent. 

Next, let’s set the margins: this will be the guide for the live area in our document. Give yourself a minimum of 0.125 inches; I prefer
0.25 inches for a lot of projects. We’ll leave the slug alone, so click okay. 

You have now set the bleed and live areas in your document. It’s time to make it look like a cover.

04. Arrange the cover panels

This diagram shows your bleed, trim and live areas



Open the Pages panel from the Window menu. You’ll see the typical two-up shu�e. Click the top-right �y-out menu in the Pages panel
and uncheck Allow Document Pages to Shu�e. Now drag-and-drop page one between pages two and three. Imagine these pages from
left to right as your back cover, spine and front cover. 

Now, let’s resize the spine. Choose the Page tool from the Tool panel. In the control panel at the top, you’ll see the Liquid Page Rule
�eld appear. This is set to Controlled by Master, but for us to get the most �exible options for making changes later on, select Scale. 

Next, hit Opt/Alt and pull in one of the edges of the spine to roughly the width that you think your spine will be. When you let go of the
mouse, the pages will snap back together. 

05. Calculate the width of the spine

Now you have a three-page spread that will be more convenient for making changes on the �y



There are two major pieces of information you need to calculate the width of a perfect bound spine. You must know the number of
pages in the book – which will always be a multiple of four, even if it means including blank pages. You’ll also need to know the paper
thickness for the inside pages of the book, which is called ‘text stock’. This chart will give you an idea for selecting the appropriate page
thickness, and shows how to calculate the spine width.

Let’s say you have 348 pages and use 60lb stock. To calculate the spine width, �nd the thickness in inches and multiply by page count:
348 x 0.0048 = 1.6704 inches.

Now jump back into InDesign. With the Page tool still selected, you’ll see a Width �eld in the control panel at the top. Enter the value
you calculated here – in my case, it’s 1.6704 inches. Now your spine is the right size, and you can drop in your design.

Use this chart to �nd the weight of paper you want and calculate the spine



06. Design the background of the cover and spine

Next, it’s time to place the images you plan to use in the design. You can use an image for one panel, or on all of them, or over a
combination of them. However, just make sure there’s enough negative space in the image for all the important information on the
spine – like the title – to be legible. 

I’m using a photo for the background of my front cover and spine. Then, I’ll use a solid colour on the back. To create the frame for the
picture, select the Rectangle Frame tool and drag it along the panels you want. Don’t forget to include the bleed area all the way to the
edge of the other page. 

Now place your image in the box and resize it so that the brown box �lls the whole rectangular frame. Do this with the Direct Selection
tool.

07. Design the back cover

Place the image you want to use on your book cover and spine



Let’s add a background colour to the back of the book. First, grab the Rectangle tool – not the Rectangle Frame tool – and draw a box
covering the back panel, bleed to bleed. If you have trouble getting it exactly the right size, use the Width and Height �elds in the
control panel to put in the correct measurements. 

We know the width is 5.5 and the height is 8.5. InDesign lets you type the addition of the bleed right into the Width and Height �elds,
so type 5.5 + 0.125 for the width, and 8.5 + 0.25 for the height. This way, InDesign will calculate and resize everything in one step. 

Now select the rectangle. In the Fill and Stroke settings, set it to have no stroke. The default black �ll will work for now. Next, select the
Eyedropper tool and, with the rectangle selected, choose one of the colours from the image on the front and spine (I’ve chosen a blue
tone). Jump over to the Swatches panel and add this colour as a swatch.

08. Lay out the typography

The background for all three pages has been positioned, and is waiting for the text



Create a text box that spans from live area to live area on the front cover using the Type tool. Now add in your title – here, ‘Anonymous
Phan’. Highlight the text, go to the Fill and Stroke settings (which will now show the T symbol for type, instead of the square swatch)
and double-click the �ll colour. 

The Color Picker dialog will open. In the lower-right corner, you’ll see an eyedropper. Select a colour from the front cover that you’d like
to use, and click-and-drag it. In my case, I’m picking the light yellow from the hat. Click OK. Don’t forget to add this second colour as a
swatch. 

I’m using Courier New for the title because it makes sense for this book. We’ll also use a nice sans serif for the additional text that we
have on the back, and for the author’s name. With the title highlighted, choose Courier New from the control panel at the top. Choose
a bold weight. I also want to rotate the type frame so that it’s diagonal, along with the scribble. It might be helpful to change your
Screen Mode to Preview to get the angle just right.

09. Add the author's name

I love how the scribble from the front wraps the spine. When something looks out of place, it can help grab attention on the shelf



Now I’m ready to add the author’s name at the bottom of the front cover. I’m going to use Acumin Pro Condensed in a regular weight,
aligned to the bottom live area. I want this to be all caps to contrast the title, but I’ve also tracked it out to around 200 to further lighten
the overall value. (I went with 21 pt and 225 in the tracking.) I’ll reuse that yellow swatch from the title for the colour of the author’s
name too. 

Now let’s add the text to the spine. Press Opt/Alt and drag the title to make a duplicate of it. Rotate it until the beginning of the title is
at the top and it’s at 90 degrees. Next, duplicate the author’s name. You may need to choose a more condensed version of Acumin to
get it to �t horizontally on the spine. Let’s also change the colour of the author’s name to a dark colour, since it’s not on the dark
background anymore.

10. Add the barcode

Think about contrasting the title text with the author's name



Lastly, let’s move onto the bacover. You must include an ISBN (international standard book number). This is a 13-digit unique number
that identi�es your book. You must also have a barcode. This is based on the ISBN number and allows your book to be sold. You’ll also
need the price and category. In addition, one of the most professional and essential things to add is the publisher logo; even if that
publisher is you.

There are also some recommended but non-essential items to consider. You’ll likely want a summary of the story or some other
information. You might want to include any endorsements or awards, for example, and maybe an author bio. Sometimes if there isn’t
room for an author bio on the back, it might go at the very end of the book or on the jacket. You can also add bullet points. These
would provide quickly scannable information that helps sell your book, but it's more relevant to non-�ction works.

To add these elements to the Bacover, �rst get an ISBN. You can do this through this website My Identi�ers. Fill out the info as needed,
and you’ll get an ISBN number that you can use to generate a barcode. You can pay for a barcode through the same site, but you can
also get one here for free. Enter your ISBN code, �ll out the rest of the �elds and choose whether you want a PDF or PNG format for
the barcode. Once you get your barcode, place it into your document.

11. Flow in the copy

This is a standard barcode placement

https://www.myidentifiers.com/
https://www.barcodesinc.com/generator/index.php


Sometimes the barcode might look like it’s right up against the edge of its white background. You can add a white rectangle behind it
and if you give it a little extra room, you now have the perfect place to add the category they’ll need at the bookstore. (In our case, it’s
juvenile �ction)

Now �ow in the copy for the back of the book. Don’t forget to add the publisher's logo on both the spine and the back of the book. And
that's it: you have a book you can be proud of – and one that’s taken the guesswork out of whether everything will be printed in the
place you intended.

About Pluralsight

Pluralsight is an enterprise technology learning platform that delivers a uni�ed, end to end learning experience for businesses across
the globe. Through a subscription service, companies are empowered to move at the speed of technology, increasing pro�ciency,
innovation and e�ciency. For a free trial and more information, visit www.pluralsight.com.

Related articles:

Here's the �nished book cover design with all the necessary elements

https://pluralsight.pxf.io/c/221109/424552/7490?subId1=cbq-3647267591381290000&u=https%3A%2F%2Fwww.pluralsight.com%2Fbusiness%3Faid%3D7010a000002BSl4AAG%26promo%3D%26oid%3D%26utm_source%3Dcg-society%26utm_medium%3Dwebsite%26utm_campaign%3Dfree-trial%26utm_content%3D%26utm_term%3D

